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Forget all you know about editing sampled instruments.
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Welcome to Keymap

Keymap is a power ful tool for editing, looping, arranging, and 
organizing samples into complete sampled instruments. Keymap makes 
it easy and fun to create any kind of sampled instrument, from loop 
collections to acoustic instruments to special effects libraries. This 
preface provides an overview of the features of Keymap.

Keymap makes it easy to create and edit sampled instruments on your computer. With the Keymap tools 
and functions you can easily combine individual samples into great sounding sampled instruments. 
Import your EXS24 instruments, loop your samples, use Harmonic Resynthesis to reshape sounds and use 
a variety of mapping tools for getting to your desired result very quickly, without leaving the Keymap 
environment.  Keymap offers a unique environment where you can import your instruments and samples 
and tweak, edit, loop, re-synthesize, spatialize and much much more…

When you are ready to use your instruments in your music, you can export the them as industry-standard 
Logic/Logic Express EXS24 instrument files and samples. Each sample file created by Keymap always 
contains complete sample mapping details so that it can be imported into any sampler application, on 
any platform.

What Keymap is not:
Keymap is not a performance instrument (meaning: it’s not a plug-in, you don’t insert it into a host DAW’s 
audio channel strips) and it is not a replacement for the EXS24 or EXS24P. Keymap is a standalone 
application which doesn’t need Logic to run, but natively handles the EXS24 instrument format, and is a 
natural companion to Logic. Keymap does contains its own playback engine so you can hear the edits in 
realtime; however we do not emulate the EXS24’s filter section or the modulation matrix. You’ll typically 
use Keymap to create or edit instruments which you will subsequently load into the EXS24.

Keymap focuses on the editing and creation of cohesive, excellent sounding, and exceptionally playable 
sampled instruments from your raw samples or instruments, using sophisticated yet intuitive tools. 
Keymap does not force a specific workflow on you: flexibility is intrinsic in our design.  We firmly believe in 
offering you a variety of tools and functions, and letting you determine your own preferred way to use 
them.
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Note: This guide expects you to already know the basics of sampling and of the EXS24 (or EXS24P) 
software instrument. If you are a Logic user but you are not familiar with your version’s sampler 
instrument, please read its description in the Logic Plug-ins Reference Guide.

Hybrid virtual memory audio engine
Keymap uses a hybrid virtual memory engine so that samples do not have to be loaded completely in 
RAM before you can start using them. This means that even when working with huge instruments, load 
time is always reasonably short, depending on your Mac’s hard disk performance.  Keymap automatically 
loads from disk the required audio as needed, and ignores audio not currently needed for playback. The 
audio engine also lets you use samples in compressed audio formats, as MP3 and AAC with no limitations. 
The decoding is performed in realtime, with no need to decompress sounds before editing them. This 
might add an extra CPU load on your computer, but the hybrid virtual memory engine takes care of 
reusing the decoded data when appropriate. For all intents and purposes the original sample format is 
simply irrelevant to you as a user.

Multichannel sample support
Keymap has been designed to support up to 8 output channels per sample. Through channel maps you 
can remap channels to a different configuration, for each single Zone. On output you can assign up to 16 
Keymap audio channels to your audio device, remapping each Keymap out to any audio device out for 
maximum monitoring flexibility.

Open formats
Keymap is all about using open or standard formats and allowing free information exchange. Keymap 
imports WAVE, AIFF, MP3 and AAC format audio, and exports audio in WAVE and AIFF formats. All the 
sample files created by Keymap contains information about the placement of the sample in an instrument 
map, and the position of loop points, so that those samples can immediately be loaded and used in any 
audio application. 

We choose to support directly the Apple EXS24 instrument format because:
• The EXS format is one of the oldest and most supported instruments formats available
• You can convert almost any other instrument format from/to the EXS format
• The EXS format is arguably Apple’s “official” format for the Mac platform, being the sample format used 

in GarageBand, Logic Pro and Logic Express.  
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When exporting projects to the EXS24 format, samples using complex Keymap-only features are rendered 
and/or split in order to be compatible with the EXS24 audio engine or other traditional two channel 
sample engines.

Virtual samples
Instead of playing samples directly, Keymap plays non-destructively edited samples (Virtual samples), that 
you can cut, copy, paste, slice, shift, fade, loop at your pleasure. The fact that that you can manipulate 
sounds without touching the files on disk means that you do not have to worry about undoing changes 
and sharing samples among instruments, you have more freedom to experiment, and edits are always 
very quick.

The actual sample on disk referenced by both zone 1 and zone 2

In this zone we cut a portion and added a fade out

In this other zone we cut a different portion and did not add any fade out

Each single Zone appears to have an independently editable sample file, even if they are 
using the same sample file on disk. All this is realtime, non destructive and does not 
create additional sample files until you export to EXS24 format.

Zone 2

Zone 1
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Harmonic resynthesis
One of the main problems you’ll find with sampling, past the initial excitement, is that you often want to 
build a coherent /cohesive sound out of many different samples but the samples cannot be modified as 
fluidly as you’d like, and not in the context of an instrument. While you can use the traditional resampling 
to adjust the pitch of a sound, after that the timing of the sample will also be changed. Or imagine you 
have two wonderful vibrato flute samples, but the vibrato speeds don’t really match...or you have a piano 
sample which you think sounds a little too much like a harpsichord and you’d like it to sound more like a 
grand piano. Sometimes you also have the inverse problem: samples are too similar and you need to 
differentiate them in order to create a sense of more breath, variety and dynamics.

Previously, applications have allowed you to change some properties of sounds, as pitch and time,  but 
only one sample at a time. Traditionally you have to use time-stretching algorithms and/or plugins to do 
this destructively for each sample file, and then reassemble the whole instrument and hope that it plays 
they way you imagined. This approach is inefficient and can kill creativity and experimentation.

Harmonic Resynthesis (HR) is a proprietary technology we have introduced to the field of sampled 
instruments editors for manipulating pitch, time, formant and amplitude of samples in the context of 
entire sampler instruments in a simple and intuitive way. The same way movies use computer graphics to 
create realistic scenes that would be otherwise impossible to shoot, Harmonic Resynthesis works by 
analyzing your samples, and creating in realtime new sounding samples using the original as a basis.

For maximum flexibility, each Zone has an individual HR engine and set of parameters that you can tweak 
in realtime. You can also edit multiple Zones at once and immediately hear the results, in the direct 
context of your instrument. 

For each of the four main Harmonic Synthesis sound property parameters, you can directly draw and edit 
envelopes to achieve the exact result you want. When you change the Time envelope, you will not 
actually be seeing a change in the length of the sample on screen, but you will see that the playback 
cursor will smoothly change its speed to follow the envelope. As another example, the amplitude 
envelope is not a volume-change control, but the real, final, volume of the sample for each point.  You are 
not limited to changing the whole sample length, but you can speed up or down an attack in a subtle 
way, smooth a vibrato or correct the sample amplitude only where you need it, directly draw the shape of 
your drum loops on screen, or freeze the decay in a sample, or…. do you get the idea?  Harmonic 
Resynthesis offers an immense range of applications!

Editing of  HR envelopes is done either by drawing with the mouse or by using tools that allow you to 
expand or reduce the effect, grab and smear the envelope, or smoothly reset the envelope to its original 
shape. While this is extremely flexible, we also added parameters to let you perform common tasks as 
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pitch correction or normalization in realtime through sliders,  without having to edit the envelopes 
directly.

You can use Harmonic Resynthesis to polyphonate a sample.  In other words you can load a sample and 
build re-synthesized versions of it for the two surrounding octaves. The polyphonated Zones will play for 
the same exact amount of time, so that you can very easily use this to create harmonies of spoken words, 
or other similar applications where you are stuck with very few samples and you want intermediate 
samples too.

While at this point the “Resynthesis” part of “Harmonic Resynthesis” should be clear, we still have to 
explain the meaning of “Harmonic”. By “Harmonic” we mean that this kind of resynthesis is targeted to 
sounds with a clearly defined and possibly tuned set of  fundamentals and harmonics (also called 
harmonic sounds). Most acoustic instruments, voices and synth sounds are harmonic sounds. Drums are 
not harmonic sounds, and neither are drum loops or effected sounds. The amplitude control is an 
exception to the “harmonic sounds only” rule, as it will also work with inharmonic or non tuned material, 
and actually will give fantastic results with drum loops as you can directly draw the drums shape.

HR is available in three different algorithms, HR-A , HR-B and HR-C.  The HR-B version  differs from HR-A in 
that you can’t change formants, but you have higher quality on complex harmonic audio material. HR-C is 
for pitch only and is of very high quality. Each algorithm can be selected independently for each Zone.

Audio Effects
Each Keymap Zone offers a set of individually configurable Low Pass and High Pass filters with settable 
frequency and resonance. Keymap also includes a couple of saturators and a stereo width reducer/
expander. These simple effects allow you to mix and match and fine tune different samples so that they fit 
together better, and these effects can be also used to combine several layers of sounds harmonically so 
that, for example, one layer plays the low frequency portion of the sound over the whole keyboard range, 
while another layer just adds the top frequencies (imagine a low pass filtered grand piano layered to an 
high pass filtered rhodes). As always, the settings are editable individually Zone by Zone, or by selecting 
and editing multiple Zones at once.

Multiple objects editing in inspectors
In most of the Keymap editors, whenever you select multiple objects (i.e. Zones, or Groups), you can edit a 
value in the inspector and all selected objects will be edited at once. This makes it extremely easy to 
assign a Group to multiple Zones, or edit all Zones to have a certain top velocity range.
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Smart edit 
In the Instrument editor, dragging a border common to adjacent Zones will edit both Zones at once. You 
can also split Zones and drag and drop Zones across layers and instruments.

Tessellation engine 
“Tessellation” refers to the creation of repeated shapes that do not overlap or have any gaps, which very 
often is exactly how you want to create sample Zones. The Instrument editor uses a tessellation engine 
which will automatically cut Zones in order to make space for others, and allows you to add Zones or 
delete map areas without having to edit all affected Zones directly. Slide Over and Slide Under modes let 
you protect either the edited Zones, or the unedited Zones when dragging Zones. 

Display guides 
You can add visual alignment guides to help you place Zones on the map, with and without snap.

Dynamic velocity remapping 
You can remap whole layers over velocity through a real-time velocity envelope.  This is like the inverse of 
having a velocity curve, in that you are keeping the incoming velocity as it is, but you are changing the 
placement of Zones over the velocity range.

Quadrasmooth
Very often, the multiple samples you’ll place in an instrument will have slight volume differences. 
Quadrasmooth lets you visualize these differences over the sample map as variation of a color, and then 
easily identifies and corrects these differences. You simply set the desired volume for the four corners of a 
layer, and Quadrasmooth will automatically change all Zones volume in that layer, based on the amount 
of correction desired.

Zone crossfades
Sometimes you will notice  small “jumps” in sound between adjacent sounds due to the fact that the 
samples are different. Keymap lets you set a crossfade area individually for each Zone in order to have a 
constantly mixed transition between different samples. You can also create optimized Zone crossfades 
automatically for multiple Zones at once, and then simply tweak the crossfade scale to minimize or 
maximize the effect. Zone crossfades are individually settable for both notes and velocities ranges.
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Sample editor in Instrument editor window
Instrument editors and resources windows contain a smaller sized, but fully featured sample editor, so you 
can edit samples while looking at the instrument, with no need to switch windows back and forth.

Single cycle loops
Keymap offers great tools for creating and editing single cycle loops. You can create a single cycle loop by 
simply selecting a point of the sample and pressing a key. Keymap will also automatically set the loop 
tune so that the single cycle plays at the right pitch, and can also retune short loops of arbitrary length, 
letting you to explore different formants for that cycle,  a bit like a sync oscillator does in a synth. 

Single Cycle Explorer
Sometimes you might be working on long evolving samples and you might want to experiment with the 
single cycle loop at various points over the samples length. The Single Cycle Explorer lets you move the 
single cycle around the sample by dragging a slider.  You can also use this for multiple Zones.

MIDI Learn
MIDI Lean allows you to set note and velocity parameters by using a keyboard controller.

Pitch and Time correction in Instrument editor
Keymap offers non-destructive, undoable HR Pitch correction and HR Time change directly from the 
instrument window. If you are working with looped samples, you can time stretch the loop duration 
separately from the attack duration.

Samples Drag and Drop 
Keymap offers extensive drag and drop support of WAV, AIFF, MP3 and AAC samples into the Instrument 
editor. You can also drag whole folders, and each folder will be placed in a separate layer that is 
automatically named after the folder. When you drag and drop samples, you can also use modifier keys in 
order to automatically create a Group for those samples, or to map each sample to octave intervals. You 
can also substitute a sample in an existing Zone, simply by dragging and dropping a new sample over an 
existing sample.
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Advanced selection methods 
Keymap offers an extensive number of  ways to select Zones. You can select Zones directly with your 
mouse or you can select the currently playing Zones. You can select Zone Templates (empty Zones) or 
Zone Placeholders (Zones with missing samples).  If you wish to work with a MIDI controller, Keymap also 
let you select Zones between the last two played notes. Once a selection is made, you can move, or 
extend it using cursor keys.

Audition mode
With only a few key presses, you can define an area to play repeatedly, even across the end of a loop. 
When you adjust the sample start or loop position, the playback area will move with the parameter, 
allowing you to continuously preview the change without waiting for a complete playback cycle around 
the loop (which is very desirable when editing loop points, for example).

Autosplit
Keymap can split long recordings into individual virtual samples automatically. The split Regions can also 
be trimmed automatically to user settable attack and release levels.

Autophase
With the Autophase function, you can move sample start, end and loop to zero crossings automatically, 
also for multiple Zones.

Interactive attack and release trim
With Keymap you can select a portion of a sample, or a Zone, or even multiple Zones, and tweak a slider 
for trimming the attack to a desired dB level. The same can be done for the release. This let you select your 
Zones containing raw samples, set the two values, and…you’re done! When you are doing this on a single 
Zone or single Sample, the trim points are visualized in realtime.

Autolooping
Finding an optimal loop in a sample is often a difficult, boring and time consuming task. Keymap offers a 
series of extremely powerful autolooping tools that enables you to find loops in your sample material 
very easily. While a lot of complex DSP is required for this to happen, we designed the simplest possible 
user interface for it. You basically select a sample area (up to the entire sample), and you “Autoloop”  it, and 
that’s all. You can also search for loops parametrically, by limiting the search Zone only to a certain range 
over the sample. Autolooping can be performed for multiple Zones at once.
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Automapping
When creating instruments from scratch, another arduous task is to load each sample, assign the proper 
root notes and adjusting the Zone borders. Keymap offers several Automapping functions that let you 
place samples over the Keyboard automatically by using pitch detection, or mapping data from the 
sample files, or the root name embedded in the sample filenames. You can also select if you want the note 
ranges built so that the root note is placed on high note, on low note or in the middle of the note range. 
And obviously you can just set the root notes, leaving the existing note and velocity ranges as it is.

Magic Pads
In each Instrument editor you have a set of Magic Pads, which are drag and drop destinations for sample 
files. Each Magic Pad performs a series of actions over the dropped samples. Among the various available 
functions, with Magic Pads you can autosplit and autotrim samples, then automap them, and finally 
autoloop them. This lets you go from the raw recording to a playable instruments in seconds, so that you 
can concentrate on fine tuning the results. 

Remapping
Sometimes you might need to rearrange Zones for a specific use. Keymap offers an extensive selection of 
remapping functions. You can remap to white or black keys only, or you can compact Zones toward low 
notes or high notes, or remap them from a certain note with a certain interval, etc...

You can swap the latest two played Zones, or expand Zones to fill the whole map. You can also simplify 
existing complex instruments by setting how much you want to reduce the number of Zones. Once Zones 
are set to the proper root note, you can also have Keymap build the Zone ranges for you.

Keep and Remove 
Instead of just relying on the usual Zone selection, Keymap offers two dedicated markers (“Keep” and 
“Remove”) for each Zones. In this way you can mark Zones (using selection, or by playing notes, etc), and 
at the end only keep the ones marked “Keep”, or remove the ones marked “Remove” .  Used together with 
the available remapping functions, this makes for very flexible and intuitive construction of instruments 
from a MIDI Controller.

Group chain editor
A Group chain is a sequence of Groups that will repeat in a “round robin” fashion. Keymap offers a 
dedicated and intuitive graphical editor for creating Group chains. You can connect Groups through 
graphical connections so that it’s very easy to visualize the chains at any time. 
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Dedicated Group Select editors
Keymap also offers dedicated graphical Group editors for setting velocity range, select-by-pitch and 
select-by-controller ranges.  Group Keyswitches are visualized on the Virtual Keyboard, and you can set a 
specific MIDI Channel for each Group.

Graphical Amp Envelope editor with Group offsets editing
The Amplitude Envelope has its own graphical editor, where you can grab and drag envelope points. 
When a Group is selected, you can still edit the envelope, but instead of editing the actual envelope 
parameters, you are actually editing the envelope offsets for the selected Group. In this way you can build 
an arbitrary number of different envelopes for use in your instruments, without having to deal directly 
with the complexity of the Group offset parameters.

Cursor navigation and editing
You can freely navigate across Zones and Layers using the cursor keys, and using key modifiers you can 
also merge layers, move Zones across layers, and change/extend selection. This allows for a very efficient 
editing experience.

High performance sample overviews
Keymap uses a heavily multithreaded sample overview engine that has been designed for speed and 
flexibility. Overview generation is very quick, and performed in the background, so you do not have to 
wait for overviews to be created when opening a new sample file. At any time you can view from any 
sample position to any sample position, with no limitation on the zoom factor. This let you use your 
screen space for displaying only the portion of sound you are interested to. An optional “TruView” mode 
let you see on screen the actual result of your fade and crossfade operations on the sample, and not just a 
superimposed envelope. This is extremely useful for visualizing any unwanted phasing in crossfades.

Full support for mouse scroll wheel / Mighty Mouse
Keymap uses the Mighty Mouse trackball and scroll wheel features for navigation in most of its windows. 
In the Instrument editor you can pan using the trackball, while in the sample editor you can zoom in/out 
and pan in a way you have never seen before. 

Horizontal Sample Autozoom
Many times you may find yourself working with a zoomed out sample display, and need to set a cursor to 
a sample accurate position. Keymap has an automatic (horizontal) autozoom feature, where you can grab 
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and hold a cursor or marker with the mouse, and Keymap will start zooming in around the cursor until 
you start moving the mouse again, or just release the mouse button. In this way you can go from a 
completely zoomed out sample to your sample accurate view without having to mess with scroll bars and 
zoom settings at all. When you are finished, you are back to your original sample view. Simple and 
effective.

Vertical Sample Autozoom
In some situations, especially with decaying samples, you may find that the sample view shows you very 
little information. You’ll see a huge peak at beginning, and then the waveform oscillates near zero with a 
long tail. This happens because your samples have a lot of resolution (and possible dynamics) but you 
only have a few hundred pixels on screen to display that data. In Keymap you can enable a Vertical 
Autozoom function that will automatically zoom in and out in order to fill the display with a useful sample 
waveform, not empty space. At any time, the visualized dynamic range is displayed on screen. This 
function lets you, for example, select a small portion of a decaying sample, and when moving the view 
toward the decaying end you’ll keep seeing the waveform displayed for the full vertical pixel resolution of 
the sample view.

Advanced sample naming and renaming
When rendering new samples, or simply renaming existing samples, Keymap offers an highly 
sophisticated parameter-based naming system, where you can combine more than 20 different 
parameters (as Zone name, project name, low and high notes, velocities, root note, date, time, etc) into 
the new sample name. It becomes very simple to create samples with the name structure that best suits 
your needs. When you create new samples you can use the parameters also for creating subfolders.

Slicing, slice mapping and loop remix
You can slice a sample manually, at regular points or at transient points, and then shift the content of 
individual slices around. Slices can be played back with a continuous crossfade system allowing glitch-free 
playback. Through cursor keys commands you can navigate across slices and shift their content in real 
time and very intuitively, effectively remixing the content. This is especially interesting with rhythmic 
loops. You can also select  slices and map them to individual notes on the Keyboard.

Regions
For each Zone you can create Regions, each containing its own set of basic parameters (start, end, loop, 
etc). Regions can be created by manual selection or by auto-splitting long samples containing multiple 
sounds, and can also be used for working with alternative settings, as loop points, for each Zone.
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LiveDB sample database
Keymap contains Redmatica next-generation scanning database engine (LiveDB). This system has been 
designed to couple the advantages of database systems (no need to scan every time)  with the 
advantages of scan (data always in sync with what is on disk). When you add a new folder/drive, it will be 
scanned just once at roughly three times the speed of  ExsManager 2.9 . After this first scan, a full 
database update usually takes a few tenths of second even for databases containing many hundreds 
thousands files. The small-footprint database file is automatically loaded/saved from disk. Basically, once 
you set the paths where to search for samples, searching samples is not a problem anymore.

Statistics
Keymap can display and update in realtime statistics about the currently active project. A dedicated 
Statistics window shows more than 40 statistics, while the most important ones, i.e. the number of Zones 
and the total sample size, are permanently displayed in your Mac system menu at the top of the screen.
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Chapter 1: Keymap project structure
Before we start: how things are organized inside the EXS24
A good editor should always show you the data in an organized fashion in order to make it easy for you to 
see what you want to edit, and then edit it. This is especially needed with sampled instruments because of 
the enormous number of parameters and settings they can potentially contain. For example,  in the EXS24 
editor, the organization of elements in an instrument is as shown in the following diagram:

Instrument

GroupsZones

Samples

An instrument is built out of a number of Zones and Groups. The Zones reference the samples and 
contain the mapping parameters (note range, velocity range, loop, etc). The Groups are used to Group 
edits the Zones and to control their playback conditions (controller, note off triggering , keyswitch, etc). As 
you can see, the Zones are all in the same “basket”, and this can be a really big and potentially confusing 
basket if you have many Zones. Every time you need to change something in the sample (example: 
normalization), you also need to destructively edit the samples.  Combining two instruments in one is 
done by copying all Zones and Groups from one of the instruments and pasting those Zones and Groups 
into the other instrument, but in doing so you lose the ability to quickly edit one instrument or the other 
individually.

Page 31



How things are organized inside a Keymap project
Keymap extends the EXS24 organization by introducing new organizational elements such as Setups, 
Layers and also introducing non destructive editing to samples:

               

Setup

Instruments

GroupsLayers

Zones

Non 
destructively

edited
samples

Samples

In order to avoid potential confusion, a single Keymap instrument file is called a “Keymap Project”, or KMP 
file. A project consists of one (and only one) Setup element in which you can create or load Instruments 
(as many as you want). Think of the Setup as sort of like a “Combi” of Instruments. Each Instrument 
contains Groups as in EXS24. However the Instruments do not contain Zones directly, and at this level we 
instead have Layers. 
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Setups
In each keymap project you always have one and one only Setup. The Setup lets you load and map 
multiple instruments over the keyboard so that it’s very easy to build layered or stacked sounds out of 
existing instruments. A bit like “Combi” or “Setup” mode in hardware synths, you can transpose each 
instrument, limit its playing range, add a velocity offset, and temporarily mute it. Working at the Setup 
level makes a lot of sense if you want to rearrange instruments over the keyboard without going into the 
detail of what exactly each instrument contains. The Setup level also contains the Amplitude Envelope, 
which is common to all instruments in each project. As we’ll see in the Groups chapter, this is not that big 
of a limitation as you can get individual envelopes through Groups. 

Instruments
Going down in the organizational hierarchy, the Instruments element in Keymap resemble their EXS24 
counterpart as they are the main holders of all the sounding things.

Layers
Layers are one of the most important concepts in Keymap. Each Layer contains a matrix in which sounds 
(Zones) are mapped over notes and velocities, and you can have as many layers as you want for each 
single Instrument. 

From the Instrument point of view, Layers are overlapping workspaces which respond all to the incoming 
MIDI messages for that Instrument. When a certain note is pressed on the MIDI keyboard with a certain 
velocity, all the layers will play at the same time if they have a sound assigned for that note and velocity. 

Layer 1

Layer 2

Layer 3

MIDI Messages going through all layers

A peculiarity of Layers is that each single Layer cannot contain overlapping Zones. If you want to overlap 
Zones you will simply place them in separate Layers. This paradigm makes for a much clearer visualization 
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of things, and allows the introduction of many useful editing and remapping functions, which would not 
really make sense with overlapped Zones. Each individual Layer also has a set of parameters which allow 
you to quickly change parameters at the Layer level: volume, pan, Zone crossfades and much more. Each 
Layer can also be muted, soloed and you can assign a Layer name.

Layers are also very useful as workspaces in which you can work on sounds/samples which you then copy 
or move to their destination layer.  We’ll explore all of this in detail later in the Layer chapter.

Zones
Inside each Layer we find one or more Zone elements. A Zone is a placeholder for a sample reference, but 
also contains important parameters, as the note and velocity ranges over which the sample should play, 
the root note, the transposition and tuning, the start and end sample point, the loop points, and all other 
parameters that affect how the sample will be played in the context of the layer. 

A Zone can also be created without a reference to a sample file. In this case the Zone is referenced as a 
Zone Template, which can be later “filled” with a sample. Zone Templates are very useful if you have a 
map model that you just want to fill of samples each time you build an instrument.

Groups
Groups in Keymap are very similar to their EXS24 counterparts. The fact that in Keymap you can edit and 
set parameters for multiple Zones at once directly makes the note and velocity ranges settings in Groups 
less important, but Groups still remain the holders of the Zone selection logic, and through Groups you 
can set a number of conditions for the Zones to play. The conditions might be a certain controller range, a 
pitch bend range, a keyswitch or the use of a specific MIDI Channel. Group chains can also be defined so 
that you can have round-robin style playback of properly assigned Zones, and much more. Through the 
use of Group Amplitude Envelope offsets you can also define and use more than one Amplitude Envelope 
in each project.

Virtual Samples
The term “virtual” is notoriously abused, but you will see how in the Keymap context it makes perfect 
sense. While usually samplers play sample files, Keymap plays non destructively edited samples. This 
might appear a small difference but it’s not.  Each virtual sample is conceptually similar to an audio track 
in the Logic Arrange, in which you can cut/paste/shift, change volume, add envelopes to the samples, and 
so on, while your actual files are left untouched on disk. When a Zone is played in Keymap it’s like 
triggering an audio track in Logic, and any change or edit over the virtual sample is computed in real-
time. This completely non-destructive approach lets you normalize samples, change their dynamics, pitch 
correct, time stretch as simple parameter/envelope changes that you can change and tweak at any time 
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over the life of a Keymap project. When saving in EXS24 file format, all the edits that cannot be translated 
to the EXS24 capabilities are rendered in new standard-format sample files that Keymap creates and 
assigns automatically to the EXS24 Zones so that you can hear the same exact sound/edits inside the 
EXS24.

This approach has the advantage of being quick and fully undoable. As only the kmp file content changes 
over the life of a Keymap project (samples are never modified!), features like the Keymap built-in 
“autobackup kmp files” makes perfect sense to keep track of all changes and being able to go back at any 
moment. 

Each individual Zone has its own Virtual Sample, which is totally independent of all other Zones, even in 
the case that the actual Sample on your hard drive is used by more than one Zone. In other words, when 
you edit a specific Virtual Sample, you can be sure that no other Zone will be modified by mistake. Of 
course, when you need it, there’s a number of functions in Keymap allowing you to edit multiple Zones at 
once.

Sample references are saved with a project only if the sample is being used by a Zone. Keymap lets you 
temporarily add samples without Zones to a project with the File > Add Samples to the current Project 
menu, but that’s intended only as a way to open a sample editor for a sample in your current session, 
before referencing that sample in any Zone. If you want your project to maintain a reference to a sample, 
even if you are not really using it in your project, you can always create a Zone for that sample in a muted 
layer which you’ll use as a workspace for editing tasks.

Basic handling of loop points, crossfades, start and end points does not require a new sample to be 
rendered for the EXS24 , however you can render your samples in order  to get individual samples out of a 
long recording sample, or if you want looped samples without any unused audio data past the loop end. 
For simplicity, we’ll refer to Virtual Samples as “Samples” . Just keep in mind that these are very special 
samples!

Real Samples
Real samples are the actual sample files on disk, and they are never modified or overwritten by Keymap. 
Each time you render samples, a new set will be created so that, you can always revert to previous project 
versions. In normal use, rendering is something that is done rarely: typically just once you are satisfied 
with the project and want to export your instrument to the EXS24 for creating music in Logic.
 

Note: Keymap allows you to use standard WAVE and AIFF formats for samples, but also compressed 
formats as MP3 or AAC, with no special limitations. 
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Keymap will also put full mapping and looping data inside each rendered sample file, so that it’s easy to 
import those samples in any other application. An advanced naming panel allows you to render samples 
with very intuitive or complex names built, among other things, out of more than 20 different dynamic 
parameters.

The only exceptions to the “real samples are never modified” are when you choose to rename samples 
from within Keymap, or add mapping and loop data chunks into the original sample files. 

The structure of Keymap windows and editors

Keymap offers several interconnected project editors. Each editor focuses on a specific project element or 
task.

Global windowsProject windows 

Instrument editor 
and Sample view

Setup editor

Sample editor
Resources 
window 

and Sample view

Surround+Space

Preferences 
window 

Statistics window 

Key commands
manager
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Keymap also has one preferences window and one statistics window, which are not strictly part of the  
currently open project, and will not close when you close the project. The statistics window however will 
show you statistics for the currently loaded/active project. The key commands manager let you display 
and edit the assignment of commands to keys.

All of the project editors typically offer one or more graphic views in which you can directly edit objects 
using the mouse, and then one or more inspector sections where you can directly set or tweak  
parameters. One common inspector feature is that wherever it makes sense you are able to select 
multiple items of the same type in the workspace and set parameters in the inspector directly for all of 
them at once. At the same time when you select multiple items of the same type you can see the 
common values they share in the inspector boxes.  Another Keymap feature is that for most editing tasks 
you will not need to open the full sample editor window that Keymap provides, since smaller but still fully 
functional sample views (also called “auxiliary sample editors”) are embedded in other editors wherever a 
sample is involved. This lets you work in a single editor for most of the time without the hassle of 
switching back and forth between different windows.

Special attention has been given to visualization—in other words, in making sure that the editors give 
you clear and precise visual information at all times. We also focused on workflow efficiency through the 
extensive use of key-commands, key modifiers, context menus and scroll-wheel/trackball navigation.
In order to offer a better editing experience tailored to your system, Keymap offers three different layouts 
for the main two editors (Setup editor and Instrument editor). You can select the one better suited to you 
in the preferences. 

Wherever it makes sense, MIDI learn  (represented by a blue M button) is also available for parameters,  
and real-world units (Hertz, Cents, Note names, dB, etc) are used. For some parameters it’s also possible to 
switch between different measure units by opening the context menu over the parameter description.

Parameter 
value

MIDI Learn

Value stepper

CTRL-Click 
to change 
displayed 
measure 

unit

We’ll now have a very quick tour of the various editors and windows.
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Instrument  editor
This is the most important editor in Keymap. Thanks to the multiple auxiliary editors available in the 
window, you can edit Zones, layers, Groups, samples, Regions, amp envelope and instruments with no 
need to switch windows.
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Sample editor

This window lets you access the full set of sample tools, and lets you edit samples, loops, slices, Regions 
and Harmonic Resynthesis envelopes.
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Setup editor

In this window you combine multiple instruments into a Setup, and can edit properties for each 
instrument and for the setup, including the amp envelope.
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Resources window

This window let you see in tabular form the samples, Zones, layers, instruments for your current project. 
An auxiliary sample editor let you also visualize and edit samples.
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Surround+Space mixer

In this window you place and mix each of Keymap’s sixteen stereo surround busses into the soundfield 
with a selection of algorithms and multiple output configurations.
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Statistics window

In this window you can see statistics about your current project.

At all times, the information regarding the number of Zones and project sample size is also displayed in 
the system menu bar on the top of your screen.
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Key Manager

In Keymap each function or command can usually be performed either as a menu command, or by using 
key commands. As the key commands are user-definable we won’t mention them explicitly every time in 
the guide, but using key commands is the recommended way to access functions.
This Key Manager window lets you see the key commands, and change key assignments.
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Preferences
The preferences page let you set the audio device, the search engine, and other parameters used to 
personalize your Keymap experience

Menu Conventions
In the guide we’ll often refer to menu commands. A hierarchical menu command will be written as 
follows: Menu > Menu Entry > Function. When using menus, remember that menus are disabled when 
an operation can’t be performed, as in the case of copying a selection of objects if a selection is not 
available.

Blank areas in the guide
This guide has been written using a large number of snapshots and graphical illustrations. In order to 
Group paragraphs and images in a logical way, some guide pages might not be completely filled with text 
and images. This is intentional.

Key commands
Almost all menu functions have equivalent key commands. Sometimes this guide will mention key 
commands explicitly: we’ll refer to the default key assignment. Be aware that key commands assignments 
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are user definable and can be changed as you prefer. You can search for the assignments from the Key 
Manager window.

The vast majority of key commands also are also tied to specific editors, and so the same key can have 
different functions depending if you are in the sample editor, or in the Instrument editor. Again, you can 
see this from the Key Manager.

Key modifiers
Keymap makes extensive use of key modifiers, namely the shift, the option, the control and the 
Command keys, which you press in conjunction to other keys or to the mouse. In this guide we’ll both 
explicitly mention them as modifier keys (“… pressing the Shift key modifier and the W key will 
perform…”) and also describe them in a synthetic way (“...shift+W will perform…”).  The two expressions 
are equivalent.

It’s all interconnected! Please read the guide twice.
Keymap is an application where all the functions and editors are heavily interconnected. For this reason 
we’ll inevitably have to make references in this guide to things that are explained “later”. We suggest 
reading this guide twice, since it is our experience that during the second reading everything will “click” to 
its place.
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Chapter 2: Setting up Keymap

The first time you launch Keymap, you will need to configure the application for your system. This is done 
from the preferences panel. The things that you’ll need to configure are:

1) The Audio Device in the “Audio” preferences tab.

Audio Device

Main stereo outs

Set all EXS outs to Main outs

EXS bus out to Audio out 
assignation table

If your audio device has multiple outs, you will also need to set which set of outputs Keymap will use as 
main outs. The Main stereo out pop-up menu lets you select which stereo audio output you want to use 
as main Keymap stereo. Setting this menu is not the only step to reconfigure audio outputs. For the new 
main outputs to be used you will also to click  the Set all to main stereo outs button. Then Keymap will 
route all the EXS/Keymap outputs to the selected main stereo outs.

You do not have to set MIDI devices, as Keymap always responds to all attached MIDI controllers. 
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2) The preferred layout to be used for the editors in the “General”  preferences tab:

Editors layout

Keymap offers different sizes for several of its editor windows in order to better match your screen size. 
The default layout will be the most suited for your current screen size, but you might want to use a 
different one. This setting is relevant only for the new editors you are going to open: currently opened 
editors won’t change layout.

3) You also need to set the locations where you store your sample files folders/drives in the “Search 
Engine” preferences tab, so that the Keymap integrated sample database (LiveDB) will know where to 
search for samples when needed. 

Add sample location

You can click on the “+” button to add paths or folders, and click on “-” to remove them. Once a path has 
been added, you can change it by clicking the “Set Path” button. 
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LiveDB will automatically self-update every time this is needed, but the very first time it will have to scan 
the newly added drives and folders and it takes some more time, so you might want to do it now by 
clicking “Update database”. LiveDB has been designed to work in  a “set-and-forget” way, and will 
automatically load/save and update with no need for you to do anything.
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Chapter 3: Let’s build an instrument

Before explaining the various Keymap editors and functions one by one, let’s dirty our hands a little bit by 
building an instrument from scratch using some of the demo samples available on the Keymap CD or as a 
download from the Redmatica site.  We’ll assume you already set up the audio device correctly as 
described in the previous chapter.

Let’s build the SynthA instrument.
After installation, Keymap will create a new instrument by default when launched. You can later disable 
this in the preferences if you wish. For now, ignore or close the Setup editor, as we’ll only use the 
Instrument editor. 

Open the folder containing the SynthA samples

Notice how the samples have quite anonymous names, and no trace of a root note name.
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Select the sample files and drag them into the Instrument editor, roughly in the middle of the layer matrix. 
In these pictures you will see the a compact layout Instrument editor, but of course you can use other 
layouts as well.

Dropped Samples turn 
into Zones

Current 
layer

Root 
notes

for 
selected 

Zones

Red outline means the 
zones are selected

Note how new Zones (blue rectangles) have been created in the current layer matrix for the samples you 
dropped. The Zones are one note wide, with the root note set to that note. The red outline means that the 
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Zones are selected. Whenever Zones are selected, you can see their root notes highlighted in red over the 
virtual keyboard. Notice also how Zones have been placed over notes in alphabetical order based on their 
sample names.

With the Zones still selected, use the Zones > Automap > Automap using pitch analysis root notes  
menu.

 

Keymap analyzes the samples and places them at the appropriate position in the map, with the root note 
set properly.
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And here are the results of automapping:

Notice how the samples 
are now properly placed in 

the matrix

The root notes are now 
properly set from pitch 

analysis

If you try to play the instrument it now sounds perfectly mapped.
However, after playing a note for a while, the sound stops. This happens because the samples are not 
looped yet. 
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So what we are going to do now is autoloop the Zones. Make sure the Zones are still all selected, and then 
select the Zones > Loop > LowRes Autoloop command.

In a few seconds the samples will be non destructively looped. Once autolooping ends, try playing notes 
again, and you will notice how the sounds play indefinitely.

You can now save the project as an EXS24 instrument by using the File > Save menu.  By default you are 
saving in Keymap format, but you can select EXS24 format in the popup menu found in the save panel.
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Set the name you want to use here

Select the instrument format 
you want to use here

(and ignore the rest for now)

Do not be intimidated by all those parameters. For now we won’t use them, and you will learn all about 
them later.

Click “Save” and that’s all. 

Congratulations! You have just built your first instrument with Keymap from scratch, complete with 
autolooping, and without having to edit anything. The whole process could probably have been done in a 
couple minutes.

Welcome to the world of Keymap!
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Chapter 4: Instrument Editor Overview
The Instrument editor is the most important Keymap window and has been designed for an efficient 
workflow with most of the functions just one mouse click away. The editor makes extensive use of context 
menus which you access by clicking the right mouse button (or ctrl+single mouse button) over the main 
window elements. 

In the Instrument editor you typically edit Zones, layers, Groups and the instrument parameters, but 
through the built-in auxiliary sample editor editor you can also edit samples form here., You can drag and 
drop samples into the matrix to create Zones automatically, or to assign samples to existing Zones.

Virtual 
keyboard

Layer Matrix

Zones 
inspectors

Groups 
inspector

Layers inspector

Setup inspector

Dynamics 
envelope

Auxiliary 
editors

Group
Chains
editor

Zone
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The Instrument editor window contains several elements.  The largest element is the layer matrix, in which 
Zones can be created and placed graphically over note and velocity ranges.

At the top we have  an integrated Virtual Keyboard with full velocity range control, which is used to play 
notes using the mouse, to see which note is being played from MIDI, and to visualize Zone root notes and 
other useful data.
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The Setup inspector resides in the upper-right, with parameters for crossfades, envelopes, dynamics and 
vibrato. These parameters are shared with the whole project (actually with the setup in the project), not 
just the edited instrument. 

Dynamic crossfade 
parameters

Volume Envelope 
parameters

Dynamics parameters

Vibrato
 parameters

Continuing down the right we see the Layers inspector.

Layer table

Layer parameters

Dynamics remapping

Magic pads

At any point, the layer displayed in the Layer matrix  is the one selected in the Layer table. 
Each layer has an independent dynamics remapping envelope, which is useful for changing the velocity 
mapping and/or restricting the dynamic range of the each layer. At the bottom of the layer inspector box 
you see five Magic pads, each of which can apply a different set of functions to samples dragged and 
dropped over them. These pads are very useful for quickly performing some preset common tasks.
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On the right bottom we see the Groups inspector,  containing the Group table, with the associated 
parameters. An important section at the bottom handles the selection parameters for Groups, 
determining when a Group should become active or not. As we’ll see, the selection mechanisms are very 
important for creating complex, dynamical playing instrument.

Groups table Groups parameters

Groups selection 
parameters
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At the bottom-left, we see the Zone inspectors. We use the plural because each Zone has a huge number 
of individual parameters, which are presented in seven distinct tabs, subdivided by area of pertinence. If 
you select multiple Zones, the inspectors will display the common values and will still let you edit the 
other ones, so that it’s very easy, as example, to set all Zones low velocity with a single edit action from 
the inspector.

Main
 Zone

parameters

Harmonic
Resynthesis
parameters

Trim edit 
and

Regions

Single 
Cycle
loop 

explorer

At the bottom of the main Zone inspector tab you also find the Single cycle loop explorer. This long slider 
let you automatically navigate through single cycle loops for harmonic samples, just by moving it to the 
desired relative position.

Above the screen area of the Zone inspectors we see the Auxiliary (aux) editors.  These small but fully 
functional editors let you visualize and edit important data in the context of the Instrument editor so that 
you will rarely need to switch to other windows. The most important aux editor is  the Aux Sample Editor 
(also named sample view to distinguish it from the full-featured sample editor).

Auxiliary sample 
editor
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This editor shows you the sample assigned to the currently selected (single) Zone. The sample view 
becomes inactive when you select multiple Zones, or when no Zone is selected. 
Another auxiliary editor is the Amp Envelope editor, showing at all times the amp envelope for the current 
project. Note that even if we have a single amp envelope for each project, you can actually have many 
different variations by using the Groups offset feature. More about this later.

Amp Envelope
editor

Among the aux editors we also find the main Group velocity/xfade range editor, which lets you select 
the velocity range for which the Group(s) will become active and will play linked Zones.

Main group select
range editor

And we also can see the smaller editors for the Group selection respectively by controller and by 
pitchbend.

Group select 
by ctrl editor

Group select
by pitchwheel editor
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We have one last editor in the Instrument editor window and it’s the Group chains editor, accessible 
through a tab on the left of the layer matrix.

Group chains
editor

With the Group chains editor it becomes very simple to visualize and edit even the most complex round 
robin Group structures.

Virtual keyboard
The virtual keyboard in Keymap is used both for displaying information and for playing notes using the 
mouse. This latter operation is  quite straightforward, as you just have to click over the representation of 
the keyboard keys. The note velocity for the played Zones depends on the vertical position of the mouse 
cursor over the keyboard when clicking. Click a note at the bottom and you will get a low velocity note. 
Click at the top and you will get full velocity. If you prefer, a setting in preferences lets you reverse this 
behavior, so that you get low velocity at top and high velocity at bottom. 

The virtual keyboard also displays note-related informations by highlighting the virtual keys with colors. 

High velocity

Low velocity

Playing notes in Red
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At any moment:

red notes are the currently playing notes, both from mouse or from MIDI.

light red notes are the root notes for the selected Zones. The root notes will be displayed only if the View 
> Extra  and the View > Show > Root Notes  menus are enabled. This let you have a less visually crowded 
virtual keyboard in case you do not want to work with root note parameters. 

green notes are keyswitch notes set in Groups.

blue notes are the range of the currently dragged Zones (and they will appear only when dragging 
around Zones).

light blue notes are the original note range of the currently dragged Zones

yellow notes show the note range in between the last two played notes (Keymap always remember the 
latest two played notes and can use that information for selecting Zones).

The virtual keyboard can also be used to edit the root notes for the selected Zones: select the Zones in the 
layer matrix, and then drag the light red notes on the virtual keyboard with the mouse by holding the 
option+Command key modifiers and then clicking and dragging the root notes around on the virtual 
keyboard. This kind of edit is also possible for multiple Zones.

You can also select the currently playing Zone by holding the Control key modifier while clicking notes 
on the virtual keyboard, or from he MIDI Keyboard. Using this functions, you can inspect very quickly the 
Zone parameters for the note you hear.
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Cursor inspector, MIDI Monitor, Zoom and Guides
Above the virtual keyboard we have various small inspectors and buttons. 

Layer 
matrix tool 

selector

Mouse 
position 

inspector

Selection 
inspector

Action
inspector

MIDI
monitor

Layer 
matrix

slide mode 
selector

Horizontal 
zoom

selector

Tessellation
mode 

selector

Add 
display 
guide

button

Starting from left, the layer matrix tool selector lets you select the current tool for the layer matrix.  

The cross represents the selection tool. This is used for selecting, resizing and moving Zones around the 
layer matrix.

The pen represents the pen tool, which is used for drawing Zones in the layer matrix

The square represents the erase tool, which is used for deleting Zones or create arbitrary empty spaces in 
the layer matrix

Another tool, the scissors tool, is always available from the layer matrix by pressing the Command key 
modifier (vertical scissors tool), or the shift+Command key modifiers (horizontal scissors tool).

The mouse position inspector shows you the current note and velocity position of the mouse cursor 
inside the layer matrix. This is useful when you want to do precise edits.

The selection inspector displays the current number of selected Zones.

The action inspector displays in detail the current action being performed with the mouse.

The MIDI monitor displays both the notes being played by any external MIDI source connected to your 
computer, and the notes that you play on the virtual keyboard. The small blue “x” button at the right of 
the  MIDI monitor is an “all notes off” panic button.

The horizontal zoom selector let you select the zoom level for the layer matrix. The available zoom levels 
are typically 1X and 2X, but some editor layouts (as the wide setup editor) are fixed at 2X and in that 
layout you won’t actually see the zoom selector. 
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Next, to the right, is the slide mode selector. Slide mode is a very important concept in Keymap, and it 
lets you select how Keymap handles overlapping Zones in a layer. We need to remember that in Keymap, 
Zone overlaps in a layer are not allowed. However, while moving selected Zones around with the mouse, 
you can overlap them as long as you hold the mouse button pressed. The slide mode selector essentially 
lets you select what happens when you release the mouse button.

Unselected zones

Selected zones

Slide-over mode

Unselected zones cut to avoid overlaps

Selected zones

While dragging selected zones around ... and after releasing the mouse button

In slide-over mode, the selected Zones are considered to be placed over the unselected Zones. When you 
drag selected Zones and release the mouse button, Keymap will cut the unselected Zones in order to 
make space for the selected Zones you are dropping over them. 

Selected zones, cut to avoid overlapsSelected zones

Slide-under mode

Unselected zones

While dragging selected zones around ... and after releasing the mouse button

Unselected zones
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In slide-under mode, the selected Zones are considered to be placed under the unselected Zones. When 
you drag selected Zones and release the mouse button, Keymap will cut the selected Zones in order not 
to overlap the pre-existing unselected Zones at that position.
What actually happens in both modes is slightly more complex. As you might imagine, Zones are 
graphically visualized as rectangles, and so Keymap can’t simply cut a part of a Zone, as it wouldn’t be a 
rectangle anymore! Here is where the tessellation engine steps in and solves the problem. 

For a start, what does “tessellation” mean? From the dictionary:

tessellate |ˈtesəˌlāt| (also tesselate)

verb [ trans. ]
cover (a plane surface) by repeated use of  a single shape, without gaps or overlapping.
DERIVATIVES
tessellation |ˌtesəˈlā sh ən| (also tesselation) noun

The tessellation engine automatically recognizes situations where cutting a Zone would result in an 
irregular, non-rectangular shape, and splits this shape in a number of rectangular Zones, each a copy of 
the original one.

The tessellation mode selector let you select if you prefer the irregular shape to be split horizontally or 
vertically. Once the slide mode and the tessellation mode are selected, this is what Keymap actually does 
through its tessellation engine:

Copy of 
Zone2

Zone2

Copy of 
Zone2

Zone2

Zone1

Copy of Zone1

Zone1

Copy of Zone1

Zone2

Zone1

Tessellation engine in slide-over mode

Zone1

Before releasing the mouse button With vertical tessellation

Zone1

With horizontal tessellation

Zone1

Tessellation engine in slide-under mode
Before releasing the mouse button With vertical tessellation With horizontal tessellation

Zone2 Zone2 Zone2
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And of course, while this example shows just two Zones for the sake of simplicity, Keymap can handle 
multiple Zones at once. After all this talk about overlapping Zones not being allowed, we need to 
remember that while Zone overlaps are not allowed in a single layer, you can certainly overlap as many 
Zones (and relative samples) as you wish by using multiple layers.

Back to our screen controls, at the right we find the add display guides button. Display guides are 
vertical and horizontal lines that serve as handy visual elements  which you can place on the layer matrix 
as a visual reference.  This is especially useful when moving Zones around.  As previously mentioned, 
Guides can be vertical (over a single note) or horizontal (over a single velocity level). Once you click the 
guides button, a panel will let you select the guide type and value.

Guides are especially useful when the View > Snap to guides menu function is enabled. Once created, 
guides can be moved by dragging around the corresponding small yellow triangle, and can be deleted  
by dragging the guide triangle to velocity zero, or note zero.

Independent Virtual Sample 
As we have seen already, instead of referencing a sample directly, each Zone has its own virtual sample. 
The advantage of this is that you can edit the samples in each Zone without interfering with other ones. 
Each single virtual sample only references audio data from a single real sample file, so it’s not possible to 
cut and paste between different sample files.
At all times you can see the referenced real sample file name and path from the Zone Inspector as shown 
in this illustration. 

Referenced sample

Referenced sample
path

A more comprehensive and detailed view of the samples used in your Zones can be seen in the resources 
window.

Page 68 



Chapter 5: Layers in the Instrument Editor
The Layer matrix shows the Zones contained in the currently selected Layer, and you can see and select 
Layers in the Layer table. The order of layers is not strictly important as they will all respond to incoming 
MIDI messages in the same way. You can‘t select more than one layer at once.

Layer table

Layer parameters

Dynamics remapping

Magic pads

Create a layer
When you create a new project using the File > New menu command, the default instrument contains 
one single empty layer. You can create new empty layers using the Layers > Create menu command.

Duplicate a layer
You duplicate an existing layer including all of its Zones by first selecting a layer and then using the Layers 
> Duplicate menu command. 

Delete a layer
You can delete the selected layer by using the Layer > Delete menu, or by using the backspace or delete 
keys in the Layer table.
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Layer mute, solo and viewable checkboxes

Each layer can be muted and soloed in the layer table through the [M] and [S] checkboxes. Regarding 
layer muting, note that when exporting to the EXS24 file format only the non-muted and non solo-muted 
layers will be saved, with the muted layers discarded. 

When your instrument has more than one layer, sometimes you may want to edit the Zones in one layer 
with respect to the position of Zones of other layers. This would seem to pose a problem, since you can 
select and display only one layer at at time. The “viewable” checkbox  (“[V]”) solves this problem by letting 
you select which layers you want to always display in the matrix background. 
 

Layer 1 selected and displayed in the matrix Layer 2 selected and displayed in the matrix

By clicking the "viewable" [V] checkbox for Layer1, 
you can now select, see and edit Layer2

 while Layer 1 is still displayed in the background

How the "Viewable" layer checkbox works 
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Layer volume and pan
Each layer has independent volume and pan settings, so that you can easily adjust the volume for the 
whole layer, instead of having to edit Zone by Zone. When exporting to EXS24 format, the volume and 
pan are factored to the individual Zone parameters.

Layer crossfade factors
Each layer has two independent settings (NX Fact and VX Fact) for adjusting any static Zone fades that 
you might have defined. The NX Fact slider will increase or decrease the note crossfade for all layer Zones 
with  defined note fades. Similarly, the VX Fact slider will tweak the velocity fades.
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Chapter 6: Zones in the Instrument Editor
In the Layer matrix, Zones are visualized as rectangles over a certain note range and velocity range. When 
a note within both the note and velocity ranges for a certain Zone is played on the MIDI Keyboard or 
virtual keyboard, that specific Zone will be played. The Layer matrix makes this process very evident, as 
any incoming played note will be displayed as a small red dot in the matrix,  at the crossing of the played 
note and its respective velocity, so that you can see at any moment which Zone in the layer is being 
played. For a Zone to emit sound, it must reference an existing sample, and the layer must not be muted 
or solo-muted.

Velocity display 
guide

Zone template

Zone placeholder

Normal 
Zone

Note 
display 
guide

Selected 
Zone

Notes

Velocity

Zone types
In Keymap there are three different types of Zones which are displayed differently:

Blue Zones are normal Zones, referencing a sample.

Dark Zones are Zone templates, i.e. they occupy a space in the layer matrix but they don’t actually 
contain any reference to a sample yet, so they are mute. You normally use Zone templates to create maps 
that you will later fill with samples. You can convert a normal Zone to a template using the  Zones > 
Convert to Template command, and you can convert a template to a normal Zone by dropping a sample 
over it.
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Light patterned Zones are Zone placeholders. These already reference a sample, but the sample file was 
not found  when Keymap opened the project. These Zones too are muted until you re-load the project 
with the samples available.
When these three Zone varieties are selected, the Zone borders appear drawn in red color. Unselected 
Zones have a light gray color border.

Create Zones
You can create Zones in Keymap using several different methods. Each Zone gets its own independent set 
of parameters,   and creating or modifying a Zone doesn’t affect other Zones, even if they are referencing 
the same sample file.

Create Zones when you have one sound for sample file

CREATE BY DRAG AND DROP FROM FINDER
This is probably the simplest way to create Zones from existing samples.  When you drag samples from 
the finder and drop them into the layer matrix, Keymap will create a sequential series of Zones in the 
matrix, each spanning one single note, at the drop point.  You can create wider one-octave Zones by 
pressing and holding the Shift key modifier while dropping the samples. If a layer is not selected in the 
Layer table when you drop the samples, then a new layer will be created for you, and samples placed 
there.

Not only you can drag and drop multiple samples, but you can also drag and drop multiple sample 
folders. For each folder a new layer will be created,  appropriately named, and the samples from each 
folder will be placed in Zones into the respective layers.  

If you drop samples while pressing the Option key, a new Group will be created and automatically 
assigned to the new Zones.

When draging and dropping samples, Zones will be created sequentially in alphabetical order of the 
referenced samples, with special consideration for any note name that might be embedded in sample file 
names. This means that  the proper musical order of note names is respected (as example: “Flute-
C#4.wav” is placed after “Flute-D2.wav” even if alphabetically it would come before). Note that the notes in 
the sample names will not be used automatically for mapping the Zones on the layer. You can do that 
later, using the Zones > Automap > Automap command using root from sample files name menu.

You can also drop samples, one at a time,  over existing Zones or Zone templates. In this case, the existing 
Zone content will be discarded and replaced with the new sample. This feature is very useful if you want 
to replace a few Zones without the hassle of deleting and creating new ones, or if you simply want to fill a 
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layer comprised of Zone templates already placed at the right map position.  When performing this 
operation normally all Zone parameters are reset, but if you press and hold the Command key while 
dropping a sample over an existing Zone, you will replace the sample but keep the existing main Zone 
parameters as tuning, pan, volume.

CREATE BY DRAWING ZONES
You can directly draw Zones using the pen tool from the layer matrix tool selector. The pen tool intuitively 
let you draw Zones anywhere in the layer matrix, and any existing Zone will be tessellated to make place 
for the newly drawn Zone. 

Normally the pen tool draws Zone templates with no reference to a sample, but if you press and hold the 
Option key when drawing Zones, you will be asked to select a sample file for each newly drawn Zone. 
Using the same key modifier, if you click with the pen tool over an existing Zone, you will be able to select 
and assign/reassign a sample file for that Zone.

TRICK: CREATE BY SPLITTING EXISTING ZONES: when you need to work with duplicates of existing 
Zones, it’s often very convenient to enlarge the Zone and then split it using the scissors tool.
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Creating Zones using multiple sounds imbedded in one sample file

When creating instruments from scratch, very often you do not have already split and trimmed samples, 
but instead a few long recordings of multiple  sounds, recorded one after the other, with silence used as 
separator.

From a single long recording 

we want to split individual 

sounds and define a new zone 

for each sound

The typical multiple-sounds single-recording situation

Keymap offers an extensive variety of methods for mapping these recordings, some involving the sample 
editor. Normally Keymap lets you open the sample editor from Zones. In this case we do not yet have 
Zones, so we will open the sample in the sample editor by using the Files > Add samples to current 
project command.
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CREATE ZONES BY MANUAL SELECTION IN THE SAMPLE EDITOR
The basic idea with this method is to add the sample recording to an open project and then manually 
select the desired sections of the recording from the sample editor and map them as Zones using the 
Samples > Map > Map selection set of menu functions. The note position at which the Zone will be 
created depends on which variation of the “Map selection” menu you use.

Samples > Map > Map selection sequentially to current layer will map each selection sequentially 
(useful for drums, or phrases, for example). 

Samples > Map > Map selection with MIDI learn to current layer will ask you to press a note on the MIDI 
keyboard to select on which note to create the Zone.

Samples > Map > Map selection with pitch detection to current layer will analyze the pitch of the 
sample selection and map the Zone at that note.

These three manual methods will create Zones one note wide. This is the recommended way to build 
layers in Keymap, as you can always expand each Zone to fill empty layer space using the Zones > Remap 
> Expand menu function. Conversely, once the layer is completely filled by Zones, you can shrink each 
Zone again to  one single note (its root note) by using the Zones > Remap > Remap to root note menu 
function.

Tip: it’s very useful to use the Samples > Selection > Trim selection to sample menu command (H 
key command) when selecting single segments, as the selection will be automatically resized to the 
start and end positions of the audio segment in the recording.

Selecting individual audio segments with ease

Select the outside of the audio 
segment

Samples>Selection>Trim 
selection to sample

The selection closes onto the audio 
segment
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CREATE ZONES BY AUTOMAPPING A SELECTION IN THE SAMPLE EDITOR
Keymap lets you automate the splitting and the sequential/pitch detection process described above with 
the automap functions available from the sample editor. Just select the desired section of the sample 
containing all the sounds you want to map, and use the Samples > Automap > Autosplit and Automap 
selection sequentially to new layer menu function if you want to create Zones in sequential fashion. 
Alternatively, the  Samples > Automap > Autosplit and Automap selection by pitch to new layer menu 
function  will create Zones mapped using pitch detection.

Note: each split segment is automatically trimmed using the levels set in the preferences panel. If 
you do not get the expected results, you might have set those values too high or too low.

CREATE ZONES BY DRAG AND DROP OF THE RECORDING FILE OVER MAGIC PAD #1 IN Instrument 
editor: the Magic pad #1 (the leftmost one) performs the splitting and mapping task automatically and 
creates Zones sequentially in a new layer. This method is useful when dealing with recordings of drums, 
effects or sound phrases.

CREATE ZONES BY DRAG AND DROP OF THE RECORDING FILE OVER MAGIC PAD #3 IN Instrument 
editor: the Magic pad #3 (the third from left) performs the splitting and mapping task automatically, 
analyzing the pitch for each sound,  and creating Zones mapped at the detected pitch notes, in a new 
layer. This method is optimal when dealing with tuned harmonic sounds belonging to the same 
instrument. This magic pad also automatically deals with multiple samples for each detected pitch by 
sorting them by volume over velocity. This way you can create multi-note multi-velocity layers directly 
from a recording.
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Special Zone creation methods
Keymap also includes two specialized creation methods, well suited for creating complex instruments.

CREATE MULTIVELOCITY ZONES FOR A SINGLE NOTE FROM SELECTION IN SAMPLE EDITOR
With this function you select a section of your recording containing an arbitrary  number of sounds 
sampled at different velocities (for example a snare, or a guitar, or a piano), then use the Samples > 
Automap > Autosplit and Automap to a single as multivelocity menu function to automatically split 
those sounds and create the respective Zones into the layer, at the same single note. The Zones are 
mapped over the velocity axis  based on their relative volume.

Zone from Hit #5

Zone from Hit #4

Zone from Hit #3

Zone from Hit #2

Zone from Hit #1

Select the whole sample and then
Samples>Automap>Autosplit and Automap to a single 

note as multivelocity 

Hit
#1

Hit
#2

Hit
#3

Hit
#4

Hit
#5

Five new zones are automatically created in the 
current layer, each referencing the 

corresponding hit, sorted by volume 

Page 79



Note: each split segment is automatically trimmed using the levels set in the preferences panel. If 
you do not get the expected results, you might have set those values too high or too low.

CREATE A COMPLETE INSTRUMENT BY DRAG AND DROP OF THE RECORDING FILE OVER MAGIC PAD #2 
IN Instrument editor (AKA PARAMETRIC AUTOMAPPING)
This method is the most complex method available in Keymap and allows automatic construction of 
multi-velocity instruments with keyswitched variations and pseudo-randomization features. The 
recording you are going to drop over Magic Pad #2 must be well structured for this function to work 
properly, and you must plan how you want the instrument configured in advance. 

As an example, let's say that for each of the three variations of your hihat (closed, mid, open) and for each 
of the two velocities you'll want to record, you also want four equivalent samples to be played in round 
robin fashion so that the instrument sounds natural.

You just have to record the hihat in this ”hits by variation by velocity” sequence:
hit1-closed-lovvel
hit2-closed-lovvel
hit3-closed-lovvel
hit4-closed-lovvel

hit1-mid-lovvel
hit2-mid-lovvel
hit3-mid-lovvel
hit4-mid-lovvel

hit1-open-lovvel
hit2-open-lovvel
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hit3-open-lovvel
hit4-open-lovvel

hit1-closed-hivel
hit2-closed-hivel
hit3-closed-hivel
hit4-closed-hivel

hit1-mid-hivel
hit2-mid-hivel
hit3-mid-hivel
hit4-mid-hivel

hit1-open-hivel
hit2-open-hivel
hit3-open-hivel
hit4-open-hivel

When you drop this recording on the Magic Pad #2, Keymap will ask you the parameters for number of 
hits, variations and velocities, and if you either want to map samples sequentially (drums) or by pitch 
detection (harmonic sounds). Keymap will then automatically create an instrument in which keyswitches 
will change the playing Group from " closed " to " mid " to " open ", and then each of these 3 variations will 
play in round robin fashion the correct 4 hits, and the velocity will also select the right velocity set. In 
situations where there is only one variation, or only one “hit” per variation, the corresponding keyswitch 
or cyclic Group chain selection will not be enabled/created. With this function you can really create very 
complex instruments with minimal effort.

Note: each split segment is automatically trimmed using the levels set in the preferences panel. If 
you do not get the expected results, you might have set those values too high or too low.
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Editing Zones with the mouse
Once Zones are created, you can edit them in the layer matrix using the mouse, when the selection tool is 
active. There are five sensible areas in a Zone as shown in the following illustration. 

Resize left Resize right

Resize
top

Resize 
bottom

Drag zone area

Note that the corners are not active, so that you always resize the note width, or the velocity height, but 
not both at the same time. 

When resizing multiple Zones over a border, Keymap automatically recognizes which of the selected 
Zones have the resized border in common and will edit all the Zones at the same time. This is very useful 
when you want to quickly change the note width of a multi-velocity set of Zones, or want to alter a 
velocity subdivision for the whole layer with a single edit action.

Needless to say, every time you resize or move Zones around, the tessellation engine is always ready to 
take care of any Zone overlap when you release the mouse button.

Moving Zones and the root note
Normally, moving a Zone across notes changes both the low note and high note parameters for the Zone, 
however sometimes you might also want to move the root note. For example, when you move around 
drum Zones you usually want to move the root note too so that the drums don’t sound transposed. On 
the other hand, when moving an acoustic instrument Zone you might want the root note to stay where it 
is, otherwise you’d get the wrong tuning.

Keymap lets you move Zones across notes in both fashions. By default the root note is not moved. If you 
however press the option+Command keys while moving Zones, the root note will remain “attached” to 
the Zone, and will be moved along with the Zone.
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You can use the scissors tool to manually split Zones. By pressing the Command key  you activate the 
vertical scissors tool, while using the shift+Command keys you activate the horizontal scissors tool. 
With both of these tools, only the selected Zones will be split at the scissors line, and this lets you split 
multiple non-contiguous Zones with a single action. When Zones are split, each resulting Zone gets its 
own independent set of parameters and a separate virtual sample, so that extending a Zone range and 
then splitting it, is a quick and efficient way to duplicate Zones.

The pen tool lets you draw new Zone templates or, by pressing the Option key, to create a new Zone in 
an empty section of the matrix from a specific sample. If you click with the Option key over an existing 
Zone, you will be asked to select a new sample for that Zone.

The eraser tool allows you to erase rectangular areas of arbitrary size in the matrix and uses the 
tessellation engine to split partially erased Zones. Just select the area you want to clear, and Keymap will 
do the rest.

Selecting Zones
The Zone selection mechanism in Keymap is very important, because once you select Zones you can view 
and edit their parameters in the Zone inspectors, transform them using Keymap functions, and operate 
with them in the matrix using the matrix tools.

Keymap offers several methods for selecting Zones in the Layer matrix. The straightforward method is 
select Zones with the mouse. A single click inside a Zone selects it, and you can extend the selection to 
other Zones by clicking the Shift key while clicking Zones.

It’s also possible to select Zones in a certain Layer matrix area by pressing the Shift key and dragging the 
mouse over that area.

Another method is to use the computer keyboard cursor keys. If no Zone is currently selected, pressing 
the left or right cursor keys will select the leftmost or rightmost Zone in the matrix, and then you can 
navigate through the other Zones using the cursor keys. Pressing the Shift key while using cursor keys 
extends the current selection.

Keymap also lets you select the last played Zone. This is done by holding the Control key while  playing 
on the MIDI or virtual keyboard. With this method you will only be able to select one single Zone (the last 
played) at once.
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If you want to select all the Zones in the current layer being played, you can use the Zones > Select > 
Select Playing Zones command. You must hold the played notes while you activate this function, as 
Zones still playing but in the release phase will be ignored.

Sometimes you might also want to select Zones in a note range from the MIDI Keyboard. Keymap always 
remembers the latest two played notes, and can select Zones in that range by using the Zones > Select > 
Select range between last two played notes  command. As a visual aid, you can enable the visualization 
of that range on the virtual keyboard by enabling the View > Show > Last MIDI selection menu function.

You can also select among the different classes of Zones (normal, template, placeholder), using the Zones 
> Select > Select placeholders and  Zones > Select > Select templates menu commands.

Other selection menu commands
Zones > Select > Select All 
All Zones are selected.

Zones > Select > Deselect All
All Zones are deselected.

Zones > Select > Invert selection
The selection is inverted, i.e. selected Zones become unselected, and unselected become selected.

Zones > Select > Deselect playing Zones
The currently playing Zones are deselected. The note keys must actually be held while performing this 
function. Zones still playing but in the release phase will be ignored and not deselected.

Zones > Select > Deselect templates
All the templates in the layer will be deselected

Zones > Select > Deselect placeholders
All the placeholders in the layer will be deselected

Zones > Select > Deselect range between last two played Zones
The Zones in the note range between the last two played notes will be deselected. The notes can be 
played both from the MIDI or from the virtual keyboard.
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Zones > Select > Select Zones at higher notes
If you already have Zones selected, this function will select the nearest Zones along the notes axis toward 
the right. 

Zones > Select > Select Zones at lower notes
If you already have Zones selected, this function will select the nearest Zones along the notes axis toward 
the left. 

Zones > Select > Select Zones at higher velocity
If you already have Zones selected, this function will select the nearest Zones toward the top, along the 
velocity axis. 

Zones > Select > Select Zones at lower velocity
If you already have Zones selected, this function will select the nearest Zones toward the bottom, along 
the velocity axis. 

Zones > Select > Extend select Zones at higher notes
If you already have Zones selected, this function will extend the selection to the nearest Zones toward the 
right along the notes axis. 

Zones > Select > Extend select Zones at lower notes
If you already have Zones selected, this function will extend the selection to the nearest Zones toward the 
left along the notes axis. 

Zones > Select > Extend select Zones at higher velocity
If you already have Zones selected, this function will extend the selection to the nearest Zones toward the 
top, along the velocity axis. 

Zones > Select > Extend select Zones at lower velocity
If you already have Zones selected, this function will extend the selection to the nearest Zones toward the 
bottom, along the velocity axis. 

Zones > Select > Extend select playing Zones
This function will extend the selection to the currently playing Zones. Note that the note keys must 
actually be held while performing this function. Zones still playing but in the release phase will be 
ignored.
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Keep/remove system 
The nature of sampling, coupled with the fact that you’ll often want to integrate a MIDI Keyboard into 
your workflow convinced us to develop a new mechanism whereby you can not only select Zones, but 
you can mark them as “keepers” or  as “to be removed”.  We call this mechanism the Keep/remove system. 

Typically you will use this mechanism when you drop samples in the Layer matrix, and subsequently 
audition them using MIDI or the virtual keyboard. When you hear a sample that you want to keep in the 
layer, you’ll mark the playing notes as  Keep. If you hear samples you don’t like, just mark them as 
Remove. The Keep Zones will change color and be displayed in a lighter blue, while the Remove Zones 
will change to brown color. 

There are two ways to mark Zones for Keep, one by selecting them and then using the Zones > Keep/
Remove > Mark selected Zones for Keep command and the other by marking the currently playing notes 
with Zones > Keep/Remove > Mark playing Zones for Keep command. The equivalent menus also exist 
for Remove.

At any moment, you can perform the Keep function, using the Zones > Keep/Remove > Keep menu 
command and all Zones in the layer will be removed except for the ones marked as “Keep”. Similarly the 
Zones > Keep/Remove > Remove menu command will remove all Zones marked as “Remove”. Notice 
how the two functions are slightly different, in that one lets you concentrate on the Zones you like, while 
the others is focused on the Zones you don’t like.

Note also how the Keep and Remove functions are independent from the selection mechanism. In other 
words, when you Keep or Remove your Zones you do not need them to be selected. This is done so that 
you can mark playing notes from a MIDI Keyboard and perform an action through key commands without 
having to touch the mouse.

As a suggestion, the most practical way for approaching the Keep/remove system is probably through key 
commands and not menus. You can check the Key Manager chapter for an explanation of how to find key 
commands for each function, and appendix E with the list of all the default key commands.

Other Keep/remove menu functions
Zones > Keep/remove > Clear marks for Keep
This function unmarks for “Keep” the selected Zones. 

Zones > Keep/remove > Clear marks for Remove
This function unmarks for “Remove” the selected Zones. 
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Other Zone menu commands

Zones > Convert to Template
This command will remove any sample reference from selected Zones, transforming them into templates.

Zones > Move selected Zones to Higher layer
This command moves selected Zones to the layer “above” the current one, as seen in the Layer table. 
Moved Zones will keep their note and velocity positions and all other parameters. If the moved Zones 
collide with pre-existing Zones in the destination layer, then a hole will be cut in the destination layer to 
make space.

Zones > Move selected Zones to Lower layer
This command moves selected Zones to the layer “under” the current one, as seen in the Layer table. 
Moved Zones will keep their note and velocity positions and all other parameters. If the moved Zones 
collide with pre-existing Zones in the destination layer, then a hole will be cut in the destination layer to 
make space.
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Static Zone crossfades
As we have seen, in Keymap no Zone overlaps are allowed in a single layer, but you can use multiple layers 
for stacking Zones and sounds. There are, however, situations where some kind of overlap in a single layer 
would be desirable, especially when you have adjacent Zones and you’d like to somehow blend the Zones 
to smooth a crude transition from one Zone to the other. Keymap offers a way for doing this through 
Zone crossfades.
 
As shown in the following illustration, a Zone crossfade between two adjacent Zones is essentially an area 
where the second Zone sound is progressively mixed louder, while the first Zone sound is mixed 
progressively softer.  When done properly, and when the adjacent Zones contain relatively homogeneous 
material, the transition jump can’t be heard anymore.

Zone 1 Zone 2Zone 1 Zone 2

Without zone crossfade

Sudden change when going from one 
zone to the other

With zone crossfade

Smooth change when going from one 
zone to the other

Crossfade 
area

In order to offer maximum flexibility, Keymap doesn’t implement Zone crossfades exactly as shown in the 
illustration, as that simplistic approach would stop working correctly when multiple Zones contribute to 

the sound in a complex multi-sample multi-velocity 
i n s t r u m e n t . W h a t K e y m a p a c t u a l l y o ff e r s a r e 
individually configurable fade areas around each single 
Zone through four parameters which let you set the 
fade range at the left, right, top, and bottom of the 
Zone. This approach lets you blend multiple Zones in 
any way, as you can extend each fade area over any 
portion of the Layer matrix area. As you can see in the 
illustration, the fade area is shown as a green aura 
around each Zone.

Fade area at 
the left

Fade area at 
the right

Fade area 
at the top

Fade area 
at the 

bottom
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By using the View > Show > Crossfades command, you can choose to always display the fade area, while 
the View > Show > Crossfades when selected will visualize fade areas only when the Zones are selected.

The canonical crossfade can be achieved by having two adjacent Zones extend their fade Zone by the 
same amount in the opposite directions as shown in the following illustration.

Fade at 
right of 
Zone1

Fade at 
right of 
Zone2

Once combined 
they form a perfect 
crossfade centered 

on the common 
border

You can edit the fade area for each Zone in the Layer matrix by moving the mouse cursor over the Zone 
borders, pressing the Option key and then dragging the border. You will not actually edit the Zone 
borders, but a green (fade) area around the Zone. When Zones are adjacent, you can select them and drag 
the common border using the shift+Option key. In this mode you will automatically create both fades at 
the same time, effectively creating a crossfade with minimum effort. 

As we will see later in this chapter, Keymap also offers some automatic functions that analyze the selected 
Zones and create fades of the right size around each Zone. Some further controls in the Layer inspector 
allows you to tweak and scale all fades for each layer with a simple couple of sliders.
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Here’s an example of complex crossfaded map built using the automatic Keymap functions.

It’s very important to note that creating Zone crossfades does not involve the creation of new samples, or 
the creation or use of other time and space consuming resources. When you save a project using Zone 
crossfades in EXS24 format, Keymap will simply create additional Zones around each Zone, referencing 
the same sample and with the same parameters, but with a Zone volume correspondent to the fade 
volume.

This however also means that if you try to reload such an EXS24 instrument, you will see a very different 
instrument respect to the one you saved, even if it will sound the same. For this reason, we recommend 
that you always save such projects in Keymap format before saving in EXS24 format.

Zone fade menu functions

Zones > Fades >  Create full note xfade
This function analyzes the selected Zones and sets the proper fade left and fade right values for 
smoothing Zone transitions along the note axis.

Zones > Fades >  Create full velocity xfade
This function analyzes the selected Zones and sets the proper fade top and fade bottom values for 
smoothing Zone transitions along the velocity axis.
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Zones > Fades >  Create full velocity xfade
This function analyzes the selected Zones and sets the all the proper fade values for smoothing Zone 
transitions both along along the note axis and the velocity axis.

Zones > Fades >  Clear fades
This function clears all the fade parameters for selected Zones. 
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Dynamic crossfade
As we have seen, the fade functions are very flexible in what you can do, but they are static, as they are 
tied to note and velocity information only. Once you press a note the correct blend of Zones will be 
played but you can’t change it dynamically using a modulation wheel while the note is being held.

For this reason, Keymap also supports a different kind of crossfade, called dynamic crossfade.

The two crossfade modes can’t coexist in Keymap in a single project, but you can switch from one mode 
to another without losing the individual Zone fade settings.

Dynamic crossfade mode is enabled as soon as the XFade parameter in the instrument inspector is set to 
a value other than zero, or you select a MIDI controller to be used instead of velocity with the “Vel mapped 
using” menu in the instrument inspector. After that, the green area around your Zones disappears, but all 
Zones display a light blue area extension along the velocity axis. 

 Those areas represent the fade area for the Zones. The length of the 
fade is the same for all Zones in your whole project, and is set using the 
XFade parameter. As you might already have imagined, the dynamic 
crossfade can only be applied along the velocity axis. 

When you play notes, the mechanism is similar to what we saw for static 
crossfades in that the Zone sounds are blended, with the important 

difference that if you are using a 
d y n a m i c M I D I c o n t r o l l e r f o r 
velocity you can now tweak it in 
re a l t i m e, a n d t h e s o u n d w i l l 
smoothly change depending on 
where the controller value maps 
along the velocity axis, as in the 
following illustration.

Dynamic fade area 
at top  of zone

Dynamic fade area 
at bottom of zone

With dynamic crossfades, once you assign a 
MIDI Controller to the matrix velocity axis, 
instead of the usual note-on velocity, you 
can dynamically change position along the 
axis by changing the controller value, and 
hear a dynamically blended sound from 
zones
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Zone parameters in the Zone inspector

Zones are the most complex elements in Keymap,  being repositories both for virtual samples and 
Regions, and offering more than one hundred independent parameters each. The parameters and 
elements can be subdivided into several logical categories as shown in the following illustration, and 
together determine when and how the sample will be played back.

  

Independent
Virtual 
Sample

Mapping 
parameters

Sample
Playback

parameters

Output 
parameters

Fade
parameters

Harmonic 
Resynthesis
parameters

AudioFX
parameters

Regions

Audio flow

Output parameters
The output parameters category includes volume,  pan, and the routing of the audio from Zones. Each 
Zone transmits audio on a number of channels, always numbered starting from channel one. So if a 
sample has two channels, its Zone will transmit audio on two channels (channel 1 and 2). If the sample 

Page 93



has 8 channels then its Zone will emit audio on 8 channels (channels 1 to 8).   Each Zone can route its 
audio output to four alternative destinations:
• To a direct EXS24 bus: the sound is directly sent to one of the EXS24 output busses. 
• To a Channel Map: the sound is sent to a Channel Map which let you swap channels, and reroute them 
to any EXS24 output bus.
• To a Surround+Space mixer bus: the sound is sent to one of the 16 busses in the Surround+Space mixer, 
where it can be spatialized or placed in a surround mix.
• To the destination selected by its Group (if the Zone is linked to a Group)

Routing to a direct EXS24 bus
This routing sends your audio channels directly to one of the EXS busses. 

Routing to a Channel Map
Channel Maps route each individual sample channel from the Zone to the available EXS24 busses. This let 
you swap channels, or remap multichannel samples to your designated busses. When routing a sample 
channel to stereo EXS busses you can also select if this channel is to be intended as a monophonic 
channel or as part of a couple of stereo channels.

Channel Map

Channel 1
Channel 2
Channel 3
Channel 4
Channel 5
Channel 6
Channel 7
Channel 8

EXS Bus 1-2
EXS Bus 3-4
EXS Bus 5-6
EXS Bus 7-8
EXS Bus 9-10
EXS Bus 11
EXS Bus 12
EXS Bus 13
EXS Bus 14
EXS Bus 15

Sample channels
from Zones

EXS24 Busses
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Since each sample channel is intrinsically mono but can be part of a stereo pair when routed to a stereo 
EXS bus, you can select whether the sample channel should be considered mono (so it will be sent 
equally to both channels of the EXS stereo bus), or the left channel of a stereo pair (sent only to left 
channel of the EXS bus stereo channels), or the right channel of a stereo pair (sent only to the right 
channel of the EXS bus stereo channels).

Sample channel  mapped to a Stereo EXS Bus 
as "Center"

Sample channel

EXS Stereo bus left

EXS Stereo bus right

Sample channel  mapped to a Stereo EXS Bus 
as "Left"

Sample channel

EXS Stereo bus left

EXS Stereo bus right

Sample channel  mapped to a Stereo EXS Bus 
as "Right"

Sample channel

EXS Stereo bus left

EXS Stereo bus right

Once defined, channel maps can be shared by several Zones, so that you can change the routing for 
multiple Zones, provided they are all using the same map. Note that a Zone routed to a channel map does 
not respond to Pan. 

Saving Zones using channel map routing to EXS24 format
Channel Maps are not directly supported by the EXS24. For this reason, when saving a project which uses 
channel map routings in the EXS24 instrument format, Keymap renders a new set of samples and creates 
the appropriate number of additional Zones so that the resulting instrument conforms to the limitations 
of the EXS24. We recommend saving the instrument in Keymap format before creating the EXS24 
instrument, so that you can keep working in Keymap with Channels Maps instead of multiple raw Zones.

Creating a new Channel Map
You create a new channel map by clicking the New button in the channel map editor
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Deleting a new Channel Map
You delete an existing  channel map by clicking the Remove button in the channel map editor.

Routing to a Surround bus
This is the routing to use when you want to spatialize your samples in the sound field. The complete 
description of how the sound is processed can be found in the dedicated Surround+Space chapter. For 
now know that there are 16 separate stereo buses going to the surround mixer for independent mixing 
and spatialization, so that you can position Zones in specific places around the soundfield.

How to set the routing from the Zone Inspector
You can use one of the possible routings by selecting your Zones and then setting the desired routing in 
the Out: pop-up menu of the Zone Inspector. When switching routing modes, a second pop-up menu lets 
you select respectively the bus, the Channel Map, or the Surround bus to be used. A button marked “E” 
lets you open and edit the Channel Map or Surround+Space editors directly from the Zone inspector, for 
an improved workflow.

Zone output 
routed directly

to one of the EXS24 
busses

Zone output 
routed to a custom 

Channel Map

Zone output 
routed to one bus in the 
Surround+Space mixer

Zone output 
routed as selected by its 

group
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Volume and Pan
You can change Volume and Pan for a Zone directly from the Zone inspector. The Volume is expressed in 
decibels, while Pan ranges from -100 (full left) to +100 (full right). The panning value will affect the sound 
only when the Zone is routed directly to an EXS bus: when using Channel Maps or going into the 
Surround+Space mixer, the pan value is ignored.

The Scale value let you change the Volume in function of the distance of the Zone from MIDI note 60, and 
is expressed in dB by octave.
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Mapping parameters
The mapping parameters are the core of a Zone definition, and express the note and velocity ranges over 
which the Zone will play,  the playback pitch, and the playback mode. The note range is defined by a low 
note and a high note, and the velocity range by a low velocity and high velocity. When a played note 
(with its associated velocity) hits both ranges simultaneously, then the Zone will be played.

Normally the played sample is being resampled at varying pitches over each note of the the note range, 
and the Root Note represents the note for which the the sample will be played with no resampling. If the 
Disable Pitch checkbox is enabled then no resampling will happen, and all notes of the Zone note range 
will play at the same pitch as the root note. You can change the pitch played at the root note using the 
Tune and FineTune parameters. 

Groups restrict note and velocity mapping area
We’ll talk in depth about Groups in a later chapter, but for now keep in mind that Zones can belong to a 
Group. When this happens, the mapping area of the Zone gets intersected with the Group
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and the Zone will respond only to incoming note messages for the common area, as shown in the 
following illustration of the layer matrix.

Notes

Ve
lo

ci
ty

Group area

Zone area

The 
zone will 

play in 
this area 

only
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Fade parameters
Fade parameters define the fade area around the mapped Zone in which the sound will progressively 
smoothly increase in volume and then fade to silence. The fade area is defined relative to the Zone 
mapping parameters, so that when you modify a Zone mapping, the fade area will still be linked to the 
new Zone  borders. The fade parameters are Fade Top, Fade Bottom, Fade Left and Fade Right.

You can also enable or disable fade areas using the Fade Enabled checkbox, and change the fade shape 
between linear/EQPower/S-Curve using the Fade Shape parameter.

Saving Zone crossfades to the EXS24 format
Zone crossfades are not directly supported by the EXS24. When saving to the EXS24 format, for each 
Zone, Keymap fills the fade area with many small copies of the Zone, each set at the appropriate 
decreasing volume in order to simulate the fade. We recommend saving the instrument in Keymap format 
before creating the EXS24 instrument, so that you can keep working in Keymap with fade areas instead of 
multiple raw Zones.
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AudioFX Parameters
AudioFX parameters are a series of audio effects available and independently adjustable for each Zone. 
We have a Low Pass filter with configurable frequency and resonance, a HighPass filter with adjustable 
frequency and resonance, two saturators and a stereo width control. The effects are chained serially.

The stereo width control is active only with stereo samples, while the other effects can be applied on all 
kind of samples. When talking of filters in a sampler you are probably thinking to the EXS24 filter section.  
AudioFXs have nothing to do with that and have been designed to spice up individual samples (in 
drumsets for example) or for spectrally combining different layers (imagine a composite sound created by 
a low pass filtered layer with a sound combined with a high pass filtered layer with a different sound). The 
stereo width parameter is effective as a simple soundfield enhancer without going through the full-
featured surround+space mixer.

AudioFX and EXS24
The EXS24 doesn’t have support for Keymap’s AudioFX. For this reason, when saving to EXS24 format, all 
samples using AudioFX will need to be rendered to new files. We recommend saving the instrument in 
Keymap format before creating the EXS24 instrument, so that you can keep working in Keymap with 
AudioFXs non destructively. 
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Sample playback parameters
At the heart of each Zone we have a reference to a sample, which is played back for generating sound. 
The sample playback parameters let you set where the playback should start, where it should end and 
optionally where the playback should be looped or if some fade in or fade out should be applied.

The SampleStart and SampleEnd parameters let you set the segment of the sample that will be played 
by the Zone (we will also call them start and end in this guide when no confusion might arise). The 
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FadeIn and FadeOut let you non-destructively apply some fading. The FadeIn length is relative to the 
SampleStart position and the FadeOut length is relative to the SampleEnd position, so that adjusting the 
start and end positions will not alter the fade lengths. MicroFadeIn and MicroFadeOut are specially 
shaped fades, applied similarly to FadeIn and FadeOut, that should be used in the 2-to-100 samples range 
for removing clicks from sample start and end. The two fades (Fades and Microfades) coexists and can be 
applied at the same time.

Normally the sample will play as long as you hold the note that triggered it. Activating the One Shot 
checkbox causes the Zone to ignore the length of notes used to trigger the sample and the sample is 
always played to the end. This option is useful with percussion and drums where you often don’t want the 
MIDI note length to affect sample playback. 

The sample can also have one loop defined and enabled. In Keymap a sample loop is defined by a 
LoopStart and a LoopEnd position. Once you enable the loop using the LoopEnable checkbox, when 
playback reaches the LoopEnd position, it will jump back to LoopStart.

As you can imagine only perfect loops will sound without glitches at the “join” point. For this reason 
Keymap let you set a non destructive loop crossfade, where a portion of the sample before the loop start 
gets mixed at the end of the loop in order to smooth the transition. You set the length of this segment 
using the Loop XFade parameter. You can also select a mix shape for the crossfade between linear, Equal 
Power and S-Shaped, with the LoopXFadeShape pop-up menu. As a suggestion, for simple waveforms 
the linear crossfade is probably the best choice, while complex audio will probably be better served with 
Equal Power. Needless to say, Keymap offers a variety of looping functions both at the sample and at the 
Zone levels. We’ll also see how the full fledged Sample Editor contains a dedicated loop editor.

Note: the S-Shaped crossfade is not directly supported by the EXS24 and requires new samples to 
be rendered.
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Editing sample parameters in the sample editor 
While the Zone inspector shows and let you edit these values in numerical form, you can also view and 
edit them in the Auxiliary sample editor. The sample editor contains several screen elements, called 
cursors, which let you change the respective parameters. 

Sample
Start 

cursor

Sample
End 

cursor

Fade-out 
cursor

Fade-in 
cursor

Loop
Start 

cursor

Loop
End 

cursor

Loop
XFade 
cursor

Loop
XFade
area

Without going into describing in detail how the sample editor works now, know that you can select one 
Zone at time and edit using the Aux Sample Editor cursors instead of the numeric parameters. 

Tip: When editing sample parameters, a very handy key command is the “Play” command , which is 
assigned by default to the space bar. This command will play the sample and let you hear the 
changes you made.
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Chapter 7: Regions
Sometimes you might find it useful to have alternate sets of sample parameters for the same sample, or to 
define audio segments from a sample that you will later map to individual Zones. Regions are Keymap 
elements designed exactly for these tasks. 

Each Region is basically an independent set of the following parameters: SampleStart ,SampleEnd, 
FadeIn ,FadeOut, LoopStart, LoopEnd, LoopXFade, LoopXFadeShape, and LoopEnabled 

Regions can be defined manually or by autosplitting samples. 
There are no special limitations to keep in mind with Regions: for each Zone an arbitrary number of 
Regions can be created, and they can overlap.  Regions are visualized both in a Region table, and 
graphically in the auxiliary sample editor as colored areas delimited in the ruler by Region cursors.

Region Table

Regions visualized
in the sample editor

Normally a Zone has no Regions defined and it uses the main set of sample parameters. Once you create 
Regions, you can switch between the main set and each Region set by selecting a Region in the Region 
Table. When one single Region is selected, it will become the active Region, and the Zone will play its 
sample according to the active Region. Also, all edits of the Zone parameters listed above will actually be 
editing the Region set, and not the main set, which is left untouched. 

Region cursors
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Moving the active Region cursors in the sample editor is equivalent to moving the SampleStart and 
SampleEnd parameters for that Region.

In the sample editor, Unselected Regions are displayed in light grey color, while the single selected 
Region (the active Region) is displayed in orange color. You can also select multiple Regions: in this case 
the Zone will revert to using the main set, and the selected Regions will be displayed in light orange color.

How to create a Region manually
Creating a Region is as simple as selecting a portion of the sample in the Aux Sample Editor and using the 
Regions > New Region from selection menu function. The newly defined Region will appear in the 
Region table, where you can now select it.

Select a segment in your sample and use the
 Regions>New region from selection menu function.

A new region will be created and displayed
 in the Regions table. If you then select it in the table, it will 

become active
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How to create a Region by autosplitting a sample selection
Keymap can split the audio segments for you and create the corresponding Regions. You just have to 
select a section in the sample editor and use the Regions > New Autosplit Regions from selection menu  
function as shown in the following illustration:

Select a section in your sample and use the
 Regions>New autosplitted regions from selection

 menu function.

The audio segments will be split and new regions created.
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How to create Regions at transients from a sample selection
Keymap can also detect transients in your samples, and create the corresponding Regions. You have to 
select a section in the sample editor and use the Regions > New Regions at transients from selection 
menu function, as illustrated here:

Select the sample and use the 
Regions>New regions at transients 

from selection 
menu function

The transients sheet opens

You are now able to tweak parameters 
watching the detected transients

Once you are happy with the detected 
transient points, click "OK" on the 

transients panel and new regions will 
be created, each spanning from one 

transient position to another 

How to delete Regions
Deleting Regions is as simple as selecting them in the Region table and pressing the backspace or delete 
key on your Mac keyboard, or using the Clear menu item.
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Region functions
Once Regions have been defined and selected, you have a few selected functions you can perform 
directly on them in the Region table. These functions let you copy parameters to and from the main set, 
autoloop Regions, and also map Regions to newly created Zones. 

Note: if you need to use other functions, remember that when you activate one Region you can 
use the full set of Keymap functions on that Region. 

Copy Region sample parameters to the main set
The Regions > Autoloop > Copy to main set menu function copies the Region parameters to the main 
set.

Copy the main set sample parameters to Regions
The Regions > Autoloop > Copy from main set menu function copies the main set  sample parameters to 
the selected Zones.

Autolooping Regions
Autolooping Regions is as simple as selecting them and using the Regions > Autoloop > Low Resolution  
or Regions > Autoloop > High Resolution menu functions. For each Region, the best loop will be 
searched for and set in its loop parameters. The main set is unaffected.
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Automapping Regions
With the Region automapping functions you create new Zones from  selected Regions.  

You have three distinct functions available for this:

Regions > Automap to new layer > Automap with pitch detection will pitch detect each Region and 
create a Zone at the detected note using the Region sample parameters.

Regions > Automap to new layer > Automap sequentially will create Zones sequentially using the 
Region sample  parameters.

Regions > Automap to new layer > Automap multivelocity to single note  will map all Regions to Zones 
on a single note, with Zones sorted along the velocity axis by the volume level of the sample comprised 
between each Region start and end parameters.
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Chapter 8: Harmonic Resynthesis 
Each Zone has an independent Harmonic Resynthesis engine and relative set of parameters and 
envelopes for controlling it. As we have explained at the beginning of this guide, with Harmonic 
Resynthesis you can reshape harmonic samples over four important properties: pitch, formant, time and 
amplitude. By default, Harmonic Resynthesis is not active for Zones until you explicitly enable it in one of 
the three HR Zone inspector tabs. In this chapter we won’t focus on the fact that you can draw graphical 
envelopes for each of these sonic properties, and we’ll instead describe the Harmonic parameters 
available from the Zone inspector. The best way to see how these these parameters are affecting your 
sound is to looking at the auxiliary sample editor for results. 

Note: HR is a resynthesis method, and not a pitchshift/timestretch function, and it will work 
correctly only with monotonic harmonic samples, with the exception of HR Amplitude, which can be 
applied to any kind of sample.

Harmonic Resynthesis algorithms
Keymap offers three alternative Harmonic Resynthesis algorithms: HR-A , HR-B and HR-C.
HR-A allows manipulation of pitch, formant, time and amplitude. HR-B instead allows manipulation of 
pitch, time and amplitude (you lose formant control), but it's better sounding with complex, high pitched 
harmonic sounds and for polyphonation. HR-C only handles pitch but at very high quality.  For maximum 
flexibility, the algorithm can be selected individually Zone by Zone.

How to set the Harmonic Resynthesis algorithm
Once you select one or more Zones in the layer matrix, you can change the Harmonic Resynthesis 
algorithm by setting the “HR Algorithm” pop-up menu as shown here:
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Note that changing the algorithm by itself doesn’t mean that HR will be turned on for those Zones.

How to enable Harmonic Resynthesis for the selected Zones
Once you select one or more Zones in the layer matrix, you can enable the Harmonic Resynthesis engine 
for those Zones by enabling at least one of the three master HR enable checkboxes.

At least one of the master 
HR enable checkboxes 

must be enabled for the 
Harmonic Resynthesis 

engine to be active

The first time Harmonic Resynthesis is enabled for a Zone, an analysis of the pitch and amplitude 
envelopes will be made, and this operation might take a few seconds for each Zone.

Harmonic Resynthesis and loops
As Harmonic Resynthesis creates a new sound starting from the original sample, and as looping is 
performed in the audio chain after the HR Engine, you might need to adjust your loop points, or apply 
some crossfade after editing the HR Parameters.  

Saving to EXS24
As the Harmonic Resynthesis features are not directly supported by the EXS24,  new samples need to be 
rendered when saving the project to EXS24 format. The rendered samples are normal sample files, 
containing the re-synthesized sample,  and the positions (start, end, loop, etc) in the EXS24 Zones will 
incorporate all the changes necessary to have them play the sound exactly as heard in Keymap. We 
recommend keeping a Keymap format copy around before saving to EXS24 format so that you can go 
back and tweak the HR settings, that would otherwise be lost in the EXS24 format instrument.
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The  HR Pitch envelope
If you select a single Zone, and enable the Harmonic Resynthesis Pitch enable checkbox, you will see the 
pitch envelope displayed as a thin orange line in the auxiliary sample editor. That envelope represents the 
envelope that will be used by Keymap to synthesize the pitch for the sound.

Immediately after analysisthe envelope line is a precise representation of the detected sample pitch at 
any point. Notice how the envelope is represented as a deviation from the detected fundamental note 
pitch, which is in turn always represented as a horizontal line in the center of the sample editor, regardless 
of the fundamental pitch value, or the fact that the sample is mono or stereo.
 

The HR Pitch envelope

Lower pitch 

Higher pitch 

Fundamental pitch

+50 c
+25 c

0 
-25 c
-50 c

At the left of the sample editor you can see the HR Pitch ruler values, displaying the deviation in cents 
from the fundamental.  If you have a mighty mouse, you can press and hold the Option key and spin the 
mouse trackball vertically to change the vertical HR Pitch zoom factor.

From the auxiliary sample editor in the Instrument editor window it’s not possible to draw and edit 
directly the pitch envelope, but you can use the HR Pitch parameters to quickly modify it in useful ways.
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Harmonic Resynthesis parameters for Pitch 
Each Zone has three pitch parameters for transforming the HR pitch envelope. These parameters deal 
with pitch transposition  and pitch correction.

HR Pitch Transpose let you change the pitch of the sample in semitone steps. The major difference 
between this parameter and the normal Tune Zone parameter is that HR Pitch transpose doesn’t modify 
the original sample playback length, while the Tune parameter will instead change the playback 
resampling rate and higher pitches will result in shorter playback times as shown in the following 
illustration. 

PLAYBACK TIME

Sample playing with Tune at -8 semitones

Sample playing with Tune at +0 semitones

Sample playing with Tune at +8 semitones

PLAYBACK TIME

Sample playing with HR Pitch at -8 semitones

Sample playing with HR Pitch at +0 semitones

Sample playing with HR Pitch at +8 semitones

With traditional resampling

With HR Pitch transposition

The HR Pitch Transpose parameter is used by Keymap as the basis for the Zone polyphonate function.
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HR Pitch correction
The HR Pitch Correction adjust parameter lets you correct the pitch envelope by gently warping  it 
toward the fundamental pitch by the desired amount. This parameter is expressed in percentile of he 
analyzed deviation, where 100% means the original untouched envelope, 0% means full correction. You 
can also reinforce the pitch deviation from the fundamental by using values greater than 100%. In this 
case, the pitch deviation will be accentuated. You can enable and disable pitch correction by using the 
checkbox near the pitch correction slider.  When you edit and release the pitch correction slider, the pitch 
envelope will be updated to reflect the changes you made, as shown in this illustration:

HR Pitch correction

100%

50%

25%

0%

For your consideration: some amount of pitch correction is very useful when building sampled acoustic 
instruments as it is often difficult to sample some of them at the perfect pitch. When playing a solo part  a 
slight de-tuning might sound very human and wonderful, but if you play multiple  instruments you 
definitely want them in tune.
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The HR Pitch Offset adjust parameter is complementary to the HR Pitch Correction adjust, and lets you 
add an offset to a pitch.  This is useful when you have an out of tune vibrato, and you do not want to 
change the vibrato, but just center it onto the fundamental, as seen in the following illustration:

HR Pitch offset

0 cents

25 cents

You can enable and disable HR Pitch shaping using the Harmonic Resynthesis Pitch enable checkbox.
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Harmonic Resynthesis formant control
The Harmonic Resynthesis engine can also be used, with the HR-A algorithm, to modify the formant of the 
played sample. This lets you change the spectral distribution of the sound without changing the pitch, 
which is useful if you want to create a subtle variation of the same sample, or you want to simulate a 
larger or smaller resonant body for a sampled acoustic instrument.

 The HR Formant adjust parameter lets you  modify the formant of selected Zones. A value of 1.0 means 
no formant change, while a value of 0.5 means that the formant will be shifted toward high frequencies, 
and 2.0 means that the formant is shifted toward the low frequencies.

You can enable and disable HR Formant shaping for the selected Zones using the Harmonic Resynthesis 
Formant enable checkbox.
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Harmonic Resynthesis time control
How many times have you wished you could have fine control over the timing of your sampled 
instrument? The Harmonic Resynthesis engine allows you to control the playback timing, so that it 
becomes easy to slow down a sample at some points or accelerate it in others.  In other words, you have 
continuous control of the timing aspects of your harmonic sample through an HR Time envelope. 

Perceived time vs displayed time
Keymap displays the timing changes as a time envelope overlaid on the sample; you will not see a change 
in the length of the displayed waveform in the sample editor. What you will instead see is the playback 
cursor slowing down or accelerating to reflect the current time envelope value. All sample position 
parameters displayed on screen (start, end , loop points, etc) will not change when you adjust the time 
envelope, and will keep referencing the original sample positions,  but of course the perceived length (i.e. 
the length of the sound you’ll hear) will change. This allows you to have a continuous time envelope (i.e. it 
the envelope can smoothly change sample by sample), and lets you edit and adjust envelopes with 
precision, without the waveform constantly updating.  After the initial sample analysis, the time envelope 
is a flat horizontal line centered over the sample waveform, meaning that no timing change will be done.

Harmonic Resynthesis time parameters
As for HR Pitch, it’s not possible to draw the envelope directly from the Auxiliary sample editor in the 
instrument window, but we have two parameters for controlling the sample attack and sample loop 
segments as defined in the following illustration:

Sample Attack
Segment

Sample Loop
Segment

Sample Attack
Segment

When a loop is enabled, 
we have both

 an attack and a loop 
segment

When the loop is 
disabled or not defined, 

we have only
 an attack segment
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Note that when a loop is not defined, or disabled, there is no sample loop segment and so the whole 
sample is considered to be part of the sample attack segment. 

The HR time parameters are found in the Zone HR Time inspector. 

The HR Attack Time Adjust lets you change the perceived length of the attack phase. The parameter is 
expressed as a percentage of the displayed length and you set the parameter go from 50% (half of the 
original length) to 200% (double of the original length).

Similarly, with the HR Loop Time Adjust you can change the perceived loop length. The parameter is 
expressed as a percentage of the displayed length and you adjust it from 50% (half of the original loop 
length) to 200% (double of the original loop length).

The Also use drawn envelope checkboxes let you enable/disable the hand-drawn envelopes you might 
have created from the full fledged sample editor.

You can enable and disable HR Time shaping for the selected Zones using the Harmonic Resynthesis 
Time enable checkbox.
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Harmonic Resynthesis amplitude control
The last of the four properties that you can reshape with Harmonic Resynthesis is amplitude. When a Zone 
is first analyzed, an amplitude envelope is created, representing the original sample amplitude 
characteristics. The amplitude envelope appears as a black line in the sample editor, as shown in the 
following illustration.

Tru-view display mode: visualizing HR Amp processing
When editing the HR Amp envelope or parameters, only the HR amp envelope is visually modified and the 
displayed sample waveform still represents the original sample. You can however see the actual HR Amp 
processed waveform by clicking the Tru button and entering the Tru-view  sample editor mode Tru-view 
button.

With the Tru-view mode 
disabled, the original 
sample waveform is 

displayed

With the Tru-view mode 
enabled, the processed 

sample waveform is 
displayed

Note: Tru-view mode also displays the actual results of fade-ins, fade-outs and loop crossfades. In 
Tru-view mode, the audio outside the Zone SampleStart and SampleEnd positions is visualized as 
silence.

Tru-view display mode is slower and requires more CPU power than the normal mode, which is why it’s 
not enabled by default.
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HR Amp Zone parameters
Keymap offers full control over this amplitude envelope from the full sample editor, but some useful HR 
Amp  parameters are also available from the Zone HR Amp inspector.

How to normalize samples using HR Amplitude
One of the most common actions in the sampling world is normalizing samples. Unfortunately this is 
usually implemented in a destructive way.  This means that the original samples files are modified, which 
both takes a significant amount of time and is very difficult to undo once you have committed to the 
change. In Keymap, using Harmonic Resynthesis, you can perform this operation non-destructively in 
realtime simply by setting the amount of normalization you want to achieve. The HR Normalization 
amount parameter goes from 0% (meaning no amplitude change), to 100% (meaning the amplitude is 
stretched to fully normalize the sample).
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Freezing the decay of decaying samples
A problem with sampled instruments is that decaying samples often can’t be effectively looped, as the 
energy difference between the loop start and the loop end usually creates a sudden jump in the sound at 
the loop “join” point. In these situations, a loop crossfade will be helpful, but might not solve the problem. 
In Keymap, thanks to our Harmonic Resynthesis engine, you can freeze the decay just by setting the HR 
Freeze Decay parameter to the desired decay level expressed in decibel. When the sample tail reaches 
that level, its level will freeze and remain constant until the end of the sample, making looping a much 
simpler task (and there are often hidden sonic gems in those long tails).

The original decaying piano sample

The same piano sample with decay 
freezed at -12dB

Like all Zone inspector parameters, this parameter can be set for all selected Zones, making this kind of 
edit very simple for whole layers.
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Removing dynamics out of samples
Another function in Keymap lets you remove to various degrees the dynamics from a sample so that it 
becomes a sonically uniform. The HR Dynamics parameter goes from 0% (no dynamics) to 100% (original 
dynamic). This function gives very interesting results with drum loops and with samples of constantly 
varying amplitude. Once sounds have their dynamics removed, you can sculpt them again at you liking 
using the EXS24’s envelopes and filters.

The original drum loop

The same drum loop with 
all dynamics removed

Zone polyphonation

Zones > Polyphonate menu command
Polyphonation is the process by which a single tuned harmonic sample is used to generate multiple 
samples, each shifted in pitch and mapped to a different note. This might seem similar to what happens 
when you play Zones in a sampler, but polyphonation has the important distinction of maintaining the 
sample length for all notes so that , for example, the vibrato in a sample will play at the same speed on all 
the polyphonated notes, or playing a polyphonated voice sample  over the keyboard will result in a nicely 
synched choir. The Polyphonate function in Keymap uses Harmonic Resynthesis for doing this and doesn’t  
actually create additional samples until the moment you export to EXS format. 

Once you select a single Zone and polyphonate it, a panel will ask you the range for the polyphonation at 

Page 123



the left and at the right of the selected Zone root note,  and if you want to overwrite any existing Zones in 
that range. Keymap will then create a new set of Zones, each referencing the same sample, with the same 
parameters, except for the HR Pitch transpose parameter, set to match the transposition needed.
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Chapter 9: Zone functions

Zone remap functions

The Zones > Remap sub-menu commands Group all Zone remapping functions. With a couple of 
exceptions, each remap function works on the currently selected layer.

Zones > Remap > Remap down by one octave
This functions remaps Zones down by one octave, also moving the root note. Velocities are not modified.

Zones > Remap > Remap up by one octave
This functions remaps Zones up by one octave, also moving the root note. Velocities are not modified.

Zones > Remap > Remap down by one octave no root
This functions remaps Zones down by one octave, without moving the root note. Velocities are not 
modified.

Zones > Remap > Remap up by one octave no root
This functions remaps Zones up by one octave, without moving the root note. Velocities are not modified.

Zones  > Remap > Remap instrument down by one octave
This functions remaps Zones down by one octave for the whole instrument (i.e. all layers), also moving the 
root notes. Velocities are not modified.

Zones > Remap > Remap instrument up by one octave
This functions remaps Zones up by one octave for the whole instrument (i.e. all layers), also moving the 
root notes. Velocities are not modified.
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Zones > Remap > Remap velocity
This functions remaps the velocity ranges for selected Zones. A panel asks you the desired minimum and 
maximum velocity and will then remap the selected Zones so they fill the desired velocity range in equal 
amounts.

Remap velocities

Zones > Remap > Remap to white notes
This functions remaps the note range for the selected Zones, so that each Zone becomes one single note 
wide, is positioned over white notes only, and is mapped sequentially starting from the leftmost Zone. 
The root note for each Zone is also moved. This function is useful with percussion and effects sounds for 
which you want to have different sets mapped on the white and (see the next menu function) the black 
keys, possibly on separate layers.

Remap to white 
notes
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Zones > Remap > Remap to black notes
This functions is the counterpart of the previous one.  It remaps the note range for the selected Zones so 
that each Zone becomes one single note wide, is positioned over black notes only and is mapped 
sequentially starting from the leftmost Zone. The root note for each Zone is also moved. This function is 
useful with percussion and sound effects for which you want to have different sets mapped on the black 
and (see the previous menu function) the white keys, possibly on separate layers.

Remap to black 
notes

Zones > Remap > Remap to all notes
This functions remaps the note range for the selected Zones, so that each Zone becomes one single note 
wide and is mapped sequentially starting from the leftmost Zone. The root note for each Zone is also 
moved. This function is useful with percussion and sound effects for which you want to compact Zones in 
the layer, especially after dropping several Zones in the layer and deleting the uninteresting ones.

Remap to all notes
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Zones > Remap > Remap to root notes
This functions remaps the note range for the selected Zones, so that each Zone becomes one single note 
wide and is mapped on its root Zone. The root note for each Zone is not moved. This function is useful 
when you want to insert Zones between existing ones and want to have some free layer matrix space, or 
when you want to map samples manually. Once you are satisfied, you can use the “Expand Zones” 
function (see later) to fill up any empty layer matrix space.

Remap to root 
notes

Zones > Remap > Remap to ranged notes
This function asks for a starting note and a width, and then remaps the note range for the selected Zones, 
so that Zones are mapped sequentially starting from the starting note, with the selected width for each 
Zone. The root note for each Zone is moved to the center of each Zone note range. This function is useful 
when you have some samples and want to create a playable range around each of them to experiment 
playing at various pitches.

Remap to ranged 
notes
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Zones > Remap > Remap toward high notes
This function changes the selected Zones note width to a single note, and moves them toward high notes 
(i.e. toward the right in the matrix) until an unselected Zone is found. The root note for each Zone is 
changed to the new Zone note position. This function is useful if you want to compact Zones in the 
matrix.

Remap toward 
higher notes

Zones > Remap > Remap toward low notes
This function changes the selected Zones note width to a single note, and moves them toward low notes 
(i.e. toward the left in the matrix) until an unselected Zone is found. The root note for each Zone is 
changed to the new Zone note position. This function is useful if you want to compact Zones in the 
matrix.

Remap toward 
lower notes
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Zones > Remap > Remap to last played note
This function changes the selected Zones width to a single note, and remaps them sequentially starting 
from the last played note. The root note for each Zone changes to the new Zone note position. This 
function is useful if you want to remap sparse percussion and effects Zones, using the MIDI  or virtual 
keyboard.

Remap to last 
played note 

(G1 in the example)

Zones > Remap > Swap last two played notes
This function let you swap the Zones assigned to two different notes. You simply play one note and the 
other on the MIDI or virtual keyboard (and you can do this until you find the right notes), and then 
activate this function. All the Zones assigned to those two notes will be swapped. 

You first play a note

Then play a second note

The "swap last two played notes"
     function will swap all the zones for 
     those two notes

Page 130 



Zones > Remap > Simplify mapping
This function transforms the current Zone selection in the map into a simpler map with less Zones. 
Keymap asks for your desired maximum number of splits over note and velocity ranges, analyzes the 
placement of Zones, discards the necessary Zones and fills empty layer space with the remaining Zones. 
This function is useful for creating a lighter version of an instrument. Zone crossfades can be used to 
smooth transitions. For this function to work properly, the initial map should be filled over its entire area, 
or at least within the lowest and highest used note.

Simplify 
mapping

The current 
map is 

simplified to 
match the 

desired 
maximum
number of 

splits
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Zones > Remap > Simplify mapping no expand
This function is similar to the previous one, with the difference that the redundant Zones are removed, 
but the remaining Zones aren’t expanded to fill the empty matrix space. For this function to work 
properly, the initial map should be filled over its entire area, or at least within the lowest and highest used 
note.

Simplify
mapping

no expand

Zones are 
removed in 

order to 
simplify the 

map
as desired
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Zones > Remap > Expand Zones
This function expands both the notes and velocity ranges for the selected Zones in order to fill as much 
empty matrix space as possible. It’s very handy when your samples are placed in the matrix and you want 
to fill empty spaces between them. Root notes are not modified.
 

Expand
zones

Zones are 
expanded 

along the note 
and velocity 

axis 
in order to fill 
empty matrix 

space
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Zones > Remap > Expand Zones notes
This function expands the note ranges for the selected Zones in order to fill as much empty horizontal 
matrix space as possible.  Velocities and root notes are not modified. 

Expand
zones
notes

Zones are 
expanded 

along the note 
axis 

in order to fill 
empty matrix 

space.
Velocity is not 

modified
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Zones > Remap > Expand Zones velocities
This function expands the velocity ranges for the selected Zones in order to fill as much empty vertical 
matrix space as possible.  Notes and root notes are not modified. 

Expand
zones

vel

Zones are 
expanded 
along the 

velocity axis 
in order to fill 
empty matrix 

space.
Notes are not 

modified
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Zones > Remap > Optimize mapping based on root notes
This function analyzes the selected Zones and remaps them in the Layer matrix based on the defined root 
notes. Velocities are not modified. This remapping function uses one preference parameter, Zone 
automapping mode  to determine how you want to remap Zones. 

The possible choices are:

Root on low note means that the remapped Zones will have the low note set to the root note.

Root on high note means that the remapped Zones will have the high note set to the root note.

Root centered over note range means that the Zones will be remapped so that the root note is centered 
respect the low and high notes (with an exception for the leftmost and rightmost Zones). In Zones two 
notes wide, the low note is set to the root note.

Root centered over note range favoring low is like “Root centered over note range” but with a different 
rounding so that in Zones two notes wide, the high note is set to the root note.

Original map

Optimized map with
 "Root on low note"

Optimized map with
 "Root centered over note range"

Optimized map with
 "Root on high note"
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Zones > Remap > Intersect Zone ranges with Group ranges
This function analyzes the selected Zones, checks if any of them are assigned to a Group, and if any Zones 
are, reduces the Zone note and velocity ranges within the note and velocity specified by its Group. This 
change has no consequences on how the instrument plays, as the Zone ranges are always clipped to the 
Group ranges anyway when you play notes, but it makes for a much clearer visualization of Zones in the 
layer.

Zone automap functions

Zones > Automap > Automap using pitch analysis root notes
This function analyzes the pitch and volume of the samples for selected Zones and uses this analysis to 
map  them in the matrix. The detected pitch is also assigned to the root note for each Zone. 

Zones > Automap > Automap using sample files root notes
This function uses the root note information from the sample files, analyzes the volume of the samples for 
selected Zones and uses this combined data to map  them in the matrix. The pitch from the sample file is 
also assigned to the root note for each Zone. Note that only WAVE and AIFF file formats support the 
embedded root note data information. All samples rendered by Keymap contain this information.

Zones > Automap > Automap using mapping data from sample files
This function uses the mapping data information (low note, high note, low velocity, high velocity, root 
note) from the sample files and sets the respective Zones to those values. The root note information from 
the sample file is also assigned to the root note for each Zone. Note that only WAVE and AIFF file formats 
support the embedded mapping data information. All samples rendered by Keymap contain the whole 
set of mapping data.

Zones > Automap > Automap using root from sample files name 
This function checks the presence of a note name (examples: C1, F4, D#2 etc..) in the selected Zones’ 
samples and analyzes the sample volume. This data is then used to map the Zones over the layer matrix. 
Keymap will only use the first valid note name found in the sample name, and the note name must be 
separated by previous and successive characters by some separator character as space, underscore or 
similar characters.
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Zones > Automap > Automap velocity only 
This function analyzes the sample volume for the selected Zones and will remap them over the velocity 
axis based on the analysis results. The note ranges are not modified. 

Zones > Automap > Set root note to middle of range
This function sets the root note for selected Zones, at the middle of the note range. This is mostly useful 
with drums and effects, as >  you can readily have playable Zones over a range regardless of how you 
mapped them. 
Zones > Automap > Set root note from pitch analysis
This function analyzes the pitch of selected Zones’ samples, and sets the root notes to the analysis results. 

Zones > Automap > Set root note from sample file info
This function checks the presence of root note information inside the selected Zones’ sample files and sets 
the root notes to those values.

 Zones > Automap > Set root note from sample file name
This function checks the presence of  a valid note name in the selected Zones’ sample file names,  and sets 
the root notes to those values.

Zone loop functions
Zones > Loop >  LowRes Autoloop
This function searches and sets the best loop points in the samples of the selected Zones using  Keymap’s 
Low Resolution autolooping algorithm. The loops are also enabled.

Zones > Loop >  HiRes Autoloop
This function searches and sets the best loop points in the samples of the selected Zones using  Keymap’s 
High Resolution autolooping algorithm. The loops are also enabled.

Zones > Loop >  Parametric Autoloop
This function first asks you the relative positions in the selected Zones’ samples where Keymap should 
search for a loop, the minimum loop length to search for, and the algorithm to be used.  After that, 
Keymap will autoloop the selected Zones and enable the loops.
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Note that the positions and start/end positions are all expressed in percentage of each sample’s length, in 
order to be meaningful for all selected Zones regardless of their length in samples.

Zones > Loop >  Set loop from sample file
This function checks the presence of loop data (start and end points) inside the sample files of the 
selected Zones, and if this information is available sets the Zone loop points accordingly. Note that only 
WAVE and AIFF file formats support embedded looping data information. All samples rendered by 
Keymap contain the looping data (if a loop has been defined and is enabled).

Zones > Loop >  Add optimized XFade to loop
This function automatically adds some crossfades (XFade) to your existing loops, and also tweaks the loop 
end position  in order to get a better sounding loop, for the selected Zones. Note that this function needs 
and expects loops to be set and enabled already.

Zones > Loop >  Clear Loop XFades
This function clears any crossfade (XFade) in the existing loops, for the selected Zones.

Zones > Loop >  Optimize Loop XFades
This function analyzes your loops and optimizes the loop end position for crossfaded loops. It also clears 
any crossfades (XFade) in the existing loops, for the selected Zones.

Zones > Loop >  Set start to loop start
This function sets the Zone sample start position to the loop start for the selected Zones.

Zones > Loop >  Set start to loop end
This function sets the Zone sample end position to the loop start for the selected Zones.

Zone split functions
Zones > Split >  Split by Notes
This function splits the selected Zones along the note axis. Keymap asks you to select a start note, an end 
note, and the note width of each split 
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Zones > Split >  Split by Velocities
This function splits the selected Zones along the velocity axis. Keymap asks you to select a start velocity, 
an end velocity, and the velocity step of each split .

Zone autophase functions

Zones > Autophase >  Autophase sample start
This function moves the sample start position to the nearest rising zero crossing. 

Zones > Autophase >  Autophase sample end
This function moves the sample end position to the nearest rising zero crossing. 

Zones > Autophase >  Autophase loop start
This function moves the loop start to the nearest rising zero crossing. The loop length is preserved. In 
other words, the loop end position will be moved of the same amount so that the total loop length 
doesn’t change.

Zones > Autophase >  Autophase loop end
This function moves the loop end to the nearest rising zero crossing. The loop length is not preserved. In 
other words, the loop start position will not be moved.

Resources window selection commands

Zones > Select Zones in Resources window 
This command selects the Zones in the Resources window. Any other previously selected Zone in 
Resources will be deselected.

Zones > Add Zones to selection  in Resources window 
This command selects the Zones in the Resources window, maintaining any existing selection there.
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Chapter 10: QuadraSmooth
Oftentimes when you create an instrument out of multiple samples, you want a smooth  audio level from 
your samples even if the the volume of their waveforms differ, and possibly without having to alter your 
samples by normalization or by applying a gain change of the actual sample data. 

This can be especially important when two adjacent Zones play samples with a noticeable volume 
difference.  This can be somewhat improved using Zone crossfades, but the difference in volume still 
remains. 

The QuadraSmooth function in Keymap solves this problem. As the name implies, this function let you set 
the four desired volume levels at the corners of your layer matrix, and then Keymap automatically 
changes the volume of Zones in order to match the desired volume profile across the layer matrix. Each 
single layer has its own set of independent QuadraSmooth parameters.

Desired Volume 
at

Note 0
Velocity 127

Desired Volume 
at

Note 0
Velocity 1

Desired Volume 
at

Note 127
Velocity 127

Desired Volume 
at

Note 127
Velocity 1

Keymap first analyzes each sample in order to get the actual sample volume, and then applies a gain 
change to the Zone (not to the sample data) to bring it to the desired level. For example, if the sample 
volume level, expressed as RMS power, was at -22dB, and you set QuadraSmooth to have the Zones at 
-15dB, then the Zone will be played with a 7 dB volume gain. The QuadraSmooth gain parameter for each 
Zone is separate and independent from the Zone volume, so you can still use the normal Zone volume as 
you wish, as  QuadraSmooth always refers to the volume level of samples before applying any 
processing or further volume change to samples/Zones. If you set all samples to the same exact volume 
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level through QuadraSmooth, and then change the volume for one Zone, then Keymap will first smooth 
the volumes using QS, and then will also apply the volume change as from the Volume parameter.

The results obtained with QuadraSmooth are perfectly equivalent to applying a gain change to the 
samples, but we have the great advantage of being able to tweak values in realtime, with no destructive 
process taking place. The volume correction that you apply is also not just an on/off thing, but you can set 
the amount of correction you like.

QuadraSmooth parameters

You enable or disable the function through a QuadraSmooth checkbox in the Layer Inspector box.

The QS Analysis Time parameter lets you set how much of 
the audio signal should be analyzed to calculate its audio 
level. For percussive signals, or signal with a quick attack 
you might want to use values in the range of 1 or 2 
seconds. Long attack samples might need longer values, 
as 5 or 6 seconds.

The QS Perc slider lets you set the amount of desired 
volume correction, from no correction (full left) to f 
correction (full right). 

The four corner level sliders and relative parameter entries 
let you set the desired RMS volume value for the four layer 
matrix corners. 

When tweaking sliders, the corresponding values are also 
momentarily displayed in the layer matrix. 

Page 142 



QuadraSmooth view
QuadraSmooth is not merely a way to correct volume differences, but also to display them.
When you turn on the QuadraSmooth view mode by enabling the QS View checkbox, Zones will be 
displayed in various shades of green color, with the brightest green being the Zone with the sample of 
highest volume, and the darkest green being the Zone with the sample of lowest volume. When you 
change the correction amount, the Zone shading will be update to reflect the new situation, as in the 
following illustration.

Brightest green 
represents the 
zone with the 

highest sample 
volume

Darkest green 
represents the 
zone with the 
lowest sample 

volume

QuadraSmooth view mode with no QuadraSmooth correction

QuadraSmooth view mode with full QuadraSmooth correction

Zones are now 
all at the same 
volume (same 

shade of green)
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QuadraSmooth menu commands

Zones > QuadraSmooth >  Refresh layer
This command refreshes the QuadraSmooth analysis for the selected Zones. 

Saving a  project using QuadraSmooth in EXS24 format
When saving a Keymap project which uses QuadraSmooth, in EXS24 file format, the volume changes 
necessary for the correction are added to the Zones volume, so that EXS24 can play Zones at the correct, 
QS corrected, volume.

No rendering of new samples is necessary with QuadraSmooth.
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Chapter 11: Dynamics remap envelope 
Most probably, you already are familiar with the concept of velocity curves on MIDI Keyboards. With 
velocity curves you essentially reshape the velocity response of the Keyboard to better match your 

playing style, or to play an instrument in a more expressive way. The  
Dynamics remap envelope in Keymap uses the same concept but 
this time not to the velocity data from the MIDI keyboard , but 
instead to the velocity values of your mapped Zones for each single 
layer. In this way you can adjust the velocity mapping of a whole 
layer just by drawing an envelope, and all Zones velocity parameters 
in that layer will be modified accordingly, as shown in the following 
illustration.
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As you can see this is a very efficient method for reshaping layers along the velocity axis, especially 
because at all times you see the Zones moving while you edit the envelope, and you can play directly the 
transformed map in realtime from a MIDI Keyboard.

When you enable the dynamics remap envelope for a layer, you will not be able to perform manual 
editing  of Zones and other remap functions in that layer, until the envelope is disabled or applied in a 
permanent way to the Zones.

The Envelope in detail
The dynamics envelope section can be found in the Layer inspector box, and it’s effectively a layer 
function, always processing the whole layer. Being a layer function, it means that each layer has an 
independent envelope.  

 

Dynamics 
Envelope

Built-In 
shapes

Reset and 
Apply 

buttons

Envelope 
enable

Envelope nodes

The envelope shape is displayed as a series of blue nodes connected by a red line.

The envelope is turned on for the layer through the Dynamics Envelope checkbox, and can be reset using 
the Rst button, or applied in a definitive way to the Zones by clicking the Apply button. The 2P button 
acts as the Rst button, with the difference that the first and last nodes in the envelope are not modified. 
These nodes have some important properties as we’ll see in the next page.
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Built-in envelope shapes
On the left of the envelope view you have four buttons (C+, C-, S+, S- )representing four different basic 
shapes:  “C+” stands for positive C-shaped curve, “C-” for negative C-shaped curve, “S+” for positive S-
shaped curve and “S-” for negative S-shaped curve.

C+

C-

S+

S-

For each click of these four buttons, the current envelope will be imparted a tiny amount of the 
corresponding shape, so that you can tweak envelopes without having to edit the envelope directly.

Creating an envelope manually
Of course, you can edit the envelope directly!  The envelope is defined by a series of nodes which you 
create simply by double clicking over the envelope line, and drag around until you get the desired shape. 

In a similar way you delete nodes by double clicking over them.

An envelope has always at least two nodes, the first node and the last node. 

Last 
node

First 
node

These two nodes are special in that they represent velocity 127 and velocity 0 of the original Zones, in 
other words the original top and the bottom velocity range. If you have a straight default two-nodes 
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envelope, and you edit these nodes along the vertical direction (the only allowed for them), the net result 
will be to  squeeze all Zones to a restricted velocity range or, from a different perspective, to set the 
velocity range for each layer.
 

This is very useful for stacking different audio material in different layers and tweaking their velocity 
ranges as a whole.

If you have a non-linear envelope defined (i.e. more than two nodes defined), and you hold down the 
Shift key while dragging the first or last node, all nodes in between will also be squeezed, so that you can 
restrict the velocity range but still keeping the desired envelope shape.

Shift+Click and Drag the 
first and last points

Once the layer dynamic range is restricted, i.e. the first or last nodes have been moved, then you can drag 
the envelope curve simply by clicking in the white area, which will become yellow, and then drag it 
around vertically.

Click and Drag the white 
area around the envelope
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Applying the envelope
Once you are satisfied with the envelope, you can apply it in a permanent way to the Zones by clicking 
the Apply button.

Copying the envelope across layers
The dynamics envelope context menu lets you copy and paste envelopes across layers.
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Chapter 12: Single cycle loops
Several kinds of sounds can be effectively looped using a single waveform cycle, in other words, as a 
single repetition of the basic waveform being played. This technique works, often surprisingly well, with 
wind instruments, synths, voices, and basses.

One of the problems you find with single cycle loops is that there is an correlation between the loop 
length and the perceived pitch. If you have a perfect single cycle loop, and you make it longer of a few 
samples, you will not only get some clicks caused by the wrong loop points, but you will also hear a lower 
pitch. Why this? You are essentially playing repeatedly the looped segment: regardless of what is in the 
looped audio segment, the perceived pitch fundamental frequency will be equal to the number of times 
you play that segment in a second. 

Another related problem is that while loop start and end positions and so the loop length, can be 
expressed only as integer numbers, almost in every case you’d need loops of fractional length.
For example, the fundamental frequency for note C4 is 261.60 Hertz, and this needs a single cycle loop of 
168.57 samples (at 44.1Khz sample rate) to play at the right pitch. This looks an impossible problem, as 
you can only build loops of 168 or 169 samples. The clever solution introduced many years ago by 
sampler manufacturers is to have a fine tune control for the loop segment. With this capability you can set 
a loop of 168 samples, which will play sharper than wanted, and then tune it down using the loop tune 
parameter. But you see, this complicates things, as now not only you have to find the right loop points, 
but also set another parameter to have the correct pitch.

Well, we are pleased to tell you that Keymap does all this (loop search and retuning) for you, with a single 
key command. 

Keymap single cycle loop functions have been designed to work on harmonic samples, and will not work 
correctly with other kinds of material.
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Autolooping a single cycle
Creating a single cycle loop in an harmonic sample is as simple as placing the sample cursor in the sample 
editor, and using the Samples > Loop > Autoloop Single Cycle menu function. A loop of the right length 
will be created, with the loop start aligned to a positive-phase zero crossing, and the loop tuning 
parameter set at the proper value in order to have a perfect pitch.

Just place the cursor at a sample position, 
and then use the 

Samples>Loop>Autoloop Single Cycle
 menu function

Keymap will create a single cycle loop, and 
tune it to get perfect pitch

In some cases, you might want to add a small loop crossfade in order to smooth the transition.

Autotuning a near-cycle  to match the right pitch
Near-cycle loops are intended for loops less than two waveform cycles long. These short loops are a gold-
mine of sonic potential, but experimenting with them has always been a problem because the pitch 
changes drastically as you change the loop length. Keymap offers an autotuning function that 
automatically does that for you with harmonic samples.

 

Auto tune short loop
checkbox

Just enable the checkbox near LoopTune, in the Zone Inspector, and your short loops will be retuned.
If you edit the loop points while playing the sample, you will hear how the pitch will remain stable, but 
the spectral shape of the sound will smoothly change.

When experimenting with near-cycle loops, we recommend using some loop crossfade in order to always 
get a smooth loop.
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The Single Cycle Loop Explorer
If you experiment a little with single cycle loops in harmonic samples, you will notice how often the 
spectral content of the loop changes depending on the position of the loop in the sample: a single cycle 
loop at attack might sound brighter than a single cycle loop at the end. The Single Cycle Loop Explorer in 
the Zone inspector lets you explore the changing spectral properties of your single cycle loops at the 
various sample positions simply by moving a slider, as shown in the following illustration.

Drag the slider and the loop will move accordingly

When you drag the Single Cycle Loop Explorer knob, a phase aligned, autotuned single cycle loop will be 
created at the corresponding relative position for the selected Zones. The explorer will also set the start 
position to the loop start position, so that on playback starts directly at the loop beginning.
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Chapter 13: Groups
Groups in Keymap are very interesting elements as they bring a lot of functionality to the instruments . As 
you might imagine, Groups by themselves are not really useful (with the due exceptions as we’ll see), but 
are normally used in conjunction with Zones. Once you assign a Zone to a Group, the Zone will inherit the 
Groups properties, and will play samples when both the Zone and Group parameters, together, agree.

The Group parameters can be subdivided in three main categories as we see in the following illustration.

Output 
parameters

AMP Envelope 
offsets

Playback 
conditions

We have:

Playback conditions (a.k.a. selections): this set of Group parameters together decide when the Group 
should play (example: on note-on, or on note-off, only in a small map area, etc..)

AMP Envelope offsets: Keymap, as the EXS24, has a single AMP Envelope. However, each Group contains 
a set of parameters that let you customize the envelope for the assigned Zones.

Output parameters: you can set an audio routing, and tweak volume and pan for the Group as a whole.
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Playback conditions (a.k.a. selections)
As we have seen, most of the Zone parameters are related to how the sample should play, and you have 
only the note and velocity ranges parameters to set when it should play. Now, this will suffice for a lot of 
applications, but when you need something more complex, you use Groups. 

Group parameters for conditions

Basically, Groups let you set a number of conditions for the assigned Zones to play.  Only when all 
conditions are met and the played MIDI note and velocity hit the Zone map area in the layer matrix will 
the Zone play.  It’s important to note that this set of conditions always limit Zone playback, and never 
extend it.  

Possible Group conditions to meet for Zone playback to happen

NOTE AND VELOCITY
Play only if the notes match 

both the zone and the group 
mapping area

SELECT BY CTRL
Play only when a MIDI 

Controller value is in a certain 
range

SELECT BY PITCH
Play only when the MIDI 

Pitchbend controller value is in 
a certain range

SELECT BY KEYSWITCH
Play only after you press a 

certain note

MIDI CHANNEL
Play only if notes are sent on a 

certain MIDI Channel

IN GROUP CHAIN
Play only when it's the turn in a 
closed chain of Groups played 

in round robin fashion.

TRIGGER MODE
Play on note on, or on note off
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NOTE AND VELOCITY
If you set the Group LowNote/HighNote/LowVel/HighVel to less than the full map area, you will limit the 
Zone playback to when the note, and its velocity, will match both the Zone map area and the Group map 
area.

NOTE AND VELOCITY

Layer matrix

Group map area

Zone map area

The 
zone will 

play in 
this area 

only

NOTES

VELOCITY

This Group map area condition is always active, but you can of course make it irrelevant by setting the 
Group map area to the whole layer matrix, i.e. LowNote set to zero, HighNote set to 127, LowVel set to 1 
and HighVel set to 127. In this way the Group map area condition will always be satisfied.

Similarly, if you set the Group map area so that it doesn’t intersects the Zone map area, then the Zone will 
never play.

Tip: Keymap has a remapping menu function, Zones > Remap > Intersect Zone ranges with 
Group ranges, which will remap the Zone(s) to the common (intersection) area with the Group. The 
result will be  smaller Zones, set to the real relevant areas. If the Group and the Zone do not intersect, 
then the Zone will be deleted. This function will help you a lot in “fixing” messy instruments where 
the sound designer used unnecessarily large Zone map areas, and small Group map areas.
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How to use Group velocity range for creating dynamic sounds

Group velocity ranges, when used with layers, are very important tools for creating dynamic layered 
sounds in Keymap. Here’s a simple step by step construction of an instrument using three different 
sounds, dynamically crossfading as you move the modulation wheel while playing.

As first thing let’s create three layers, one for each sound, place your Zones there and assign one Group to 
each layer content. The Groups velocity range is displayed in green here.

Layer 1, 
all Zones assigned to 

Group 1

Layer 2,
 all Zones assigned to 

Group 2

Layer 3,
 all Zones assigned to 

Group 3

VELOCITY

Group 
Velocity
Range

Now, for each Group, restrict the Group velocity range so that the Group is active only for a small section 
of the map. Set the three ranges so they are tied one to the other, with no holes along the velocity axis

VELOCITY

Group 
Velocity
Range

If you now play on the keyboard, you will see how you will play one sound or another depending on the 
velocity. However, you are still “jumping” from one sound to the other, with no smooth transition. We now 
add some dynamic crossfade:

Add some dynamic 
crossfade
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Adding dynamic crossfade means that the Group (and Zone) low and high velocities will be extended by 
the XFade amount, and the resulting two new areas, one at the top, the other at the bottom are fade 
areas, as shown in the following illustration.

VELOCITY

Dynamic crossfade area

Dynamic crossfade area

Dynamic crossfade area

Dynamic crossfade area
Group 

Velocity
Range

If you now try playing again, you will notice how the sounds do crossfade, and we now have blended the 
three sounds. However, very often you will want dynamic control over the blending while you are 
holding notes, and you can’t do that using velocity, because it’s a single value received at the beginning 
of a note.

Using a MIDI Controller instead of MIDI Velocity in the layer matrix
To reach that goal, you can set Keymap to use a MIDI Controller instead of MIDI velocity, for all the 
parameters that normally reference velocity. In other words, while we are used to think to the layer matrix 
as a matrix of  the note and velocity values, you can actually also use a MIDI Controller instead of velocity.

VELOCITY

NOTES

MOD
WHEEL

NOTES

MIDI Ctrl 
#16

NOTES

Layer MatrixLayer Matrix Layer Matrix

The parameter which controls this, is the “Vel mapped using”  found in the Setup inspector.
Using a dynamic 
controller as the 

modulation wheel, 
instead of velocity

To continue in our example, set the “Vel mapped using” parameter to the modulation wheel, and play 
again on the keyboard. This time you will be able to change the blend of played sounds, just by moving 
the mod wheel, even while you are holding notes on the MIDI Keyboard.
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Graphical Group velocity/xfade editor
We have seen how it’s technically simple to create dynamically blending sounds in Keymap. However, the 
method we have just described is not really intuitive or real-time oriented. For this reason, Keymap 
provides a dedicated graphical Group velocity/xfade editor, where you can set velocity ranges and Group 
volume level graphically, and see the interaction of crossfade shapes across Groups.
 

Group velocity/xfade editor
0 127Velocity (or MIDI Controller)

Low 
Velocity
Cursor

Whole 
Range
Cursor

High 
Velocity
Cursor

Group
Volume

At any moment, the selected Groups are drawn in green color, and you can edit the velocity range just by 
dragging the low or high velocity cursor around with the mouse. If you drag the cursor on top of the 
displayed Group, you can move the whole range, without changing its length. At all times you can hear 
the results just by playing the MIDI Keyboard.

If you add some amount of dynamic crossfade to the project, and select one of the possible dynamic 
crossfade shapes,  the editor will show you these areas and the interaction of their fade curves.

If you press and hold the Option key and then drag around the whole-range cursor, you will also be able 
to set both the velocity range and the volume for the Group. In this way the experience of creating and 
editing Group crossfades is very musical, as you have immediate control, and feedback, about the blend 
of sounds from Groups.
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SELECT BY KEYSWITCH
Sometimes it is useful to have different sets of Zones, playing different sounds, or variations of sounds, 
and switch set while playing. For example, you might have one set of Zones playing guitar notes, and 
another set  playing strummed guitar chords. This can be done by assigning one set of Zones (or even a 
whole layer) to a Group, and the other set to a second Group. If this is all you did, both sets would still play 
at the same time, but you can actually tie Groups to MIDI Keyboard notes, so that Groups play only after 
you press a note on the MIDI Keyboard. We call this method “select by keyswitch”, and the note you have 
to press to activate one Group is, as you guessed, the Keyswitch. 

One important thing to keep in mind is that only one keyswitch can be active at any moment, and so 
Groups using different keyswitches (notes) are mutually exclusive: if you play one set then the other will 
get muted, and vice versa.

Keyswitch
notes

are green

Keyswitch
enable

Keyswitch
note

Default active 
Keyswitched 

group

SELECT BY KEYSWITCH

Keyswitches are also latched, so once you press a Keyswitch note, the relative Group will become active 
until you press another, different, Keyswitch. 

Given the hierarchical, non overlapping organization of Zones in Keymap, you will use two layers for the 
two sets. And of course you can actually have as many Keyswitched sets as you want—until you run out of 
Keyswitch notes!

Notes assigned as Keyswitches are exclusively reserved for that task, and will not emit any sound. For this 
reason, the choice of a note usually goes for very low keyboard notes that you might not use often for 
producing actual music.
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SELECT BY MIDI Controller
Another possible way to make a Group active is through a MIDI Controller: you select a MIDI Controller 
(modulation wheel , pedals, knobs, etc) and you set the range of values that will make the Group active, as 
shown in the following illustration.

SELECT BY CTRL

Select by 
ctrl

enable

MIDI 
Controller 
to check

Range for 
which the 
group is 

active

Not active                                                                                                Not activeActive

0 127Values of the selected MIDI Controller

Only when the value from the MIDI Controller is inside the set range will the Group become active (and of 
course only if all the other conditions you might have set are met as well). 

Unlike Keyswitches, these MIDI Controller conditions are not mutually exclusive. You might have one 
Group enabled when the sustain pedal is held down, and another Group enabled when you turn one 
knob full left, and these Groups can become active at the same time provided that each meets its set 
conditions.

You would normally use this function to select between different sets depending on knobs, or for limiting 
playback of the Group Zones only to some special MIDI event (i.e. when you press down a pedal, or put a 
finger on a trackpad, or press one MIDI Controller switch, etc).
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Graphic “Select by Ctrl” editor
In Keymap, the SELECT BY CTRL feature has a corresponding graphic aux editor where you can visualize 
the range graphically against ranges in other Groups, making the construction of multiple Groups 
selection ranges very intuitive. 

Graphical Group "Select by CTRL" Editor

0 127Values of the selected MIDI Controller

Group
Volume

+6dB

-36 dB

Low 
Val

Cursor

Whole 
Range
Cursor

High 
Val

Cursor

You can click and drag the editor cursors with the mouse, and the Group controller range will be updated 
accordingly.  

If you press the Option key while dragging around the whole-range cursor, you can set both the 
controller range and the volume for the Group. This allows you to create and edit Group conditional 
selections in a very musical way, as you have immediate control and visual feedback regarding when and 
at what volume the Group will play.
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SELECT BY MIDI Pitchbend
Another possible way to make a Group active is via the MIDI Pitchbend controller: once this function is 
enabled,  you set the range of pitchbend values that will make the Group active, as shown in the following 
illustration.

SELECT BY PITCH

Select by 
pitch

enable

Range for 
which the 
group is 

active

Not active Active

-127 127Values of the MIDI Pitch bend controller

Only when the value from the MIDI Pitchbend controller is inside the set range will the Group become 
active (and of course only if all the other conditions you might have set are met too). 

As with MIDI Controllers, these MIDI Pitchbend controller conditions are not mutually exclusive. You can 
have overlapping pitchbend ranges, and the Groups will become active accordingly, regardless if another 
Group is active or not.

Graphic “Select by Pitch” editor
In Keymap, the SELECT BY PITCH feature has a corresponding graphic aux editor in which you can see the 
bend range graphically, against ranges in other Groups, making the construction of multiple Groups 
selection ranges very intuitive. 

Graphical Group "Select by PITCH" Editor

-127 127Values of the MIDI Pitch bend controller

Group
Volume

+6dB

-36 dB

Low 
Val

Cursor

Whole 
Range
Cursor

High 
Val

Cursor
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You can click and drag the editor cursors with the mouse, and the Group pitchbend range will be updated 
accordingly.  

If you press the Option key while dragging around the whole-range cursor, you can set both the 
pitchbend range and the volume for the Group. In this way the experience of creating and editing Group 
conditional selections is very musical, as you have immediate control, and visual feedback, about when 
and at what volume the Group will play.

Group Chains
Keymap and the EXS24  support the creation and playback of Group chains in which each Group in a 
chain takes its turn at being active, and each played note advances the active Group in the chain.

For example, imagine you want to create a strummed guitar simulating the up and down strokes, and you 
want the sampler to handle automatically the change of direction for each note you play. For doing this, 
you create two layers, one containing the strum up Zones, and the other the strum down Zones. You then 
assign the Zones in the two layers to two Groups, one for the strumming up Zones, and the other for the 
strumming down Zones. If you create a chain with the two Groups, then each Group will take its turn at 
becoming active, playing back as shown in the following illustration.

Playing a  simple two group chain

Group 1
Strumming down guitar 

zones (samples)

Group 2
Strumming up guitar

zones (samples)

Group 1 
playing

Group 2 
playing

Group 1 
playing

Group 2 
playing

1st note 
played

2nd note 
played

3rd note 
played

4th note 
played

By definition all Group chains are closed, i.e. once the chain arrives at its last Group, it starts again from 
start, and the chain advances to the next Group as you keep playing notes.

This feature is very useful for creating complex realistic instruments because it allows you to use multiple 
variations of a sample to add extra realism (think of multiple hi-hats and snares samples, and acoustic 
instruments in which two notes played in sequence are never exactly the same).
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While the Group chain mechanism is intuitively simple, managing it can be a nightmare, and as you start 
adding multiple long Group chains to your instrument, keeping track of all these chains can be a 
nightmare. For this reason Keymap doesn’t let you create and edit chains directly from the Group 
Inspector, but offers you a dedicated Group Chains editor.

Group Chains Editor
To access the Group chains editor, click on the vertical tabs on the left of the Layer matrix.  We based this 
editor around a user interface metaphor of  a workspace containing  boxes connected through virtual 
cables. The boxes represent the Groups, and the workspace is simply a place where you can create, move, 
re-cable and delete your Groups.

Group Chains editor

Editor 
Tools

One 
group

A 
group 
chain

A more 
complex

group 
chain

The workspace

A chain is a set of Groups connected by cables.  Editing chains is a highly intuitive process as you simply 
drag the wires extremities around. Keymap always takes care of closing the chains for you when you 
delete Groups or move cables.

Selected Groups are displayed with an orange border. Groups can be selected by clicking on them, and if 
you press the Shift key while clicking on Groups you will add the Groups to the current selection. Using 
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the same key modifier you can also select  Groups in an area of the workspace simply by dragging the 
mouse. 

A series of functions let you create not only single Groups, but also pre-cabled Group chains.

How to edit a chain in the editor
Each Group is represented in the workspace as a box with two jacks for cables. The jacks are displayed as 
two small circles as shown in the following illustration.

A group  in the workspace

Cable from the 
previous group

Cable to the next 
group

Cable
jack

Cable 
jack

The jack on the left accepts cables from the right side of the previous Group in chain, and the jack on the 
right is used to cable the Group to the left side of the next one. Connected jacks are displayed in orange 
color, while unconnected jacks are in gray color.

Cabling Groups together is as simple as positioning the mouse cursor over a jack, and then dragging the 
mouse to a jack in another Group. In the same way, if a cable is already connected, you can unplug it and 
connect it to another Group in the same way: click on the jack and drag the cable to the new Group.

Note that you can only create cables going from a Group left jack to a Group right jack, or from a Group 
right jack to a Group left jack, as it wouldn’t make sense otherwise.

When you release the mouse button after cabling, Keymap will validate the chains and close any open 
chain. Group chains consisting only of one Group, while technically still a chain, will be demoted to single 
Groups.
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Adding single Groups
As the Group chains editor is connected in realtime with the Group table, you can add Groups normally 
from the Group menu using the Groups > Create new Group menu function, and they will appear in the 
workspace. Alternatively you can select the pen tool from the toolbar at the top, and simply click in the 
workspace: a new Group will be created under the mouse cursor. You can also use the Create new Group 
function in the context menu. Newly added single Groups are not wired to a chain already.

Adding alternate Group chains (two-Groups chains)
You can add a pre-cabled chains containing two alternating Groups by using the Groups > Create 
alternate Group chain menu function, or the Create alternate Group chain function from the context 
menu.

A new chain of two new Groups will be created, already cabled for you. You 
can later edit the chain to add more Groups at will.

Adding longer Group chains 
You can add a pre-cabled chains containing an arbitrary number of Groups  by using the Groups > Create 
cyclic Group chain menu function, or the Create cyclic Group chain function from the context menu.

You will be asked through a panel the number of the desired  
Groups (the length of the chain), and a new chain of new 
Groups will be created, already cabled for you. You can later edit 
the chain to add or remove Groups at will.
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Removing Groups from an existing chain
Sometimes you might want to remove a series of Groups from a chain, without deleting the Groups 
themselves. You can do that either manually, by changing all cabling, or automatically, by selecting the 
Groups and then using the Groups > Detach Groups from chain menu function, or the Detach Groups 
from chain function in the context menu. 

Reordering Groups in the workspace
As you create chains, you might needs to reorder the chains in the workspace to visualize things more 
clearly.  Once you select one of the Groups in the chain, Keymap offers two functions reordering.
The Groups > Reorder chain vertical menu functions will reorganize the chain as a vertical column of 
Groups.

After using the
Groups>Reorder chain vertical 

menu function

The Groups > Reorder chain circular menu functions will reorganize the chain Groups in a circle.

After using the
Groups>Reorder chain circular 

menu function

These functions only have a cosmetic purpose, and they do not modify the chain or the Groups in any 
way.
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Deleting Groups
Groups can be deleted from the Group table using the Edit > Delete menu function, or its equivalent in 
the context menu. You can also select the eraser tool and click with the mouse over Groups.

Navigating the workspace
You can pan through the workspace using the mighty mouse trackball, or by using the Hand tool and 
dragging the workspace around. You can zoom in and zoom out pressing the Option key modifier and 
turning the scroll wheel/trackball.

The chain functions in the Group inspector
As we have seen, the chain editor is the place where to create and edit chains. Still, in the Group inspector 
we have a few functions available about chains. The In Group Chain checkbox will show you if the 
selected Group is in a chain.  In that case , you can detach it from the chain by unchecking the checkbox.  
On the right you can see the previous and next Groups in the chain, and you can switch selection to one 
of them by clicking the appropriate button on the side, as shown in this illustration.

CHAIN PARAMETERS FOR A GROUP

The two buttons
let you select 
the previous 
and the next 

group in chain

Put the 
group in a 

chain

Previous 
group in 

chain

Next
group in 

chain
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MIDI Channel 
Normally Groups respond to incoming notes on any midi channel.  By enabling the MIDI Ch checkbox in 
the Group inspector, and selecting a midi channel you can force the Group to respond only to that single 
MIDI Channel.

SELECT BY MIDI CHANNEL

Select by 
MIDI

enable

MIDI 
Channel

This function is the key to creating multi-timbral instruments in Keymap and EXS24, as you can create 
separate layers, each with its own Group responding to a different MIDI Channel.

Page 171



Trigger Mode
Normally a Group, once active, will trigger Zones when receiving note-on messages. However, you can 
have Groups respond to note-off messages instead. This is useful when you want to add release samples 
to an instrument, i.e. when you want a certain sample to be played when you release a note on the 
keyboard. The parameter responsible for this is called trigger mode, is found in the Group inspector,  and 
can be can be set to NoteOn or to NoteOff. 

When you set the trigger mode to NoteOff, the Group will stop using the AMP Envelope, and will instead 
play Zones with a simple decaying envelope, whose time is set by the Dcy parameter.

NoteOff trigger mode decaying AMP envelope

ON NOTE- OFF
THE AMP STARTS AT FULL VOLUME

DECAY

Polyphony
The Group Poly parameter let you set the maximum number of Zones, assigned to the Group, that should 
be playing at once. When you trigger a note and you exceed the set limit, the oldest playing Zone in that 
Group will be stopped, and the new one will start playing instead. 

This parameter is useful for emulating some kinds of instruments where the sound is inherently 
monophonic.
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AMP Envelope Group offsets
The EXS24 and Keymap only have one single AMP Envelope generator. This may seem to be a serious 
limitation, in that you can’t have more than one envelope shape for each one of your instruments. We 
wrote “seem” because this is not the case. 

Each Group contains a set of time and level offsets respect to parameters of the main AMP Envelope. 
When a Zone is assigned to a Group, and you play the Zone, the Group offsets will modify the AMP 
envelope for that specific played Zone, without changing all other playing AMP envelopes. In other words,  
through this mechanism you can define many different envelope for your sounds, in a single instrument. 
To avoid making confusion between the original AMP shape and the modified AMP envelope, we’ll call 
the original envelope the “main envelope”.

The offsets available in each Group are relative to the attack, decay, release times, expressed in 
milliseconds.  The sustain level can be tweaked as a percentage of the level defined in the main envelope.

AMP Offset Group parameters

Hold time
Through the Group AMP offset mechanism, you can also transform the normal ADSR AMP Envelope 
available in Keymap and EXS24 into an AHDSR envelope, by setting the hold time parameter to a value 
different than 0ms. This parameter is only available from Groups.

ADSR Envelope AHDSR Envelope

ATTACK

DECAY

SUSTAIN PHASE

RELEASE ATTACK

DECAY

SUSTAIN PHASE

RELEASE

HOLD
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Editing the offsets and hold time from the AMP Envelope editor
It’s great to have the capability to use a different envelope for each Group, but not if you need a pocket 
calculator, some paper and a pencil to keep track of all those offsets (and all the time what you really want 
to do is to play music!). Keymap solves this problem by letting you edit the envelope shape directly in the 
graphic AMP envelope editor. When a Group is selected in the Group table, instead of modifying the main 
AMP Envelope parameters you will actually change the offsets in the selected Group.

When no Group is selected and you are editing the main AMP envelope parameters, then the envelope 
shape will be displayed in red color. When instead a single Group is selected, the envelope will turn in 
blue color, and by moving around the envelope nodes you will actually edit the Group offsets.

While you are editing the Group offsets, the main AMP envelope is still drawn as a reference, in a dark gray 
color.

Example of AMP envelope editing

Deselect all Groups, and switch to the AMP Envelope editor. The envelope will be displayed in red

Now select a single Group. The envelope will become blue. You are now editing the Group offsets. Notice 
how the offsets are still at their default values.
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If you now click and drag the envelope nodes  with the mouse, the main envelope is not modified, and 
can still be seen in dark grey inside the editor. You are just changing the Group offsets, so that the Group 
will play the blue envelope.

Resetting the AMP Envelope offsets
The Groups > Reset AMP Offsets menu function resets all offsets and hold parameters to zero in the 
selected Groups.

Output parameters
Each Group has a set of parameters dedicated to routing and modifying the audio output of assigned 
Zones.

Output Group parameters 

Output routing
Once you assign Zones to a Group, their audio output will be routed as selected by the Group out pop-up 
menu. The possible routings are to an Exs bus, to a Channel Map, or to a Surround bus. As the Group out 
parameter mimics exactly the Zone out parameter, we’ll spare you a duplicate explanation.

Page 175



Volume and Pan
The Volume and Pan are adjustable for each Group. These settings will combine with all other volume 
parameters in the hierarchical structure of your instrument, and so are good choices for tweaking the 
volume of a Group against another. 

As we have already seen, the Group volume is also settable through the various Group Ctrl, Pitch and 
Velocity aux editors by clicking the Option key while editing the full range cursors.

Other group functions

The Select linked zones in curr layer contextual menu command selects all zone sin the current layer, 
that belong to the selected group(s).

The Select next linked layer contextual menu command selects the next layer containing zones that 
belong to the selected group(s).  This is useful if you want to search for zones belonging to a group. 

Page 176 



Chapter 14: Setup inspector
The setup inspector let you change project wide parameters that affect both all instruments.  Most of 
these parameters are also available from the Setup editor. 

Vel mapped using
This pop-up menu lets you substitute the normal note velocity with a the value of a MIDI Controller. Once 
set to a MIDI Controller different than “Velocity”, each time Keymap (and the EXS24) receives a note-on 
message, it will get the “velocity” value not from the velocity of the note, but from the current value of the 
selected controller. Selecting a controller different than Velocity enables the Dynamic crossfade mode, 
and disables all defined Static crossfades for all instruments in the setup.

XFade
This value determines the size of the extended velocity area used for dynamic crossfades in Zones and 
Groups. If you set it to a value different than zero, the Dynamic crossfade mode will be enabled, and any 
Static crossfade in all instruments in the setup will be disabled.

XFade Shape
This pop-up menu let you select the volume shape to be used in the dynamic crossfades areas.

Possible values are:
DbLinear : the volume, expressed as decibel, will linearly fade to/from zero
Linear  : the volume will linearly fade to/from zero 
EqlPower : the volume will fade to/from zero using an equal power shape
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Slow Attack, Fast Attack, Decay, Sustain, Release
These parameters control the shape of the AMP Envelope

AttShape
This parameter controls the shape of the attack phase in the AMP Envelope, as shown in the following 
illustration.

AMP Envelope AttShape parameter

RelScale
This parameter changes the release time for the AMP Envelope depending on the position of the played 
note respect to MIDI note 60. When edited, the envelope editor will briefly show the factors that will be 
used for the release time across the whole note range, as shown in the following illustration:

AMP Envelope RelScale parameter
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Volume Scale
This parameter lets you scale the volume across the keyboard with respect to note 60, and is measured in 
decibels per octave. Positive values will lead to higher volume on high notes, while negative values will do 
the opposite.

Volume
This is the general volume control for the whole setup.

Tip: if you just want to change the monitoring 
level, you can use Keymap built-in independent 
monitoring volume, assigned by default to the F1 
and F2 keys on your Mac keyboard. This volume 
controls the volume on all Keymap audio outs, 
and doesn’t change the volume for other audio 
applications that might be running at the same 
time.

Global tune, Fine tune
These two parameters control the tuning of the whole setup.

Dynamic Range High, Dynamic Range Low
These two parameters controls the dynamic range for played notes, over the whole velocity range.

Dynamic Range High
(the volume to be used for notes 

played at velocity 127)

Dynamic Range Low
(the volume to be used for notes 

played at velocity 1)

Dynamic range parameters
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Dynamic Range High is the volume to be used when notes are played at full velocity (velocity 127), and 
Dynamic Range Low is the volume to be used when notes are played at the lowest velocity (velocity 1).
The dynamic range for the setup is given by the difference between the two values.

When creating a new project, the dynamic range is set accordingly to the Default dynamic range for new 
projects value in the preferences panel. 

Vibrato section
The vibrato section is available only if the use of LFO1 by Keymap for this task doesn’t interfere with an 
existing routing or use of it in the original EXS24 instrument synthesis parameters, and the LFO1 rate and 
EG values in the EXS instrument are within the values range supported by Keymap.
if the instrument is built from scratch in Keymap, then the vibrato section is always available.

Vibrato rate
This parameter controls the rate of the vibrato LFO. When saving to EXS24 format, this is mapped to LFO1 
Rate.

Vibrato Amount High
With this parameter you set the amount of vibrato, expressed in cents of a semitone, when the MIDI 
Controller tied to the vibrato  is at full value.

Vibrato Amount Low
With this parameter you set the amount of vibrato, expressed in cents of semitone, when the MIDI 
Controller tied to the vibrato  is at minimum value.

Vibrato EG
The parameter controls a simple envelope generator modeling the vibrato LFO waveform shape.  Setting 
it to a value different than zero, means that the vibrato LFO shape will  fade-in for the set amount of time.
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Vibrato Controller
With this pop-up menu you set the MIDI Controller ties to vibrato control. A common controller used for 
this task is the Modulation Wheel, a.k.a. MIDI Controller #1
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Chapter 15: Instrument Editor Magic Pads
When building sampled instruments, some tasks are intrinsically repetitive. Loading recordings, splitting 
them in individual audio segments, mapping those segments in the instrument, etc..

Magic pads are drag and drop destinations for samples which automatically perform predefined sets of 
action chains on the dropped samples. They are appear onscreen as small square pads , and are available 
in all Instrument editors next to the layer table. While the action chains for Magic pads are not user 
modifiable, they represent the most common tasks involving repetitive editing.

Magic pads

#1 #2 #3 #4 #5

Magic pads do not have specific name, and they are referenced through their position. As Keymap 
currently includes five Magic pads, we reference them as Magic pad #1 up to Magic pad #5.

When you drag some samples from the Finder, and you move the mouse cursor over the pads, a short text 
message informs you of the functionality tied to that specific pad.

Let’s examine each single pad in detail.

Magic Pad #1
This pad adds dragged samples to the current layer and autoloops them. The created Zones are mapped 
sequentially starting from MIDI note 20, and are 1 note wide.  This pad is useful if you have many rhythmic 
segments already cut but not looped, and you want them mapped and looped on the keyboard. 
Autoloop by its nature needs a larger audio segment than just the loop, so you will not get the expected 
results if the segments are already perfect loops—in that case you can simply drag the samples into the 
Layer matrix.
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Magic Pad #2
This pad allows automatic construction of multi-velocity instruments with keyswitched variations and 
pseudo-randomization features. The recording you are going to drop over Magic Pad must be well 
structured for this function to work properly, and you must plan how you want the instrument in advance. 

For example, let's say that for three variations of your hihat (closed, mid, open) and for each of the two 
velocities per variation you'll want to record, you also want four equivalent samples to will be played in 
round robin fashion so that the instrument sounds natural.

You just have to record the hihat in this ”hits by variation by velocity” sequence:
hit1-closed-lovvel
hit2-closed-lovvel
hit3-closed-lovvel
hit4-closed-lovvel

hit1-mid-lovvel
hit2-mid-lovvel
hit3-mid-lovvel
hit4-mid-lovvel

hit1-open-lovvel
hit2-open-lovvel
hit3-open-lovvel
hit4-open-lovvel

hit1-closed-hivel
hit2-closed-hivel
hit3-closed-hivel
hit4-closed-hivel

hit1-mid-hivel
hit2-mid-hivel
hit3-mid-hivel
hit4-mid-hivel

hit1-open-hivel
hit2-open-hivel
hit3-open-hivel
hit4-open-hivel
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When you drop this single recording on Magic Pad #2, Keymap will open a panel and ask you the number 
of hits, variations and velocities, and if you either want to map samples sequentially (drums) or by pitch 
detection (harmonic sounds). 

Keymap will then automatically create an instrument in which keyswitches will change the playing Group 
from " closed " to " mid " to " open ", and then each of these three variations will play the correct 4 hits in 
round robin fashion, and the velocity will also select the right velocity set. In situations in which there is 
only one variation, or only one “hit” per variation, the corresponding keyswitch or cyclic Group chain 
selection will not be enabled/created. With this function you can really create very complex instruments 
with minimal effort.

Note: each split segment is automatically trimmed using the levels set in the preferences panel. If 
you do not get the expected results, you might have set those values too high or too low.

Magic Pad #3
This pad expects to receive recordings each containing multiple tuned audio segments. Each of these 
recordings will be automatically split and trimmed in its individual segments, and then each segment will 
be pitch detected and mapped on the layer accordingly. The trim values for attack and release are set in 
the preferences panel. A new layer will be created for each recording (sample file).
No autolooping is performed.

This pad is very useful for quickly creating instruments out of recordings.

Magic Pad #4
This Magic pad works as magic pad #3, but also autoloops samples.

Magic Pad #5
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This Magic pad works as magic pad #4, but also adds crossfading to the loop and then optimizes it. It 
might be a good solution for exotic audio material.
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Chapter 16: Sample editor
The sample editor is where you perform edits on virtual samples and have full access to all the Keymap 
functions for creating loops, Regions, applying Harmonic Resynthesis, creating slices and much more. 
While the focus of the sample editor is on a single virtual sample at a time, the same features and 
functions of the sample editor are also available in the Aux Sample Editor found in the Instrument editor 
and resources window, which is for all intents and purposes as functional as the full sample editor only   
stripped of some of the full sample editor’s surrounding elements.

Edit modes
and 

HR Enable

Shift+button 
tools

Various

Meter and 
volume 
control

Real 
Sample 

inspector

Selection 
inspector

Sample
Cursor

Playback
cursor

Sample view

Loop editor

Virtual sample 
inspector

Loop with 
crossfade

Sample 
overview

It is important to understand that the sample editor is always about virtual samples, and not the real 
sample files on disk. All the cut and paste operations you do here never modify the real samples: the 
editor, and all of its functions, are totally non destructive. 
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The main element in the sample editor is the sample view, where the sample waveform is displayed, and 
where you can set cursors, define loops, make selections, and perform functions.

Selection

Play
cursor

Loop

Ruler
Ruler units

selector

Vertical zoom 
and autozoom

HR Envelopes
vertical zoom

Sample
Start 

cursor

Loop
Start 

cursor

Loop
End 

cursor

Sample
End 

cursor

Loop
XFade 
cursor

Fade-In
cursor

Fade-Out
cursor

In each sample view you always have a number of cursors tied to the basic set of virtual sample 
parameters:

The Sample Start cursor represents the starting point for playback of the virtual sample. When the 
sample is going to be played with the MIDI keyboard, playback will start from there.

The Sample End cursor represents the ending point of playback of the virtual sample. When the sample is 
being played with the MIDI keyboard, playback will stop there, unless there’s a loop defined, in which case 
the playback never goes beyond the loop end, as it jumps back to the loop start.

The Fade-In Cursor represents the length of the initial fade-in (if any), and is tied to the Sample Start 
cursor (when you move the start sample cursor, the fade-in cursor will move too).

The Fade-Out Cursor represents the length of the final fade-out (if any), and is tied to the Sample End 
cursor (when you move the end sample cursor, the fade-out cursor will move too).

When a loop is active you’ll also see the loop highlighted in light blue color, with some loop-specific extra 
cursors:

The Loop Start cursor sets the start position of the loop. This cursor is always after the fade-in cursor.

The Loop End cursor sets the end position of the loop. This cursor is always before the fade-out cursor.
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The Loop XFade (crossfade) cursor sets the amount of crossfade that will be used with the loop.

When the sample is being played, the playback position is being shown in realtime by the red color 
playback cursor.

If you click with the mouse over the waveform, you will set the black-color sample cursor. 

Under the sample view we find the sample overview, which shows the whole sample extension.

The sample overview

View-From
Cursor

View-To
Cursor

Playback 
cursor

In the sample overview we have the View-From and the View-To cursors, which at all times let you set  
the portion of the whole sample being displayed in the sample view. The playback cursor is seen (but not 
edited) in the sample overview too, as a vertical red line.
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How the sample is displayed
The sample is displayed in a familiar way, with some important differences.

There is no conventional zoom level.
 The sample view simply shows the waveform between the two view cursors positioned in the sample overview

View-From
Cursor

View-To
Cursor

Sample area outside 
"start-to-end" is drawn 

in grey color

Sample area inside 
"start-to-end" is drawn 

in blue color

Waveform color
The waveform color indicates whether it is within the sample-start to sample-end area (in blue), or 
outside (in grey). 

No horizontal zoom
There is no conventional horizontal zoom factor:  at any moment the sample view shows the sample 
section within the two View-From and View-To cursor in the Sample Overview. The high-performance 
Keymap graphic subsystem can visualize the sample from any position to any position, and is smoothly 
updated in realtime as you move the view cursors. An extensive set of zooming functions accessed 
through menus and key commands let you zoom out completely, zoom just the start-to-end section, 
zoom the loop, zoom the selection.
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Vertical autozoom
A typical problem with decaying samples is that very often the display only shows you a huge peak and 
then a flat line as in this following illustration:

The case of the decaying sample: without vertical autozoom

When you 
zoom the 
selection

A common decaying 
piano sample

You just see a lot of 
empty pixels

If you zoom on the center section of that sample, you’d normally see.… nothing, and you would have to 
constantly tweak the vertical zoom.  The vertical autozoom function in Keymap, when enabled, constantly 
changes the vertical zoom in order to show you the maximum amount of useful waveform:

The case of the decaying sample: with vertical autozoom

When you 
zoom the 
selection

A common decaying 
piano sample

You always see the 
audio waveform!

The autozoom function is independent from the vertical zoom slider, so that you can have the autozoom 
function enabled and still zoom on something with the slider.
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The representable dynamic range
The problem with visualizing waveforms on a computer display is that waveforms can have an enormous 
dynamic range. Each 24 bit sample can be at more than 16 million possible distinct levels(!), while  
displays have typically just a few hundreds pixels for representing a sample. Keymap constantly calculates 
and updates the maximum and minimum audio level representable on screen, considering the available 
number of pixels and the zoom and autozoom factors.

Vertical zoom, autozoom , and the representable dynamic range on screen

-30.68 dB

--64.48 dB

The highest waveform 
level representable on 
screen with the current 

zoom settings

The lowest waveform 
level representable on 
screen with the current 

zoom settings

Vertical zoom slider

Vertical autozoom 
checkbox

This is especially useful when the vertical autozoom is enabled, so you have at all times two reference 
levels to the waveform you see.

Ruler and ruler units 
The ruler in Keymap sample view can be set to use several different units of measure. You change the unit 

of measure by clicking over the clock icon , and selecting from 
the context menu:
- Samples shows positions in samples from the beginning 
- Milliseconds shows positions expressed in milliseconds, or 
for long samples in seconds, from the beginning 
- Time shows positions as absolute time from beginning
- Percentage shows positions as percentage of the total 
sample length
- Percentage S to E shows positions as percentage starting 
from the Start position (0%) to the End position (100%)
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Horizontal autozoom for cursors
When editing cursors, it’s very common look at the whole sample, as this way you get a good idea of the 
relative cursor positions. However, this makes precise graphic editing almost impossible, since moving the 
cursor with the mouse by just one pixel could mean changing the value of several thousands samples at 
once!

Keymap solves this problem by progressively zooming in horizontally when, during a click-and-drag 
cursor session, you continue holding down the mouse button but stop moving the mouse for a couple 
seconds. Once you reach the optimal zoom level you need, move the mouse again, and the zoom-in will 
stop momentarily. If you stop again, zoom-in will continue from the current zoom level. 
Once you set the right cursor position and release the button the original starting zoom level will be 
restored. Setting a cursor has never been so simple and ergonomic!

TruView display mode
Keymap by default shows you the audio waveform before processing. If you add a fade out, the displayed 
waveform will not change to reflect that. However, looking at the result of your edits can sometimes be 
very useful, especially when setting crossfades. For this reason Keymap offers the TruView display mode: 
once enabled, the waveform will show you the outcome of your edits, as in the following illustration.

TruView display mode

With TruView disabled, 
you do not see the 

actual result of your 
fades and crossfades

With TruView enabled, 
you do see the outcome 

of your fades and 
crossfades

The TruView display mode uses more CPU resources than the standard mode, so you might want to 
enable it only in the situations of effective use.
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How to open the sample editor  for a virtual sample already assigned to a Zone.
You can open the sample editor in several ways.
- by double clicking over Zones selected in the Instrument editor
- by double clicking the Aux editor in the Instrument editor, when it displays a sample
- by selecting the Zones in the instrument window and using the Windows > Show sample editor for 
selected Zones menu command
- by selecting the Zones in the resources window and using the Windows > Show sample editor for 
selected Zones menu command
- by double clicking over the non editable section of the Zone table in the resources window 

How to open the sample editor for a sample file not already assigned to a Zone.
You can also open the sample editor for a sample file which has not yet been assigned to a Zone through 
the File > Add samples to current project menu function. This is useful when you want to load a sample 
and split it in segments, each mapped to a different Zone.

How to save edits done in the sample editor
Every edit you perform updates the project in memory immediately; for this reason there’s no “save” 
function specific to the sample editor. All the virtual sample edits you make, affect the project only (never 
the sample files!) and are saved together with the project when you perform the File > Save menu 
command.

The exception is the case of a sample opened with the File > Add samples to current project. The edits 
you do for that sample will never be saved, but all the Zones you create out of that editing session, and all 
the relative virtual samples associated to the new Zones of course will be saved with the project.

In other words: Keymap saves virtual samples edits with the project, only if/when these virtual samples 
are associated to Zones.  

How to set the sample cursor
If you click the mouse inside the sample view, the black colored sample cursor will move to the mouse 
position.

How to select a segment of a sample
If you click the mouse in the sample view and then you drag the mouse holding down the mouse button, 
you define a selection. The selection start and end positions, and the selection length, are visible from the 
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selection inspector. The selection mechanism is important, as many sample editor functions work on 
selections.

Playing the sample
You can always play the sample using the transport controls at the bottom of the sample editor:

Play from 
Loop start

Play from start
Play from current 

play cursor position

or by using the Play key commands. By default, the spacebar key plays from the sample cursor, shift
+spacebar plays from the sample start, and option+spacebar plays from the current playback cursor 
position.

Dragging the playback cursor to a position
While the sample is playing, it is possible to drag the playback cursor, and jump playback to any position 
within the sample and end positions, either by dragging the diamond shape at the top of the red 
playback cursor:

 
or by holding down the Option key and clicking directly in the ruler area: the playback cursor will jump to 
that position and continue playing from there. If you press the Option key and then drag the mouse over 
the ruler, you will be able to scrub to any point in the sample within the sample and end positions.

Audition mode
Sometimes you want to repeatedly play back a small section of the sample so that you can adjust 
parameters or (loop) positions. In other audio applications you are probably used to selecting a segment 
of the waveform and then enabling a mode for repeat playback. The problem with that approach is that 
you can’t use it across the sample loop end boundary and back to loop start, which is probably the single 
most important transition. Also, that approach makes it difficult to hear the attack of your selection, since 
the attack plays immediately following the end of the selection. To solve both these problems, Keymap 
provides a playback Audition mode: you set the audition time, enable Audition mode and start playback. 
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The playback will start and continue normally for the set audition time, then fade out to silence, and start 
again at full volume from the initial point. You can change the initial point simply by setting the sample 
cursor (clicking with the mouse in the sample view). 

Audition mode playback 

Play
Fade Out

Audition Start
(Sample Cursor)

Playback starts from the sample cursor,
 goes on for the set audition time,
 fades out, and then starts again 

Audition mode never interferes with the normal path of the playback cursors. If you start playback near 
the end of a loop, the playback cursor will follow its normal path and when it reaches the loop end, it will 
jump back to the loop start position, continuing from there. When the audition time expires, the fade out 
will happen and then it will start again from the original start position.. 

Audition mode playback through the loop end

Loop

Loop

Play

Play
Fade Out

Audition Start
(Sample Cursor)

Once the playback cursor reaches the loop end, 
it jumps back to loop start, plays for the remainder of the audition time,

 fades out, and then starts again 
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The audition time is not set as a numeric value, but by holding down for the desired amount of time the 
Learn audition time key (normally it’s shift+A). Audition mode is enabled/disabled using the Toggle 
audition mode key command (by default the A key). When in audition mode, a small flashing red warning 
will appear next to the sample view to remind you that the Sample Editor is in audition mode.

Meters, monitoring volume and muting
The meters at the bottom left of the sample editor window show the RMS levels (in green) and the Peak 

levels (in Red) of the played sample. You can also change the monitoring volume for the editor 
by clicking over the small yellow triangle, and dragging it vertically to the desired level. 

This volume level only affects the volume for the current editor. If you want to modify the 
overall Keymap monitoring volume, you can use at any time the F1 and F2 function keys.

You can also mute the sample editor temporarily by holding the Option key modifier and 
clicking over the meters. If you click again, the volume will be reset at 0dB.

Zoom and pan using the sample overview, and the visible segment
As we have seen, in Keymap you can set the sample view to show any sample segment, from every 
position to any other position simply by moving the view cursors in the sample overview to the desired 
position. The sample segment visible at any time in the sample view is called the visible segment.

Relationship between  sample overview and sample view: the visible segment
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If you want to pan the visible segment, click in the sample overview between the two view cursors, and  
drag the (yellow) highlighted visible segment around. If you want to zoom in or zoom out of the current 
visible segment, press and hold the Shift key then click again with the mouse in the sample overview, 
between the two view cursors, and drag the mouse up and down.

Zoom and pan using the Mighty Mouse
The small trackball available in the Apple Mighty Mouse device makes for an excellent controller in pan 
and zoom applications. Keymap supports this device in multiple ways:
- you can pan the visible segment by placing the mouse cursor over the sample overview or the sample 
view and scrolling left or right
- you can zoom in/out by placing the mouse cursor inside the visible segment in the sample overview, 
and scrolling up and down
- you can zoom in/out by placing the mouse cursor over the sample view and scrolling up and down

Notice how zooming is always made relative to the mouse cursor position. This is extremely ergonomic, as 
you can place the mouse cursor over a waveform peak, scroll the trackball up/down, and you will zoom 
in/out exactly around that peak.

If you first select a section of the sample, and then quickly scroll down the trackball, you will zoom the 
selection.

Zoom and pan using the Trackpad 
If your Mac laptop supports trackpad gestures (all recent ones 
do), and you enabled them as shown in the picture on the right,
Keymap will let you use it similarly to the Mighty Mouse 
trackball. When you place two fingers on the trackpad at the 
same time,  and the mouse cursor is over the sample view, you can zoom by moving fingers forward and 
backward, and pan moving fingers left or right.

Zoom and pan using the cursor keys
You can also use the cursor keys for zoom and pan. The Cursor Left and Cursor Right keys pan the visible 
segment. Option+Cursor Left and Option+Cursor Right will instead change the current zoom level.
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Zoom functions
A number of functions, accessible through both menu commands and key commands,  let you zoom to 
specific sample segments instantly:

- the View > Zoom all menu command (Option+Up Arrow) will display the whole sample
- the View > Zoom selection menu command (S) will zoom to the selection
- the View > More Zoom > Zoom loop menu command (Down Arrow) will zoom to the loop
- the View > More Zoom > Zoom to the Zone menu command (Up Arrow) will show the start to end 
segment
- the View > More Zoom > Zoom cursor menu command centers the sample view around the sample 
cursor

Note that most of these functions do not *exactly* zoom to the respective segment, but will also display  
some additional space at left and right so you can readily adjust the cursors without having to zoom out 
or pan immediately.
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Chapter 17: Loops
Creating a loop
You can define the loop segment by making a selection in the sample view, and then using the Samples > 
Loop > Set loop from selection menu command (Option+L). The loop segment will be displayed as a 
highlighted light blue color area, and the Loop Start, Loop End and Loop XFade cursors will appear. 

The Loop

You can move the 
whole loop by clicking 

and dragging the 
highlighted are in the 

ruler

The loop segment is 
highlighted in light blue 
color also in the sample 

overview

The loop segment is 
highlighted in light blue 
color in the sample view

Loop Start
cursor

Loop End
cursor

Loop XFade
cursor

The EXS24, and Keymap, support a single loop for each Zone/virtual sample. In a looped sample, playback 
never goes beyond the loop end position. 

Crossfade loops
The EXS24, and Keymap offer realtime loop crossfades which is very useful for smoothing out the “join” 
point of the loop, i.e. when the playback cursor jumps from the loop end back to the loop start. This 
function does not require the sample files to be modified, and is performed in realtime by the EXS24 and 
Keymap while playing notes.

Once you set the crossfade length, the function works by smoothly fading-out the end of the loop 
segment, and at the same time mixing-in the audio segment from the corresponding relative position 
immediately before the loop start.
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The Loop Crossfade (XFade)

Segment A (pre loop-start) Audio from the loop segment fading out + 
audio from segment A fading in

This way, (at least ideally) the audio at the end of the loop should blend seamlessly with the audio at the 
start of the loop in order to avoid glitches: the crossfade function spreads any possible glitch or sonic 
difference over the length of the crossfade (mix) before loop end.

Note: adding a crossfade to a loop does not ensure that the loop will be smooth, due to the other 
factors involved (such as: the audio waveform phase, the spectral content, and so on). Keymap 

however provides functions that greatly help you in finding good loop points and crossfades.

Loop crossfade shapes
When the loop is enabled, the crossfade shape for the loop can be selected among three different curves 

from the LoopXF Shape pop-up menu.

- linear: this shape is recommended for simple waveforms
- equal power: this shape is suggested for complex audio material
- s-curve: this special shape is an hybrid between linear and equal 
power and might be useful in certain situations
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Enabling/disabling a loop

Loops are enabled and disabled in the sample editor with the Samples > Toggle loop menu function (L). 
When a loop is disabled, the loop cursors are not shown in the sample view.

Autolooping

Keymap offers several functions for creating optimal loops in your samples. Before we start describing 
these functions, we need to discuss the nature of loops.

What is a good loop?
“What is a good loop”  is a simple question, but as we’ll see the answer is very complex. Let’s look at a 
typical single snare sample. The sound is intrinsically percussive and starts with a “bang”,  quickly fading 
into silence. Can we loop the snare so that the body of the sound can be played for an indefinite amount 
of time, as long as we hold down the key on the MIDI Keyboard? The answer is no: the sample itself is a 
big transient, and nothing in the overall structure of the sound has a steady sonic state that can be played 
over and over.

But you can certainly define a 300 sample-long segment of it to loop randomly, and get a buzzy sound 
that might be nice to play. We can also loop the whole sample, and it will be *for sure* a good rhythmic 
loop.  As you can see, what is a “good loop” has not a single clear answer.

Another example: let’s take a “good”  drum loop of 1 bar at 120bpm 4/4. 

That loop will be perfect *to me* (a Vienna musician, playing walzer), if I cut out one quarter of it and it 
becomes 1 bar of 120bpm ar 3/4.  

The same original loop is perfect *to my friend* (a progressive rock musician) when he cuts out one eight 
of its length, and it becomes 1 bar at 120 bpm 7/8.

The musician from Vienna will be probably horrified at the 7/8 loop, and the prog rock player will consider 
the 3/4 loop to be decadent.

If you are an avant-garde musician, you could probably pick two random sample positions for the loop, 
and get great results (even if probably to your ears only!).
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All this is to point out how the term “loop” not only has multiple meanings, but also that sometimes the 
loop *you* consider perfect could be simply *terrible* for another user, regardless of its technical 
characteristics. This is because you are applying your artistic background to your definition of “good loop”.

So, back to Keymap, how can a software application find the loops for you if it’s not possible to define 
exactly what a  “good loop” is? The Keymap answer is that the “good loop”  is the most “natural loop” which 
makes musical sense as a single segment from a larger segment of material. Once that natural loop is 
found, it’s up to you and to your artistic choices to modify it at your will.

This means that for Keymap to search for and offer you a good loop, you have to give it a larger audio 
segment to search. Trying to search a for good loop inside a sample already defined by a loop, will *never* 
give you the original loop as a result,  but probably something 1/4 or 1/2 the length, as Keymap needs to 
have some musical context around loops in order to find them.

It’s also important to understand that, depending on the material, the best rhythmic loops in a sample are 
not necessarily the ones starting at the position you’d normally try to use as a start (as example,  at the 
beginning of a bar), because for example there might be a tail from some other transitory sound 
(cymbals?) creating a glitch at the join point.

Similarly, with harmonic sounds (instrument samples), historically loop points are searched for at zero-
crossing points, but the truth is that zero-crossing points are not much more than a trick used by human 
beings in order to simplify the search, and not necessarily the best places to search for loops.

The  Keymap Autoloop functions will look for the best natural loop in your samples, regardless of where 
the found loop will start. You can change the start point later, to zero crossings or to beat 1,  using other 
Keymap functions.

Beyond searching for good loops, Keymap also offers specialized tools for optimizing existing loops, and 
for  looping single cycle loops in harmonic samples.

Note that Keymap autoloop functions will not modify or process your samples, but will simply pick the 
“right points” for you.

Page 204 



Autoloop within a selection
The main autoloop functions search inside the sample selection boundaries. While the algorithm is 
internally *very* complex, the interface is extremely simple: just select a segment, then use the  Samples 
> Loop > Autoloop LowRes from selection menu command.
That’s it.

Select a segment of your sample

The loop is found and set

Samples>Loop>Autoloop 
Low Res from selection

menu command

Autoloop

There are actually four different variations of that menu command, depending on which algorithm and 
search mode you want to use:
Samples > Loop > Autoloop LowRes from selection
Samples > Loop > Autoloop HighRes from selection
Samples > Loop > Autoloop LowRes from selection (Keep Start)
Samples > Loop > Autoloop HighRes from selection (Keep Start)

LowRes and HighRes are the two possible algorithms you use. They differ in the accuracy of the loop 
search, and in the time needed to perform it.  LowRes can handle most applications and it is fast.  HighRes 
should be used only when LowRes doesn’t give you satisfactory results, and is far slower.

Normally the loop search will be performed inside the selection with no special regard to where the loop 
should start. However, the loop search can also be anchored to the start of the selection. The “Keep Start” 
variation will force Keymap to look for loops starting within a few hundreds samples from the selection 
start. Adding that  small tollerance of “a few hundreds samples” will greatly improve the chance of finding 
a good loop, as not every loop start position has a correspondingly good loop end position.
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Parametric autoloop
Sometimes you might want a little more control over where the loop should be searched. The Samples > 
Loop > Parametric autoloop menu function let you set a few parameters that will guide Keymap  in its 
search.

The numeric values are expressed as a percentage, which that is more useful than absolute lengths 
because you’ll frequently deal with with samples of varying length. The minimum start position and 
maximum end position parameters let you set the segment of the sample where the loop search will 
occur. In that segment, Keymap will search a loop of length equal or bigger than the minimum loop 
length parameter value. 

The Algorithm pop-up menu lets you select which of the two algorithms you want to use.

Once all parameters are set, you click Ok, and then Keymap will find you the best loop.

Setting the loop from the loop data in the sample file
AIFF and WAV samples can contain loop information such as the loop start and loop end positions. The 
Samples > Loop > Set loop from sample file looks in the sample file for that information, and if found, it 
sets the loop in the sample editor to those positions.

Autolooping a single cycle in an  harmonic sample
If you are editing an harmonic sample, you can create single cycle loops very easily by setting the sample 
cursor in the sample view, and using the Samples > Loop > Autoloop single cycle menu command  (K). 
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Rephasing a loop (setting a new loop start inside the loop)

Once you have a good loop with no perceptible glitches at the join point, you might want it to start at a 
different position. The rephase loop function does all the needed editing for you, automatically. You just 
have to set the cursor at the desired starting point, which must be inside the loop, and use the Samples > 
Loop > Rephase loop menu function. The sample will be sliced and recombined as shown in the 
following illustration.

B C

Rephase loop: segments processing detail

Loop

A D

A B DC

Select the new position within the 
loop you want to use as loop start

The rephased loop now starts 
exactly at that position

Use the 
Samples>Loop>Rephase 

loop menu function

Playback direction

Playback direction

Loop

CB

Note how the total sample length will increase by exactly one loop length. 

You can also completely cut the tail of the sample past the loop end position using the Samples > Loop > 
Rephase loop and cut tail menu function.

B C

Rephase loop and cut tail: segments processing detail

Loop

A D

A BC

Select the new position within the loop 
you want to use as loop start

The rephased loop now starts exactly at 
that position. The tail past the new loop 

end has been cut

Use the 
Samples>Loop>Rephase 

loop and cut tail menu 
function

Playback direction

Playback direction

Loop

B
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Unroll loop
Another useful loop function is unroll loop.This function, accessed through the Samples > Loop > Unroll 
loop menu command, slices the loop and adds additional loop copies before and after it, as shown in the 
following illustration. 

Unroll loop: segments processing detail

B

Loop

A C

A

Initial situation

Copies of the loop will be placed 
before and after the current loop.

Use the 
Samples>Loop>Unroll 

loop menu function

Playback direction

Playback direction

B2

Loop

CBB1

The net result is that once the loop has been unrolled, you can move the loop body by +/- 1 loop length, 
with the guarantee that the loop will still sound perfect. This is a more interactive process than rephase 
loop, as you can tweak the loop starting point interactively by moving the loop body.

Unroll loop: moving the loop body

A

Once the loop has been unrolled, 
you can move the loop body by 

+/- 1 loop length, with the 
guarantee that the loop will still 

be perfect

Playback direction

B2

Loop

CBB1
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Double the loop length
The Samples > Loop > Double loop length menu command doubles the loop length, by moving the 
loop end position. If the audio material maintains a reasonably steady timing, the loop will still play in a 
musically interesting way.

Double loop length

LoopA C
Initial situation

The loop end is moved forward 
exactly so to double the loop 

length

Use the 
Samples>Loop>Double 

loop menu function

Playback direction

remainder of C2X LoopA

Playback direction

Halve the loop length
The Samples > Loop > Halve loop length menu command halves the loop length, by moving the loop 
end position. If the audio material is playing with a reasonably steady timing, the loop will still play in a 
musically interesting way.

Halve loop length

LoopA C
Initial situation

The loop end is moved backward 
exactly so to halve the loop 

length

Use the 
Samples>Loop>Halve 

loop menu function

Playback direction

remainder of C
1/2x
Loop

A

Playback direction
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Shift loop  to right (push ahead) of 1/16th
You can shift the loop to the right (push ahead) by 1/16th of its loop length. If the audio material is 4/4 
and you are dealing with an certain number of bars (1, 2, 4, 8), and the audio is played at a steady tempo, 
this shift has a musical meaning.

Shift loop right of 1/16th

LoopA C
Initial situation

The loop start and loop end are 
shifted to right of 1/16th of the 

total loop length

Use the 
Samples>Loop>Shift 

loop right 1/16th menu 
function

Playback direction

LoopA C

Playback direction

Shift loop to left (push back) of 1/16th
You can shift the loop to the left (push back) by 1/16th of its loop length. If the audio material is 4/4 and 
you are dealing with an certain number of bars (1, 2, 4, 8), and the audio is played at a steady tempo, this 
shift has a musical meaning.

Shift loop left of 1/16th

LoopA C

Initial situation

The loop start and loop end are 
shifted to left of 1/16th of the 

total loop length

Use the 
Samples>Loop>Shift 
loop left 1/16th menu 

functionPlayback direction

LoopA C

Playback direction
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Improving loop points

Keymap offers a few functions designed to improve loops, by moving the loop start and/or the loop end 
to nearby positions that might have some better qualities. This set of functions is distinct from autoloop, 
as they use a totally different approach, and will only search for a potential position near the existing one. 
Most of these functions are available both as menu commands, as key commands, and as dedicated 
buttons in the sample editor.

 In this section, we’ll use the terms tune and tuning to refer to “improving” loop positions, not to changing 
pitch.

Fine tune loop start
This function is available from Samples > Loop > Fine tune loop start, and will search for a better starting 
loop point within a few hundred samples from the current position.  This function changes the loop 
length.

Fine tune loop end
This function is available from Samples > Loop > Fine tune loop end, and will search for a better ending 
loop point within a few hundred samples from the current position.  This function changes the loop 
length.

Fine tune whole loop
This function is available from Samples > Loop > Fine tune whole loop, and will search for better starting 
and ending loop points within a few hundred samples from their current positions.  This function changes 
the loop length.

Coarse tune loop start
This function is available from Samples > Loop > Coarse tune loop start, and will search for a better 
starting loop point within a few thousand samples from the current position.  This function changes the 
loop length.

Coarse tune loop end
This function is available from Samples > Loop > Coarse tune loop end, and will search for a better 
ending loop point within a few thousand samples from the current position.  This function changes the 
loop length.
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Coarse tune whole loop
This function is available from Samples > Loop > Coarse tune whole loop, and will search for better 
starting and ending loop points within a few thousands samples from their current positions.  This 
function changes the loop length.

Optimizing a crossfade loop
When you create crossfade loops you are mixing two different segments of the same audio material. This 
can cause a number of sonic problems if the two segments are not coherent. The Samples > Loop > 
Optimize loop crossfade menu function will move the loop end position in order to give you a batter 
crossfade loop. 

As the new position is searched only near the current position, you might need to perform this command 
more than once before finding the right position. The length of the crossfade loop also plays a factor in 
the search, and longer crossfades will lead to better loop optimizations.
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Single cycle loops

Several kinds of sounds can be effectively looped using a single waveform cycle, i.e. as a single repetition 
of the basic waveform being played. This technique works, often surprisingly well, with wind instruments, 
synths, voices, and basses.

One of the problems you find with single cycle loops is that there is an identity between the loop length 
and the perceived pitch. If you have a perfect single cycle loop, and you make it longer by a few samples, 
you will not only get some clicks caused by using non-ideal loop points, but you will also hear a lower 
pitch. Why this? Because you are essentially repeatedly playing the looped segment: regardless of what is 
in the looped audio segment, the perceived pitch fundamental frequency will be equal to the number of 
times you play that segment in a second. 

Another related problem is that while loop start and end positions (and therefore the loop length) can be 
expressed only as integer numbers, almost in every case you’d need loops of fractional length.  For 
example, the fundamental frequency for note C4 is 261.60 Hertz, and this needs a single cycle loop of 
168.57 samples (at 44.1Khz sample rate) to play at the right pitch. This looks like an impossible problem, 
as you can only build loops of 168 or 169 samples. The clever solution introduced many years ago by 
sampler manufacturers is to have a fine tune control for the loop segment. With this control you can set a 
loop of 168 samples, which will play sharper than wanted, and then tune it down using the loop tune 
parameter. But you see, this complicates things, as now not only you have to find the right loop points, 
but also set another parameter correct the pitch.

Keymap does all this (loop search and re-tuning) for you, with a single key command. 

Keymap single cycle loop functions have been designed to work on harmonic samples, and will not work 
correctly with other kinds of material.
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Autolooping a single cycle
Creating a single cycle loop in a harmonic sample is as simple as placing the sample cursor in the sample 
editor, and using the Samples > Loop > Autoloop Single Cycle menu function. A loop of the proper 
length will be created, with the loop start aligned to a positive-phase zero crossing, and the loop tuning 
parameter set at the proper value in order to have a perfect pitch.

Just place the cursor at a sample position, 
and then use the 

Samples>Loop>Autoloop Single Cycle
 menu function

Keymap will create a single cycle loop, and 
tune it to get perfect pitch

In some cases, you might want to add a small amount loop crossfade in order to smooth the transition.

Autotuning a near-cycle  to match the right pitch
Near-cycle loops are intended for loops less than two waveform cycles long. These short loops are an 
authentic gold-mine of sonic potential, but experimenting with them has always been a problem because 
the pitch changes drastically as you change the loop length. Keymap offers an autotuning function that 
automatically does that for you with harmonic samples.

 

Auto tune short loop
checkbox

Just enable the Autotune cycles checkbox and your short loops will be re-tuned.
If you edit the loop points while playing the sample, you will hear how the pitch will remain stable, but 
the spectral shape of the sound will smoothly change.

When experimenting with near-cycle loops, we recommend using loop crossfades in order to always get a 
smooth loop.
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The Loop editor

The loop editor specializes in displaying the loop at its most important point: the join point. The loop 
editor is indeed always centered on the loop join point, with the waveform on its left being the one at the 
end of the loop, and the waveform on its right the one at the beginning of the loop.  

Loop editor: relationships with the sample view

A

A

B

B

Loop 
join

The waveform inside the 
loop segment is drawn in 

blue in the loop editor

The waveform outside the 
loop segment is drawn in 

gray in the loop editor

The waveform outside the 
loop segment is drawn in 

gray in the loop editor

Loop startLoop end

The loop editor always shows two overlapped waveforms: the one around the loop start, and the one 
around the loop end. The waveform sections inside the loop are drawn in blue, while the audio not in the 
loop is drawn in gray.

The underlying concept is that the audio around the end of the loop should ideally be very similar to the 
audio around the start of the loop. When this happens, you won’t hear glitches when the loop wraps back 
to the start. Whenever you change the loop points in the sample editor, the loop editor will show you the 
situation at the join points.
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TruView display mode
The loop editor also can switch to  TruView display mode, and in this mode will effectively display the 
resulting waveform after adding a crossfade to the loop.

Changing the Horizontal and Vertical zoom using the sliders
You can change the zoom levels for the loop editor by moving the respective faders on the bottom and 
on the right of the loop editor.

Changing the Horizontal zoom using the Mighty Mouse trackball
You can change the horizontal zoom level for the loop editor by rotating the Mighty Mouse trackball  
forward and backward.

Changing the loop start and loop end with the loop editor
The loop start position can be modified from the loop editor, by clicking over the right half of the view 
and dragging the waveform. As you can see in the sample view and in the sample inspector, this is 
equivalent to setting the loop start, with the added benefit that you can interactively see how the 
waveforms overlap. The loop end point is similarly edited by dragging the waveform in the left half of the 
view.

Loop editor: edit loop points by shifting waveforms one on the other

Click and drag the waveform at loop startClick and drag the waveform at loop end
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Chapter 18: Slices
The virtual sample is built out of slices
We previously made an analogy between the sample editor in Keymap and the arrange window in Logic, 
as they both are non destructive respect to sample files. Well, continuing in that analogy,  exactly as Logic 
has audio Regions in a track, Keymap has slices in a virtual sample. This analogy should give you a good 
idea of what you can do. Some things are a bit different, and for example all slices in a virtual samples 
must always be tied one to the other, with no “empty space” allowed in between. 

Looking at slices
Slices are normally not shown in the sample view. By clicking on the Slice button, however, you enable the 
slice view mode and can see the slice borders as light gray vertical lines. Each segment subdivided by 
slice borders is a slice.

Slices are always segments from the same sample (you can’t copy and paste across different samples), 
placed one tied to the other, as shown in the following illustration.

Slices

1 3

Playback direction

2

Slice 1 Slice 2 Slice 3

Slice borders
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Cut and paste using slices
Once you enable the slice view mode, and you copy, cut or paste inside a virtual sample, you will notice 
how slice borders will appear around copied or cut segments. This is consistent with the “audio Regions in 
a Logic track” analogy we made earlier.

The continuous slice crossfade mechanism
Each slice in Keymap has an independent volume and is always smoothly crossfaded with the next slice 
via a selection of several crossfade shapes and variable crossfade length. This continuous crossfade 
system is totally non destructive, and performed in realtime. As slice crossfades are always computed 
before looping (and loop crossfade) in the Keymap audio chain, the two crossfades do not interfere. 

The reason for having slice crossfades is that you can do a lot of interesting edits if you do not have to 
worry about clicks at slice boundaries.

The slice inspector
All the slice parameters can be set in the slice inspector, under the sample view, as shown in the following 
illustrations. The slice inspector always shows the parameter values for the currently selected slice. 

The slice inspector

Available parameters are the Slice XFade In and Slice XFade Out, which set the length of the crossfade 
segments at beginning and at end of the currently selected slice. You can also select the respective fade 
shapes to linear, eqpower or s-shape using the pop-up menus on their right.

The Slice Volume changes the volume for the selected slice, and is visualized in the sample editor as a 
colored bar imposed on the slice. The Slice XF Factor parameter is global to all slices in the virtual sample, 
and is an overall crossfade length factor, so that you can tweak crossfades in the whole sample with one 
single edit. 

Using the TruView mode with slices
We recommend using the Truview display mode when editing slices, so you will be able to see in realtime 
the actual results of your edits.

Page 218 



How to select a slice 
In each virtual sample, there can only be one selected slice at a time. You select a slice by holding the 
Option key and clicking with the mouse over it in the sample view. If you enabled the slice view mode, 
the selected slice will be highlighted in light red color.

How to slice/split a sample
Slicing a sample is done by splitting an existing slice at the desired position, and it’s very simple: just place 
the sample cursor at the desired split position and use the Samples > Slices > Slice split at cursor 
position  menu command ( Y key command). A split line will appear.

Slicing a sample at regular positions
Sometimes you may want to slice the sample at regular intervals. You can do that by selecting a portion of 
the sample, and using the Samples > Slices > Slice selection at regular positions menu command.

You will be asked to enter a size in samples, and then Keymap will split the selection in slices of the 
requested size.

Slicing the loop at regular positions
Similarly, you may want to slice the loop at regular intervals. The Samples > Slices > Slice loop at regular 
positions menu command does exactly that.
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Slicing the selection at transients
As we’ll later see, slicing the sample at transients lends itself to many interesting creative possibilities. The 
slicing is done by first selecting a segment of the sample, and then using the Samples > Slices > Slice 
selection at transients menu command, as shown in the following illustration.

Slicing the sample selection at transients

Select a segment of the sample
and use the 

Samples>Slices>Slice selection at 
transients  

menu function

The transients sheet opens

You are now able to tweak parameters 
watching the detected transients

Once you are happy with the detected 
transient points, click "OK" on the 

transients panel and the new slices 
will be created

Slicing the loop at transients
The same process we have just seen can also be performed directly on the loop segment, using the 
Samples > Slices > Slice loop at transients menu command.

Slicing the loop in a musical number of slices
Keymap also lets you slice the loop into a specific number of slices. The Samples > Slices > Split loop in 4 
menu command will slice the loop in four regular segments. Other similar menus let you slice the loop in 
6, 8, 12,16,24 and 32 regular segments. These functions are very useful as a basis for the Loop Remix 
functions we’ll see later.
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Removing all slices 
From time to time you might want to reset all slices and edits and start from scratch again. The Samples > 
Slices > Restore to unsliced menu command removes all slices and restores the virtual sample to a copy 
of the real sample file on disk.

Manual slice editing: drag-shifting the slice content
The sample view lets you manually edit slices in many interesting ways. The content of a slice can be 
shifted by pressing and holding the Command key and dragging the content of the slice with the 
mouse. The slice borders and position will not change, but the audio content in the slice will shift. Of 
course, for this to be possible, the slice must have some extra audio material at the left or right of the 
currently displayed segment (for example: you can’t shift a single slice as long as a sample file). The total 
length of the sample is not affected by this edit.

Manual slice editing: drag-shifting the slice borders
If you press and hold the Option+Command key modifiers, you will be able to click and drag the slice 
borders, without changing the position of the played audio for that slice. In other words, you are really 
shifting the boundaries. The total length of the sample is not affected by this edit.

Swapping the audio content of two adjacent slices
You can swap the audio content of the selected slice with the content of an adjacent slice by using the 
Samples > Slices > Swap slice content from left or Samples > Slices > Swap slice content from right 
menu functions. The swap will occur only if both slices length can be expanded or reduced to fit the 
other’s length.

Swap remix beat functions
Once the loop has been split in a number of slices, you can randomly swap certain relative “beat” positions 
of these loop slices. The available slice remix functions found in the Samples > Slices > Swap remix….  
menus, let you remix the 1st beat, the 2nd beat, the 3rd beat or the 4th beat, all the beats indifferently, or 
just the selected slice in the loop.

Divide a slice exactly in two
The Samples > Slices > Slice divide in half menu command splits the selected slice exactly in the middle. 
This is useful, as example,  if you have a loop divided in fourths, but need also some 8ths.
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Divide a slice exactly in two with stuttering
The Samples > Slices > Slice stutter menu command splits the selected slice exactly in the middle.  
However the 2nd slice will also be shifted so to be an exact repetition of the 1st one. This command is 
useful for stuttering effects, but also for other creative edits.  

Duplicate a slice
The Samples > Slices > Slice insert duplicate menu command adds a copy of the selected slice next to it. 
This function increases the total sample length.

Remove a slice
Sometimes you might want to delete a slice without affecting the total sample length. The Samples > 
Slices > Slice remove menu command first deletes the selected slice, then fills the empty space with the 
tail of the preceding slice. 

Delete a slice
You delete a slice by first selecting it and then using the Samples > Slices > Slice delete menu command. 
The total length of the sample will decrease of the length of the deleted slice.

Creating Zones from slices
Once you have created some slices, you might want to map those slices into the instrument as individual 
Zones. The Samples > Slices > Map slices under selection to layer menu command does exactly that by 
creating new Zones, each playing a slice. As Keymap does not allow you to select multiple slices, you 
select the slices to be mapped using the normal sample selection system. Only slices completely covered 
by the sample selection will be mapped to the layer. Also, for this function to work, the sample you are 
slicing must have been opened from the Instrument editor. The new Zones will be created sequentially on 
the notes at right of the  Zone containing the sample.

Creating Zones from sliced loop
The Samples > Slices > Map loop slices to layer is very similar to the above function, with the difference 
that you do not have to make a selection. The new Zones will be generated from the slices created in the 
loop. 
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Chapter 19: Mapping functions
The overall goal of Keymap it to let you create instruments out of samples. If your samples each contain a 
single sound, then you can create Zones by dragging those samples directly to the Layer matrix. When 
instead a single sample contains multiple audio segments, each representing a different note, or a 
different sound/loop, then you need a way to map each of these segments into Zones. Keymap offers 
several automated ways to do this, but it also lets you do it manually through a series of mapping 
functions. All these functions requires that you have at least one Instrument editor open, with a layer 
selected. The nine mapping functions are combinations of three possible ways to define a segment, and 
three ways to map that segment into a layer. The new Zones will be created in the selected layer in the 
Instrument editor. That layer is called the current layer. Each of the created Zones is one note wide: you 
can later fill the empty areas of the matrix using the Expand remapping function.

Mapping the start-to-end sample segment
Creating a new Zone from the start-to-end segment, placed sequentially in the layer
The Samples > Map > Map sample sequentially to current Layer menu function creates a new Zone 
from the start-to-end sample segment. The Zone and its root note are mapped sequentially over the 
matrix.

Creating a new Zone from the start-to-end segment, placed in the layer through MIDI Keyboard
The Samples > Map > Map sample with MIDI Learn to current Layer menu function creates a new Zone 
from the start-to-end sample segment. Immediately after selecting this menu, you are asked to press a 
note on your MIDI Keyboard to choose which note the Zone will be mapped to.

Mapping using the MIDI Keyboard  
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The Zone root note is set to that note too.
Creating a new Zone from the start-to-end segment, placed in the layer using pitch detection
The Samples > Map > Map sample with pitch detection to current Layer menu function creates a new 
Zone from the start-to-end sample segment. The segment will be analyzed for pitch, and the Zone and its 
root note set at the detected note.

Mapping the loop segment
These functions require a loop to be defined  and enabled

Creating a new Zone from the loop segment, placed sequentially in the layer
The Samples > Map > Map loop sequentially to current Layer menu function creates a new Zone from 
the loop sample segment. The Zone and its root note are mapped sequentially over the matrix.

Creating a new Zone from the loop segment, placed in the layer through MIDI Keyboard
The Samples > Map > Map loop with MIDI Learn to current Layer menu function creates a new Zone 
from the loop sample segment. Immediately after selecting this menu, you are asked to press a note on 
your MIDI Keyboard to choose which note the Zone will be mapped to. The Zone root note is set to that 
note too.

Creating a new Zone from the loop segment, placed in the layer using pitch detection
The Samples > Map > Map loop with pitch detection to current Layer menu function creates a new 
Zone from the loop sample segment. The segment will be analyzed for pitch, and the Zone and its root 
note set at the detected note.

Mapping the selection
These functions require a selection to be defined

Creating a new Zone from the current selection, placed sequentially in the layer
The Samples > Map > Map selection sequentially to current Layer menu function creates a new Zone 
from the current sample selection. The Zone and its root note are mapped sequentially over the matrix.

Creating a new Zone from the current selection, placed in the layer through MIDI Keyboard
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The Samples > Map > Map selection with MIDI Learn to current Layer menu function creates a new 
Zone from the current sample selection. Immediately after selecting this menu, you are asked to press a 
note on your MIDI Keyboard to choose which note the Zone will be mapped to. The Zone root note is set 
to that note too.

Creating a new Zone from the current selection, placed in the layer using pitch detection
The Samples > Map > Map loop with pitch detection to current Layer menu function creates a new 
Zone from the current sample selection. The selection will be analyzed for pitch, and the Zone and its root 
note set at the detected note.
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Loop remix
Using slices, the continuous crossfade system and a few selected key commands, you can easily take an 
existing rhythmic loop and create dozens of variations out of it. We call this “Loop remix”. The trick is to 
subdivide your aligned rhythmic loop in a “musical” number of slices. As example, in a 2 bar 4/4 loop, we 
could use 8 slices, so that each slice is a single beat. By swapping individual slices you can recombine the 
loop in many different variations, which you can then map to keyboard with just a key command. Imagine 
doing all this while the loop is playing in realtime!

Loop remix how-to

!
Shift slice 

content from 
left

"
Shift slice 

content from 
right

#
Select slice at 

right

$
Select slice at 

left
control

shift

Play the loop, select one slice with option+click, then
holding shift+control pressed, use the cursor keys to 
navigate and remix slices

Every time you like the loop, press Q 
(Samples>Map>Map loop sequentially to layer) 
and you will map it as a new zone

Activate slice view mode
Then split your loop in 8 or 16 slices using the Samples>Slices>Slice loop in 8 (or 16) menu

Tip: slice crossfade/volume parameters let you smooth or enhance specific beats, you can alter 
timing by shifting  the slice content, you can add extra slices or tweak slices borders. 
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Chapter 20: Automap
Keymap lets you automate the split-and-map process from the sample editor with the automap functions.

Autosplitting and Automapping a sample sequentially
If you select the desired section of the sample which contains all the sounds you want to map to Zones, 
and use the Samples > Automap > Autosplit and Automap selection sequentially to new layer menu 
function, Keymap will split the selection in the individual segments, trim them according to your trim 
level preferences, and will create Zones sequentially in a new layer. The resulting Zones are also 
autolooped.

Autosplitting and Automapping a sample using pitch detection
The  Samples > Automap > Autosplit and Automap selection by pitch to new layer menu function 
works similarly to the previous function, but will use pitch detection to map Zones to the appropriate 
notes. The resulting Zones are also autolooped.

Automapping magic

Select the whole sample and 
use the 

Samples>Automap>Autosplit 
and Automap selection to 
new layer menu function

The individual segments are 
automatically split and 

trimmed, then automapped 
using pitch detection, and 

autolooped

Create multi-velocity Zones for a single note, from selection
With this function you select a section of your sample recording containing an arbitrary  number of 
sounds sampled at different velocities (for example a snare, or a guitar, or a piano), then use the Samples 
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> Automap > Autosplit and Automap to a single as multivelocity menu function to split automatically 
those sounds and create the respective Zones into the layer, at the same single note. The Zones are 
mapped over the velocity axis  based on their relative volume.

Zone from Hit #5

Zone from Hit #4

Zone from Hit #3

Zone from Hit #2

Zone from Hit #1

Select the whole sample and then
Samples>Automap>Autosplit and Automap to a single 

note as multivelocity 

Hit
#1

Hit
#2

Hit
#3

Hit
#4

Hit
#5

Five new zones are automatically created in the 
current layer, each referencing the 

corresponding hit, sorted by volume 

Note: each split segment is automatically trimmed using the trim level preferences. If you do not 
get the expected results, you might have set those values too high or too low.
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Chapter 21: Autophase
You often might want to set the sample start, the sample end, or the loop points to a positive phase zero-
crossing transition. The autophase family of functions searches for the nearest zero-crossing transition 
and set parameters to that position.

What is a positive phase zero-crossing transition?
The audio signal is physically emitted from your audio outputs as a voltage fluctuating cyclically from 
positive values to negative values and then back to positive values.  A zero-crossing transition is when the 
audio voltage crosses the zero voltage level. The waveform represents this continuous voltage change by 
drawing its level over time, around a “Zero level” line.

Positive and negative phase zero-crossing transition

Positive phase 
zero-crossing 

transition

Zero 

Negative phase 
zero-crossing 

transition

As you see, you can have two types of zero-crossings: when the wave level decreases and goes from 
positive to negative, and it’s called negative phase, or when the wave level increases and goes from 
negative to positive, and it’s called positive phase.

Autophasing the start position
The Samples > Autophase > Sample Start menu command sets the sample start to the nearest positive 
phase zero crossing.

Autophasing the end position
The Samples > Autophase > Sample End menu command sets the sample end to the nearest positive 
phase zero crossing.
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Autophasing the loop start position
The Samples > Autophase > Loop start menu command sets the loop start to the nearest positive phase 
zero crossing. The loop end position is changed too, so that the loop length doesn’t change.

Autophasing the loop end position
The Samples > Autophase > Loop end menu command sets the loop end to the nearest positive phase 
zero crossing. The loop start position is not changed, and so that the loop length will change.
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Chapter 22: Harmonic Resynthesis in the 
sample editor 
Each virtual sample can be controlled by a relative set of parameters and envelopes, and has it’s own 
independent Harmonic Resynthesis engine. If the sample has been already mapped to a Zone, the HR 
setting of the Zone and of its sample are coincident (i.e. it’s a single set). With Harmonic Resynthesis you 
can reshape harmonic samples over four important properties: pitch, formant, time and amplitude. By 
default, Harmonic Resynthesis is not active until you explicitly enable it.  HR is a resynthesis method, and 
not a pitchshift or timestretch function, and it will work correctly only with single pitch harmonic samples, 
with the exception of HR Amplitude, which can be applied to any kind of sample.

HR Envelopes and parameters are combined into the resynthesis envelope
The first time that Harmonic Resynthesis is enabled for a sample, it makes an analysis of the sound. This 
operation might take a few seconds or more depending on the complexity, the length and the format of 
the sample. The resulting envelopes (one for each property) can at this point be manually edited using 
several available tools. Keymap then combines these envelopes with a series of HR parameters, and as a 
result creates a new envelope called the resynthesis envelope, which ultimately is used by Keymap as the 
basis for re-creating the desired sound.

Combining HR Envelopes and HR Parameters

Editable HR 
Envelope 

from sample 
analysis

Reynthesis 
envelope

Combiner

HR 
Parameters

(pitch correct,
decay freeze, 

etc)

To resynthesis
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How HR Envelopes are displayed
All of the HR envelopes are displayed as envelopes overlaid to the sample waveform. There is a single 
envelope for each sonic property regardless of the number of audio channels in the sample. While the 
envelope and the sample share the use of the horizontal axis for sample position, the vertical axis 
representation changes depending on the type of HR Envelope, as shown in the following illustration.

HR Pitch envelope

Sample position

Pitch 
deviation 

respect
to root note

perfect tuning

Perfect tuning

HR Formant envelope

Sample position

Formant 
deviation 
respect to 

natural

Natural formant

HR Time envelope

Sample position

Time 
deviation 
respect to 

natural

Natural time

Faster

Slower

HR Amp envelope

Sample position

RMS 
Volume

Higher 
pitch

Lower 
pitch

Higher 
formant

Lower 
formant

High 
volume

Low 
volume
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How HR Envelopes are edited
Keymap provides a number of tools for editing the HR Envelopes. The tools are selected from the HR tools 

section in the sample editor, and are used by holding the Shift key while clicking and dragging 
the mouse in the sample view over the envelope. For the tools to become selectable, you must 
first select which HR envelope you want to edit. As soon as you select one envelope, this will 
become highlighted in red color.

Draw tool
The draw tool let you directly draw the envelope. As simple as that!

Smear tool
The smear tool smoothly bends the envelope in the vertical direction. The bend speed is proportional to 
the distance of the mouse cursor from the mid of the sample view. This tool is very useful for editing/ 
warping the envelope, maintaining its natural characteristics (as opposed to drawing).

Smear tool action in the sample view

Center

Smear down slowly

Smear up slowly

Smear down quickly

Smear up quickly

Reduce/Expand tool
The smear tool smoothly reduces or expands the envelope in the vertical direction with respect to its 
neutral value (usually the center position).  The speed of the action is proportional to the distance of the 
mouse cursor from the mid of the sample view. This tool is very useful for reducing or enhancing pitch 
vibratos manually.

Reset tool
The reset tool, when applied,  smoothly and progressively restores the envelope to it’s original shape. It’s 
useful when you draw things manually, and you want to impart a little bit of natural feeling, or when you 
want to smoothly add the natural vibrato from a hand-drawn pitch correction.
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Harmonic Resynthesis algorithms
Keymap offers two alternative Harmonic Resynthesis algorithms: HR-A and HR-B.
HR-A allows manipulation of pitch, formant, time and amplitude. HR-B allows manipulation of pitch, time 
and amplitude (you lose formant control), but HR-B sounds better with complex, high pitched harmonic 
sounds and for polyphonation in the Instrument editor. For maximum flexibility, the algorithm can be 
selected individually sample by sample, Zone by Zone.

How to set the Harmonic Resynthesis algorithm
You can change the Harmonic Resynthesis algorithm by setting the HR Algorithm pop-up menu in the HR 
Pitch/Formant inspector, as shown here:

Setting the HR Algorithm

Note that changing the algorithm by itself doesn’t mean that HR will be turned on for the sample.

How to enable Harmonic Resynthesis for the sample
You can enable the Harmonic Resynthesis engine for the sample by enabling at least one of the four 
master HR enable checkboxes, available both from the edit mode selection and in the various HR 
inspectors.

Enabling HR in multiple ways

HR Enable for the 
various sonic 

properties
(checkbox repeated 

for convenience near 
the edit mode 

switches)

HR Enable for the 
various sonic 

properties
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The first time that Harmonic Resynthesis is enabled for a sample, an analysis of the sound will be made, 
and this operation might take a few seconds or more depending on the complexity, length, and the 
format of the sample.

Harmonic Resynthesis and loops
As Harmonic Resynthesis creates a new sound using the original sample only as basis, and as looping is 
performed in the audio chain after the HR Engine, you might need to tweak your loop points, or apply 
some crossfade after editing the HR Parameters.  

Saving to EXS24
As the Harmonic Resynthesis features are not directly supported by the EXS24,  the sample needs to be 
rendered when saving the project to EXS24 format. The rendered sample is a normal sample file, 
containing the re-synthesized sample. We recommend keeping a Keymap format copy around before 
saving to EXS24 format so that you can go back and adjust the HR settings.
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The  HR Pitch envelope
If you enable the Harmonic Resynthesis Pitch enable checkbox, you will see the pitch envelope 
displayed as a thin line in orange in the auxiliary sample editor. That envelope represents the resynthesis 
envelope that will be used by Keymap to reconstruct the sound.

Immediately after analysis,  the envelope is a precise representation of the detected sample pitch at any 
point. Notice how the envelope is represented as a deviation from the detected fundamental note pitch, 
which is in turn always represented as a horizontal line in the center of the sample editor, regardless of the 
fundamental pitch value, or the fact that the sample is mono or stereo.
 

The HR Pitch envelope

Lower pitch 

Higher pitch 

Fundamental pitch

+50 c
+25 c

0 
-25 c
-50 c

HR Pitch envelope ruler
At the left of the sample editor you can see the HR Pitch ruler values, displaying the deviation from the 
fundamental in cents.  

HR Pitch envelope zoom
The HR Zoom slider, at the right of the sample view, changes the zoom factor used for displaying the HR 

ruler and  envelope. If you have a mighty mouse, you can press and hold the Option 
key and spin the mouse trackball vertically to change the vertical HR Pitch zoom 
factor. 
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Harmonic Resynthesis parameters for Pitch 
Each Zone has three pitch parameters for transforming the HR pitch envelope. These parameters deal 
with pitch transposition  and pitch correction.

HR Pitch parameters

HR Pitch Transpose lets you change the pitch of the sample in semitone steps. The major difference 
between this parameter and the normal Tune Zone parameter is that HR Pitch transpose doesn’t modify 
the original sample playback length, while the Tune parameter will instead change the playback 
resampling rate and higher pitches will result in shorter playback times as shown in the following 
illustration. 

PLAYBACK TIME

Sample playing with Tune at -8 semitones

Sample playing with Tune at +0 semitones

Sample playing with Tune at +8 semitones

PLAYBACK TIME

Sample playing with HR Pitch at -8 semitones

Sample playing with HR Pitch at +0 semitones

Sample playing with HR Pitch at +8 semitones

With traditional resampling

With HR Pitch transposition

The HR Pitch Transpose parameter is used by Keymap as the basis for the Zone polyphonate function.
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HR Pitch correction
The HR Pitch Correction adjust parameter lets you correct the pitch envelope, by gently warping  it 
toward the fundamental pitch by the desired amount. This parameter is expressed as percentage of the 
analyzed deviation, in which 100% represents the original untouched envelope and 0% represents full 
correction. You can also reinforce the pitch deviation from the fundamental by using values greater than 
100%. In this case, the pitch deviation will be accentuated. 

You can enable and disable pitch correction by using the checkbox near the pitch correction slider.  When 
you edit and release the pitch correction slider, the pitch envelope will be updated to reflect the changes 
you made, as shown in this illustration:

HR Pitch correction

100%

50%

25%

0%

Note: some amount of pitch correction is very useful when building sampled acoustic instruments 
especially considering how it’s often difficult to sample some of them at perfect pitch. When playing 
a solo part  a slight de-tuning might sound very human and wonderful, but if you play multiple  
instruments you definitely want them in tune.
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The HR Pitch Offset adjust parameter lets you add an offset to a pitch.  This is useful when you have an 
out of tune vibrato, and you do not want to change the vibrato, but just center it onto the fundamental, as 
seen in the following illustration:

HR Pitch offset

0 cents

25 cents

You can enable and disable HR Pitch shaping using the Harmonic Resynthesis Pitch enable checkbox.
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Harmonic Resynthesis formant control
The HR-A algorithm of the Harmonic Resynthesis engine can be used to modify the formant of the played 
sample. This lets you change the spectral distribution of the sound without changing the pitch, and is 
useful if you want to create subtle variation of the same sample, or you just want to simulate a larger or 
smaller resonant body for a sampled acoustic instrument.

HR Formant parameter

 The HR Formant adjust parameter let you  modify the formant of the sample. A value of 1.0 means no 
formant change, while a value of 0.5 means that the formant will be shifted toward high frequencies, and 
2.0 means that the formant is shifted toward the low frequencies.

You can enable and disable HR Formant shaping for the sample using the Harmonic Resynthesis 
Formant enable checkbox.
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Harmonic Resynthesis time control
How many times have you wished you could have fine control over the timing of your sampled 
instrument? The Harmonic Resynthesis engine allows you to control the playback timing, so that you can 
easily slow down playback at some points or accelerate it in others. In other words you get continuous 
control of the timing aspects of your harmonic sample through the HR Time envelope. 

Perceived time vs displayed time
Keymap displays timing changes as a time envelope overlaid on the sample, but you will not see a change 
in the length of the displayed waveform in the sample editor. Instead, you will see the playback cursor 
slowing down or accelerating to reflect the current time envelope value. All sample position parameters 
displayed on screen (start, end , loop points, etc) will not change when you tweak the time envelope, and 
will keep referencing the original sample positions,  but of course the perceived length (i.e. the length of 
the sound you’ll hear) will change. The reason for this is so you can have a continuous time envelope that 
lets you edit and adjust envelopes with precision, without the screen constantly updating.  After the initial 
sample analysis, the time envelope is a flat horizontal line centered over the sample waveform, meaning 
that no timing change occurs.

Harmonic Resynthesis time parameters
You cannot draw the HR Pitch envelope directly in the auxiliary sample editor in the instrument window, 
but two parameters control the sample attack and sample loop segments as defined in the following 
illustration:

Sample Attack
Segment

Sample Loop
Segment

Sample Attack
Segment

When a loop is enabled, 
we have both

 an attack and a loop 
segment

When the loop is 
disabled or not defined, 

we have only
 an attack segment
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Note that when a loop is not defined, or disabled, there is no sample loop segment and so the whole 
sample is considered to be part of the sample attack segment. 

The HR time parameters are found in the HR Time inspector. 

HR Time parameters

The HR Attack Time Adjust lets you change the perceived length of the attack phase. The parameter is 
expressed as a percentage of the displayed length with a range of 50% (half of the original length) to 
200% (double of the original length).

Similarly, you can change the perceived loop length using HR Loop Time Adjust. The parameter is 
expressed as a percentage of the displayed length with a range of 50% (half of the original loop length) to 
200% (double of the original loop length).

The Also use drawn envelope checkboxes let you enable/disable the hand-drawn envelopes you might 
have created in the sample view.

You can enable and disable HR Time shaping for the sample using the Harmonic Resynthesis Time 
enable checkbox.
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Harmonic Resynthesis amplitude control
The last of the four sonic properties that you can reshape with Harmonic Resynthesis is amplitude. When a 
sample is first analyzed, an amplitude envelope is created, representing the original sample amplitude 
characteristics. The amplitude envelope is displayed as a black line in the sample view, as shown in the 
following illustration.

TruView display mode: visualizing HR Amp processing
When editing the HR Amp envelope or parameters, normally only the HR amp envelope is visually 
modified and the displayed sample waveform still represent the original sample. You can however 
visualize the actual, HR Amp processed, waveform by clicking the TruView button and entering the 
TruView display mode.

With the Tru-view mode 
disabled, the original 
sample waveform is 

displayed

With the Tru-view mode 
enabled, the processed 

sample waveform is 
displayed

Note:  TruView mode also displays the actual results of fade-ins, fade-outs and loop crossfades. In 
Tru-view mode, the audio outside the start and end positions is visualized as silence.

TruView display mode is slower and requires more CPU power than the normal mode, which is why it is 
not enabled by default.

Page 243



HR Amp parameters
The HR Amp  parameters are available from the HR Amp inspector.

HR Amp parameters

How to normalize samples using HR Amplitude
One of the most (over)used functions with regards to samples is normalization. Unfortunately this is 
usually implemented in a destructive way, which means the actual sample files are modified, which is 
difficult to undo. In Keymap, using Harmonic Resynthesis, you can perform this operation non 
destructively in realtime simply by setting the amount of normalization you want to achieve. The HR 
Normalization amount parameter goes from 0% (meaning no amplitude change), to 100% (meaning the 
amplitude is stretched to fully normalize the sample).
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Freezing the decay of a decaying sample
Another huge problem with sampled instruments is that decaying samples often can’t be effectively 
looped, as the energy difference between the loop start and the loop end usually creates a sudden jump 
in the sound at the loop “join” point. In such situations, a loop crossfade will be helpful, but might not 
solve the problem. In Keymap, thanks to Harmonic Resynthesis engine, you can freeze the decay just by 
setting the HR Freeze Decay parameter to the desired decay level expressed in decibel. When the sample 
tail reaches that level, its level will freeze and remain constant until the end of the sample, making looping 
a much simpler task (and there are often hidden sonic gems in those long tails).

The original decaying piano sample

The same piano sample with decay 
freezed at -12dB
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Removing dynamics out of the sample
Another function in Keymap lets you remove a variable amount of the dynamics from a sample so that it 
becomes an uniform sonic blob. The HR Dynamics parameter goes from 0% (no dynamics) to 100% 
(original dynamic). This function can be very interesting with drum loops and with samples of constantly 
varying amplitude. Once sounds have their dynamics removed, you can sculpt them again to your liking 
using the EXS24 envelopes and filters.

The original drum loop

The same drum loop with 
all dynamics removed
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Chapter 23: Regions in the sample editor
Sometimes you might find it useful to have alternate sets of sample parameters for the same sample, or 
perhaps you would like to define audio segments from a sample that you will later map to individual 
Zones. Regions are Keymap elements designed specifically for these tasks. Each Region is basically an 
independent set of the following parameters:
SampleStart
SampleEnd
FadeIn
FadeOut
LoopStart
LoopEnd
LoopXFade
LoopXFadeShape
LoopEnabled 
Regions can be defined manually or by autosplitting samples. 
There are no special limitations to keep in mind with Regions: for each sample an arbitrary number of 
Regions can be created, and they can overlap.  Regions are visualized both in a Region table, and 
graphically in the sample view as colored areas delimited in the ruler by Region cursors.

The region table in the sample editor

Region
table

Open 
region 
table

Regions

Normally a sample has no Regions defined and uses the main set of sample parameters. Once you create 
Regions, you can switch between the main set and each Region set by selecting a Region in the Region 
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table. When one single Region is selected, it will become the active Region, and the sample will play 
according to the active Region. Also, all edits of the Zone parameters listed above will change the Region 
set, and not the main set, which is left untouched. 

Region cursors
Moving the active Region cursors in the sample editor is equivalent to moving the start and end position  
parameters for that Region.

In the sample editor, Unselected Regions are displayed in light grey, while the single selected Region (the 
active Region) is displayed in orange. You can also select multiple Regions: in this case the Zone will 
revert to using the main set, and the selected Regions will be displayed in light orange color.
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How to create a Region manually
Creating a Region is as simple as selecting a portion of the sample in the sample view and using the 
Samples > Regions > New Region from selection command. The newly defined Region will appear in the 
Region table, where you can now select it.
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How to create a Region by autosplitting a sample selection
Keymap can also split the audio segments for you and create the corresponding Regions. Select a section 
of the waveform in the sample editor and use the Regions > New Autosplit Regions from selection 
menu  function as shown in the following illustration:

Autosplitting into regions

Select a section in your sample and use the
 Samples>Regions>New autosplitted regions from selection

 menu function.

The audio segments will be split and new regions created.
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How to create Regions at transients from a sample selection
Keymap can also detect transients in your samples, and create the corresponding Regions. Select a 
section of the waveform in the sample editor and use the Regions > New Regions at transients from 
selection menu function, as illustrated here:

Select the sample and use the 
Samples>Regions>New regions at 

transients  
menu function

The transients sheet opens.You are 
now able to tweak parameters 

watching the detected transients

Once you are happy with the detected 
transient points, click "OK" on the 

transients panel and new regions will 
be created, each spanning from one 

transient position to another 

Region from transients

How to delete Regions
Deleting Regions by selecting them in the Region table and pressing the backspace or delete key on your 
Mac keyboard, or using the Clear menu item.

Page 251



Region functions
Once Regions have been defined and selected, you have a few selected functions you can perform 
directly on them in the Region table. These functions let you copy parameters from/to the main set, 
autoloop Regions, and also map Regions to newly created Zones. 

Note: if you need to use other functions, remember that when you activate one Region you can 
use the full set of Keymap functions with it. 

Copy Region sample parameters to the main set
The Regions > Autoloop > Copy to main set menu function copies the Region parameters to the main 
set.

Copy the main set sample parameters to Regions
The Regions > Autoloop > Copy from main set menu function copies the main set  sample parameters to 
the selected Zones.

Autolooping Regions
Autolooping Regions is as simple as selecting them and using the Regions > Autoloop > Low Resolution  
or Regions > Autoloop > High Resolution commands. For each Region, the best loop will be found and 
set in its loop parameters. The main set is unaffected.
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Automapping Regions
With the Region automapping functions you create new Zones from the selected Regions.  

You have three distinct functions available for this:

Regions > Automap to new layer > Automap with pitch detection will pitch detect each Region and 
create a Zone at the detected note using the Region sample parameters.

Regions > Automap to new layer > Automap sequentially will create Zones sequentially using the 
Region sample  parameters.

Regions > Automap to new layer > Automap multivelocity to single note  will map all Regions to Zones 
on a single note, with Zones sorted along the velocity axis by the volume level of the sample comprised 
between each Region start and end parameters.
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Chapter 24: Setup editor
The setup editor allows you to add and combine multiple instruments in a single Keymap project, and 
edit parameters which are common to the whole project. Each project always contains one single setup,  
and by default each time you create a new project using the File > New menu command, the setup editor 
will open, with the layout and window size as specified in the preferences Editors layout parameter.  The 
setup editor contains a number of elements, as shown below:

Virtual keyboard

Instrument matrix

Setup inspector

Instrument 
inspector

AMP Envelope  
editor

Instrument table

If you close the setup editor, you can re-open it at any time using the Window > Show Setup menu 
command, or its equivalent key command. It is not possible to delete or add a setup.

Creating a new empty instrument in a setup
You can add a new empty instrument to the setup by using the Setup > Add new empty instrument to 
current Setup menu command, or the New context menu command in the instrument table. Once you 
use either command, a new instrument containing one empty layer will be created, added to the setup, 
and appears in the instrument table.

Adding an existing EXS instrument to a setup
You can add an existing EXS instrument to your setup by dragging and dropping the EXS instruments 
from the finder directly into the instrument matrix. Another way is through the File > Add Instruments to 
current project  or Setup > Add Instruments into selected Setup menu functions. In this latter case,  you 
will be asked through a panel to select the instrument to add. If you enable the Also import synthesis 
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parameters in the panel, you will also  import synthesis parameters from the instrument, overwriting the 
current ones. 

 
The synthesis parameters are never imported when you drag and drop the instrument into the editor.
Note that you can only add instruments in EXS format to a setup. It is not currently possible to do this for 
with Keymap (KMP) format files.

IMPORTANT: do not confuse the Add Instruments function with the File > Open  menu command. 
The File > Open command  actually opens a new project, with its own setup. This is completely 
different than adding instruments to an existing project/setup.

Opening the Instrument editor for an instrument
If you want to open the Instrument editor for a certain instrument, double click it in the instrument table, 
or select it and use the Window > Show instrument menu command.

Enabling/disabling instruments
Each instrument can be disabled by unchecking the On checkbox in the instrument table. Once disabled, 
the instrument will stop responding to MIDI/Virtual keyboard events.

Implications of a disabled instrument when saving the project in EXS format
As the EXS format doesn’t directly support setups, and you can’t really save “disabled” sections of your 
project, disabled instruments and their relative Zones and Groups will not be saved in EXS format at all.

Tip: this feature let you handle easily situations where you have a complex Keymap project and 
want to save individual instruments to individual EXS files, as you just have to enable the wanted 
instruments,save to EXS, then go back, enable some other instruments and save again, etc.

How to avoid opening the setup window when creating new instruments or opening projects
There might be times where your focus is on a single instrument, and you are not interested in the setup 
environment at all.  In this case  you can keep the setup editor from automatically opening by unchecking 
the Open setup editor when creating new projects  checkbox in the preferences panel.
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The setup is still being created, and you can open the setup editor at anytime using the Windows > Show 
Setup editor menu or its equivalent key command.

Instrument matrix

The main component of the setup window is the Instrument matrix. Similarly to the Layer matrix, the 
instrument matrix represents the note range horizontally, and the velocity range vertically. An instrument 
is represented by a blue rectangle displayed over its note and velocity map area, and will only play if the 
incoming MIDI note and velocity intersect the instrument rectangle.  This is displayed as red dots, 
representing played notes, over the matrix so that you can easily see which instrument is being played at 
any moment, and in which matrix position.

Differently than in the Layer matrix, in the instrument matrix the elements (the instruments) can overlap 
at will, and graphical editing with the mouse is allowed only when a single instrument is selected.

Selecting an instrument from the instrument table
Instruments can be selected directly in the instrument table. You can select multiple instruments at once, 
which is very useful for editing multiple instruments at the same time in the instrument inspector.  
However to edit a single instrument in the Instrument matrix you need to select it in the instrument 
inspector. When you select a single instrument, it will be shown in the matrix with its individual color, as 
set in the instrument inspector.

Selecting an instrument from the layer matrix
Alternatively, you can select an instrument from the instrument matrix by clicking it. If there are 
ambiguities, i.e. if more than one instrument is under the mouse cursor when you click, no instrument will 
be selected directly. You can however get to select the desired instrument by pressing and holding the 
Shift key and clicking repeatedly with the mouse: the selection will cycle among the instruments under 
the mouse cursor, and you can stop when you are satisfied with the selected instrument.
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Editing the instrument in the matrix
You can graphically edit an instrument mapping by dragging one of its four borders, or the center of the 
rectangle. Corners are not active. As you will notice the note and velocity ranges parameter for that 
instrument in the inspector will update accordingly. There is no particular limitation regarding the 
placement of instruments, and they can overlap so to play together at the same time.
Note that resizing or moving the instrument note and velocity range will only change which part of the 
instrument is exposed in the setup (and to incoming MIDI Events), but doesn’t actually move the 
instrument content across the instrument matrix.

The parameters responsible for moving (shifting) the actual content, and not just the exposed part of the 
instruments, are the transpose and the velocity offset parameters, and they are respectively responsible 
for shifting across notes, and velocity. 

If you press and hold the Option key while moving an instrument (not just the borders!) with the mouse, 
the transpose parameter will be automatically updated so that the net combined effect is that you  are 
moving the current content of the instrument across the setup. Note that the velocity offset value is not 
modified by this key modifier, as for most purposes you will not want to do that.

Renaming an instrument
You can rename an instrument by directly editing the instrument name above the instrument table.

Duplicating an instrument
You can duplicate an instrument by first selecting it, and then using the Duplicate menu function in the 
context instrument table menu.

IMPORTANT: when you duplicate an instrument, you are at all 
effects creating a separate, independent copy of the instrument and 
of all its elements (layers, Zones, virtual samples, Groups). If you edit a 
Zone in one of the instruments, you will not affect its duplicate.
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Deleting an instrument
You can delete an instrument by selecting it, and the using the Delete command in the context 
instrument table menu. All layers, Zones, virtual samples and Groups in that instrument will be deleted 
from memory as well, but nothing will be done to sample files, or EXS instrument files you have 
imported from disk. In other words, this function is merely deleting the data structures in memory.

Instrument inspector
At the right of the instrument matrix you see the instruments inspector. Here you can view and edit 
instrument level parameters in an analytical way. 
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HighNote, LowNote, HighVel, LowVel
These four parameters define the area of the instrument in the setup; in other words, they determine the 
ranges for which the instrument will be played.

Volume and Pan
You can change volume and pan for each instrument independently, which makes it easy to balance 
volume for the individual sounds in splits or stacks. These values are composited with all the others in the 
audio chain in order to define the real final volume of the sound.

Color
Assigning a color will make each instrument stand out with respect to the others when selected. When 
when editing overlapped instruments, assigning a color helps you identify the instrument you are editing.

Transpose and Velocity offset
These two parameters are very important as they allow you to shift the instrument content respectively 
along the note and velocity offsets, within the note and velocity ranges defined by HighNote, LowNote, 
HighVel,LowVel.

The Instrument table
The instrument table lets you enable or disable instruments and through its context menu you can create 
new empty instruments, delete an instrument from the setup, or duplicate an existing instrument. 
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Setup inspector
The setup inspector lets you change project-wide parameters which affect all instruments. For 
convenience, most of these parameters are also shown, and editable, in the Instrument editor.  A few 
parameters, like the dynamic-crossfade-related parameters, are actually more relevant in the Instrument 
editor than here.

Sample selection and 
dynamic crossfade

Amplitude envelope

Volume, dynamic 
ranges and tuning

Vel mapped using
This pop-up menu lets you substitute the normal note velocity with the value of a MIDI Controller. Once 
set to a MIDI Controller different than “Velocity”, each time Keymap (and the EXS24) receives a note-on 
message, it will get the “velocity” value not from the velocity of the note, but from the current value of the 
selected controller. Selecting a controller different than Velocity enables the Dynamic crossfade mode, 
and disables all defined Static crossfades for all instruments in the setup.

XFade
This value determines the size of the extended velocity area used for dynamic crossfades in Zones and 
Groups. If you set it to a value different than zero, the Dynamic crossfade mode will be enabled, and any 
Static crossfade in all instruments in the setup will be disabled.

XFade Shape
This pop-up menu let you select the volume shape to be used in the dynamic crossfades areas.
Possible values are:

DbLinear : the volume, expressed as decibel, will linearly fade to/from zero
Linear  : the volume will linearly fade to/from zero 
EqlPower : the volume will fade to/from zero using an equal power shape
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Slow Attack, Fast Attack, Decay, Sustain, Release
These parameters control the shape of the AMP Envelope.

AttShape
This parameter controls the shape of the attack phase in the AMP Envelope, as shown in the following 
illustration:

AMP Envelope AttShape parameter

RelScale
This parameter changes the release time for the AMP Envelope depending on the position of the played 
note with respect to MIDI note 60. When edited, the envelope editor will briefly show the factors that will 
be used for the release time across the whole note range, as shown in the following illustration:

AMP Envelope RelScale parameter
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Volume Scale
This parameter lets you scale the volume across the keyboard, respect to note 60, and is measured in 
decibels per octave. Positive values will lead to higher volume on high notes, while negative values will do 
the opposite.

Volume
This is the general volume control for the whole setup.

Tip: if you just want to change the monitoring level, you can use Keymap built-in independent 
monitoring volume, assigned by default to the F1 and F2 keys on your Mac keyboard. This volume 
controls the volume on all Keymap audio outs, and doesn’t change the volume for other audio 
applications that might be running at the same time.

Global tune, Fine tune
These two parameters control the tuning of the whole setup.
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Dynamic Range High, Dynamic Range Low
These two parameters controls the dynamic range for played notes, over the whole velocity range.

Dynamic Range High
(the volume to be used for notes 

played at velocity 127)

Dynamic Range Low
(the volume to be used for notes 

played at velocity 1)

Dynamic range parameters
Dynamic Range High determines the volume to be used when notes are played at full velocity (velocity 
127), and Dynamic Range Low determines the volume to be used when notes are played at the lowest 
velocity (velocity 1).

The dynamic range for the setup is given by the difference between the two values.

When creating a new project, the dynamic range determined by the Default dynamic range for new 
projects value set in the preferences panel. 

Pitch Bend Up, Pitch Bend Down
These two parameters control the amount of pitch bending for the two directions of the pitch wheel 
controller.
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Virtual keyboard

The virtual keyboard resides at the top of the setup editor window.  You can use it to play notes using the 
mouse.  It also displays the notes currently being played at any moment through MIDI. 

The virtual keyboard lets you play notes at any velocity 
depending if you click on the higher part of a the virtual key, 
or on the lower position.

If you prefer, the  Invert Virtual Keyboard velocity preferences setting allows you to invert this behavior 
so that at top you have low velocity and at bottom you have high velocity.

Note keys pressed on the MIDI Keyboard or on the virtual keyboard are displayed in red. Note that this 
doesn’t necessarily means that a sound will be played, since which notes sound depends on how your 
instruments are mapped. 

Cursor inspector, Zoom and Guides
Above the virtual keyboard is the cursor inspector, showing the current mouse cursor position, the zoom 
control for the editor and a a button for creating display guides.

Cursor 
inspector

Zoom 
level

Create 
display 
guides

The available zoom levels are typically 1X and 2X, but some editor layouts (such as the wide setup editor) 
are always at 2X and for this reason there is no zoom selector in those layouts.

High velocity

Low velocity

Playing notes in Red
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Display guides are handy visual elements which you create to be references when moving elements 
around. Guides can be vertical (over a single note) or horizontal (over a single velocity level). Once you 
click the guides button, a panel will let you select the guide type and value.

Guides are especially useful when the View > Snap to  > Guides menu functions are enabled. Guides can 
be moved by dragging around the corresponding small yellow triangle, and can be deleted by dragging 
the triangle to velocity zero, or note zero.

The guides you’ll create in the setup editor will only be visible in the setup editor. In the same way, guides 
created in Instrument editors will not be visible in the setup editor.

Understanding the process of adding EXS instruments
Adding EXS instruments in a setup is subject to some limitations due to the nature of the EXS24.  The 
EXS24, (and therefore Keymap) can only handle one set of synthesis parameters (Envelopes, LFOs, Filters, 
Matrix modulation, Volume, Dynamic range, Dynamic Crossfade, etc) for each EXS instrument. For this 
reason, all instruments in a Keymap setup must share the same set of synthesis parameters.  This is not an 
issuel if you are working on a single instrument, but when merging multiple EXS instruments you will 
have to make the choice of which instrument Keymap should get the synthesis parameters from. 

The global tune and fine tune parameters in EXS instruments are handled differently, and Zones always 
play at the intended tuning with the following mechanism. When you add an instrument to a project 
without also importing its synthesis parameters (i.e. also the global tuning for the EXS instrument),  the 
Zones of the imported instrument will be retuned so as to play at the intended absolute pitch.

In the same way, when you add an instrument and also import its synthesis parameters (i.e. also global 
tuning), the existing Zones in the Keymap project will be retuned so that they will keep playing at the 
intended absolute pitch even if the global tune has changed.

In other words, whatever you do, adding instruments to a project never leads to pitch conflicts for the 
Zones, or better said, the conflicts are solved by Keymap automatically.
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Chapter 25: Opening and saving projects
The Open and Save  commands are essential parts of the Keymap workflow. This chapter deals with all 
the subtle and not-so-subtle things you should know about those two functions.

Opening KMP projects
You open KMP projects through the File > Open command. The opened project is considered to be an 

independent project respect to any other project you might have already opened.

 

Opening EXS instruments
You open EXS instruments through the File > Open command. The opened instrument is considered to 

be an independent project respect to any other project you might have already 
opened.  

One of the problems with loading EXS Instruments is that Keymap works with non-
overlapping Zones and has layers, while the EXS format instrument is a single 
element containing everything and has no concept of layers.

For this reason, when you open an EXS instrument, Keymap creates separate layers where it then places 
homogeneous Groups of Zones based on the associated Group, the one shot parameter, the disable pitch 
parameter, and the output bus parameter. Keymap also checks if overlaps occur between Zones in each 
layer, and moves Zones to new layers in order to resolve this conflict.

Once the EXS instrument is open, we refer to it as a “project” to avoid any possible confusion with Keymap 
instruments.

If the EXS instrument file was originally created by Keymap, then the file also contains the layer list. In this 
case Keymap reconstructs the layers and places Zones exactly how they were saved within Keymap.
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Sample files
When a project/instrument is opened, Keymap looks for the referenced sample files in the exact disk 
location described in the opened file. If the sample is not found there, then Keymap will use its built-in 
search engine to search for the appropriate file in a number of locations. 

The search engine
The search engine settings and location are found in the preferences panel, under the search engine tab.

Keymap has 5 different methods for searching samples, and you can configure the sequence in which 
these methods are applied by setting the “search step” sequence of pop-up menus. Our suggestion is to 
not change the default sequence unless you have a very specific need, and you know what you are doing.

Search methods: instrument folder
The “instrument folder” method searches for the missing sample in the folder where you loaded the 
project file. It will not look in subfolders.
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Search methods: instrument subfolders 
The “instrument subfolders” search method searches for the missing sample in any subfolders of the 
folder where you loaded the project file.  You can set how many subfolders levels should be searched in a 
dedicated parameter text field.

Search methods: sample locations (Live DB)
The “sample locations” method will search for the missing sample in one or more locations that you set in 
the locations table.

The location table is quite straightforward in that you can add or remove locations using the “+” and “-” 
buttons, and can change the path for the selected location by using the “Set path” button. This 
functionality is powered by Redmatica’s next-generation scan and database engine, LiveDB. This system 
has been designed to couple the advantages of database systems (no need to scan every time)  with the 
advantages of scan (data always in sync with what is on disk). When you add a new location to the table, it 
will be scanned just once at very high speed. After this first scan, a full database update usually takes a 
few tenths of second also for databases containing many hundreds thousands files. The database is stored 
in the Keymap application support folder, is automatically updated and managed, and takes very little 
disk space.

As the first scan after adding locations can take some time, you have the option of performing it 
immediately by clicking the “Update database” button.  The status of the LiveDB engine is permanently 
displayed as text, with information about the number of files and samples found, the size of the database 
and the date and time of the last update.
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In order to minimize search time, the locations should point directly to sample folders and/or sample 
drives. We strongly recommend against adding the system drive, the home folder or the desktop as 
locations.

Search methods: recent folders
The “recent folders” search method searches for the missing sample in the folders where other missing 
samples were recently found. This ensures that once you locate a sample, any other sample in that folder 
will be searched for other missing samples too.

Search methods: manual selection
When everything else fails, “manual selection” lets you locate the sample file yourself using a standard file 

dialog. With this method you can also select a sample 
with a different name than the one searched, and you 
can preview the sample content using the Play 
selected file button. The dialog will also let you select 
an entire folder: in this case Keymap will search for the 
sample file in that folder, and  if you enable Also search 
in subfolders,  also in subfolders.
If you click “Cancel”, the manual search method will fail 
and pass the task to the next method defined  in the 
search list.

If you enable Avoid asking for any remaining sample 
then you won’t be asked anymore to locate manually 
samples for the current session. This is very handy 

when you want to examine an instrument without having samples. 

Tip: if you never want to be asked about samples, just remove the “manual selection” method from 
the search steps. 

Tip: in some cases the searched sample file might not have the correct file suffix or creator code, 
and so might be not selectable from the panel. In this cases, just select its folder.
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What happens when samples are not found
In the case some samples are not found, the respective Zones will be displayed in the Instrument editor as 
placeholders. If you save the project, either in Keymap or EXS format, the references to missing samples 
will be preserved, so that they can still be searched, and possibly found, next time.

Supported and unsupported EXS Synthesis Parameters
Keymap has not been designed to replace or clone the EXS24 editor. For this reason the synthesis section 
in Keymap does not cover all the EXS24 features, and only a subset is directly supported and editable. All 
the unsupported parameters (filters, complex modulation matrix routings, etc),are however still read and 
preserved when you open an EXS instrument, and written back to the file when you save the project in 
EXS format.

Directly supported EXS24 Synthesis parameters
(screenshot of the EXS24 plugin)

AMP Envelope

Tranpose
Tune,

Fine tune,
Pitch bend

LFO1 
Rate
and 
EG

Velocity 
mapping

and
Pitch vibrato

Velocity Offset
and 

Dynamic 
crossfade

Dynamic range,
Volume,

Volume scale

In particular, we need to mention the pitch vibrato section in Keymap: while the default EXS settings use 
LFO1 for pitch vibrato through modulation wheel, this is not necessarily always true. Also, LFO1 rate can 
also be set to rhytmic figures, which aren’t supported in Keymap as there’s no metronome.
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When loading, Keymap will check if LFO1 is used for vibrato, and if the LFO1 rate is in the hertz range. The 
Vibrato section in Keymap will become available and editable only when both conditions are satisfied. In 
the other cases, the LFO parameters won’t be editable and will be preserved as they are.

Combining multiple EXS instruments in a setup: implications regarding the synthesis parameters
In Keymap, you can combine multiple EXS instruments in a single Keymap setup, and then save it as a 
single EXS instrument. As the EXS24 has a single synthesis section for all the Zones, you understand how 
it’s not possible to have multiple filter types,settings, modulation matrixes, and all the rest for each 
instrument at the same time when you save a setup back to EXS format. 

For this reason, when adding EXS instruments to a project, you can replace the current synthesis 
parameters of the project with the ones from the 
loaded EXS instrument byenabling the Also import 
synthesis parameters checkbox. 

All the synthesis parameters (vibrato, volume, AMP 
envelope, dynamic range, tuning, etc) will  be 
r e p l a c e d w i t h t h e v a l u e s f r o m t h e a d d e d 
instrument.

Notable exceptions are the tuning parameters, 
which are handled differently. When you add an 
EXS instrument and change synthesis parameters, 
the tuning for already defined Zones will be 
modified to preser ve the absolute tuning,  
regardless of  the new project tuning values. 

For example, if you add an instrument which is tuned six semitones down, the tune of current Zones will 
be increased by six semitones so that in the end they will keep playing at the current (right) pitch. 
Similarly, if your project is at +9 semitones and you add an instrument without importing its synthesis 
parameters, then the new Zones added to the project will be tuned to -9 semitones so as to play at the 
intended pitch.

Note that you are never asked to replace synthesis parameters (they are never imported), when you just 
drag the EXS instrument into the setup editor. The tuning parameters will still be handled anyway.

Tip: if you just want to replace synthesis parameters from an instrument without really adding it to 
the setup,   add the instrument and import its synthesis parameters, and then delete it from the 
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Saving the project in Keymap format
The project can be saved in Keymap format  with the File > Save or File > SaveAs command and setting 
the  Keymap instrument format in the save panel instrument format pop-up menu.

 
When you save in Keymap format, there is never need to render new sample files—the operation only 
consists of updating or writing a .kmp file.

Autobackup
Keymap provides an autobackup function that preserves previously saved versions of a project. The 
function is activated from the preferences panel by enabling the “Autobackup when saving” checkbox.  
You can also set the maximum number of older versions you want to preserve.

The next time you save the project, a folder with the project name and the .back suffix will be created 
next to it. At each save, the old version is moved in that folder, and all versions renamed by appending a 
sequential number, so that at any time version “1” always identifies the newest backup and the others are 
progressively older as the number increases.

Tip: autobackup, when used with .kmp files, lets you go back in versions at will, as keymap projects 
never require changes to samples, and all sample functions/edits are performed in realtime, and so 
all the changes over time are effectively stored in the backup files.
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Saving the project in EXS24 format
The project can be saved in EXS24 format by using the File > Save or File > SaveAs command and setting 
the  EXS24 instrument format in the save panel instrument format pop-up menu.

And this is the save panel for the EXS24 format (don’t panic!).

The Save panel for the EXS24 format

EXS Instrument name 

Folder where to save the instrument

Parameter palette you can drag and drop 
over "Sample path" and "Sample name" 

fields

Sample parameters for 
selected set

Rendering sets table

Render  warning

In the save panel you control not just the location for the saved insturment, but also how things will be 
translated from Keymap to EXS24 format. 
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Saving the project in EXS24 format: instrument parameters in the save panel
Static crossfades for a Zone are recreated by Keymap in the EXS24 as multiple small copies mapped 
around  the Zone they refer to,  with decreasing volume level in order to simulate the fade area.
The Ignore Zone crossfades checkbox excludes any static Zone crossfade from being created. In the case 
crossfades are instead saved, the Crossfades size parameter let you choose the size of the Zones to create 
for simulating the fade area.

Similarly, the Quadrasmooth pop-up menu lets you apply the Quadrasmooth volume correction to each 
Zone as it is, or alternatively split Zones in smaller chunk to get more homogeneous volume transitions 
between Zones.

Zone tuning rebalacing
Keymap let you set the fine tuning pitch parameters for Zones and loops within a very large range of 
values, while EXS24 does not. For this reasons, the tuning parameter values might need to be rebalanced 
when saving to EXS24 format. The fine tune parameter is always rebalanced to within the EXS24 limits by 
changing the tune parameters, and this doesn’t pose problems.  However, the EXS24 does not allow the 

loop tune parameter to be out of the ± 50 cents range, and this is a problem, as this parameter can be 
very easily out of that range in Keymap if you use single cycle autotuning. The application gives you three 
ways to handle the problem:

- by clipping the loop tune parameter to ± 120 cents, which is not officially supported by EXS24 but will 
work

- by clipping the loop tune parameter to ± 50 cents, which is the official supported EXS24 range

- by keeping the loop tuning using the trick of changing the tune and fine tune Zone values of the 
needed values to reach that goal. This approach is probably useful only when the sample starts playback 
exactly on loop start, or anyway very near

You select the method to use in the preferences panel
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Saving the project in EXS24 format: sample rendering
If the project uses any of the Keymap sample functions not directly available in the EXS24, then these 
samples are automatically rendered to new sample files incorporating all the edits and the processing 
required for them to sound in the EXS24 exactly as in Keymap. Functions requiring rendering to new files 
include using the surround+space mixer, channel maps, harmonic resynthesis, s-shaped crossfades, fade 
in and fade outs, cut and paste edits...you get the idea...

You can see in advance the need to render new files by looking at the Render warning message in the 
panel. If no warning message is displayed, then there’s no need to render any new file.

By default, Keymap will render only the samples where used features can’t translate directly to EXS format, 
and the saved EXS instrument will reference the newly rendered files plus the rest of the samples which 
did not require a render.

You can however force all samples to be rendered anyway to new files, using the Sample creation mode 
pop-up menu and selecting Recreate entire sample set.  In this case all samples will be rendered and the 
saved EXS instrument will only reference the new samples. 

Page 276 



Rendering parameters sets
Rendering samples involves making a number of choices: format, bitdepth, rendering mode, name of 
sample files, location for the new samples, etc. Instead of setting all these parameters every time, Keymap 
lets you create sets of parameters that you can then select as a whole. Also, you can build sample names 
and path locations parametrically out of more than 20 parameters, so that, for example, samples are saved 
in folders named after the velocity range, or samples are named after their root note.

The sets are selectable in the Rendering sets table, and you can add , remove and duplicate sets using 
respectively the “+” , ”-” and “Duplicate” buttons. 

The rendering sets table and associated parameters
Each set can be locked from modifications using the Lock this set checkbox. Once the set is unclocked, 
you can set the desired sample format (AIFF or WAVE) and bitdepth (16 or 24) from the respective pop-up 
menus.

You can also choose to render the crossfades in the loop by enabling the Render loop crossfades 
checkbox.  Doing so will make impossible to later edit the crossfade in Keymap or EXS24, but will make 
the sample playable with the crossfade by any sample player.

The Render at -6dB checkbox let you attenuate the rendered samples by 6dB in order to cope with peaks 
without distorting or limiting the sample. When this setting is enabled, the Zones referencing the newly 
rendered sample will have the volume increased by 6dB in order to compensate for the sample 
attenuation.

The sample name can be typed directly in the Sample name field, but can also be built using tokens that 
you can drag and drop from the Parameter palette or type directly. Keymap will replace these tokens 
with the actual values taken from the currently processed sample, and its Zone.  
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The available tokens are:

Token Converts to

Space A single space. Normally all redundant spaces are removed

$HN The High Note Zone parameter expressed as MIDI Note number

$LN The Low Note Zone parameter, expressed as MIDI Note number

$NHN The High Note Zone parameter expressed as note name

$NLN The Low Note Zone parameter, expressed as note name

$RN The Root Note Zone parameter expressed as MIDI Note number

$NRN The Root Note Zone parameter expressed as note name

Hyphen A single hyphen (“-”)

$HV The High Vel Zone parameter 

$LV The Low Vel Zone parameter 

$DON The project name (which is also the setup name)

$ZON The Zone name before find+replace processing

$GRP The Group name (if the Zone is not assigned to a Group, this translates to nothing)

$INS The instrument name for the Zone

$LAY The layer name for the Zone

$SEQ A sequential number, always starting from 1 for each save session, and 
progressively incremented for each sample being rendered

$TIM The current date and time

$SMN The name of the original sample file referenced by the Zone
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The sample path is built similarly, either by setting a path using the Set path button, or by adding tokens 
as for the name. When using tokens for the path, Keymap will create a different subfolder for each value of 
the token. When you combine things, you can obtain very interesting results. As example you could use a 
sample path definition of

/Volumes/ExternalDrive/KeymapSamples/$DON/$NRN/$HV

And then all your samples would always be rendered in common and well organized folders subdivided 
by project name, root note and top velocity. 

As another example, let's say that you set a sample folder defines as

/Volumes/samples/$GRP/velocity $HV

and a name structure defined as 

newsample-$LN-$HN

Keymap would render a sample with this complete name (picking random values and Group names, it’s 
just an example)

/Volumes/samples/Group one/velocity 100/newsample-A5-B5.wav (or .aiff)

Simple and powerful!

The sample folder field can use additional tokens (parameters) respect to the name. Here’s the complete 
list:

Token Converts to

Space A single space. Normally all redundant spaces are removed

$HN The High Note Zone parameter expressed as MIDI Note number

$LN The Low Note Zone parameter, expressed as MIDI Note number

$NHN The High Note Zone parameter expressed as note name

$NLN The Low Note Zone parameter, expressed as note name
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Token Converts to

$RN The Root Note Zone parameter expressed as MIDI Note number

$NRN The Root Note Zone parameter expressed as note name

Hyphen A single hyphen (“-”)

$HV The High Vel Zone parameter 

$LV The Low Vel Zone parameter 

$DON The project name (which is also the setup name)

$ZON The Zone name

$GRP The Group name (if the Zone is not assigned to a Group, this translates to 
nothing)

$INS The instrument name for the Zone

$LAY The layer name for the Zone

$SEQ A sequential number, always starting from 1 for each save session, and 
progressively incremented for each sample being rendered

$TIM The current date and time

$SMN The name of the original sample file referenced by the Zone

$SMPFOLDER The folder of the original sample file referenced by the Zone

$LOGFOLDER The logic application support folder

$DOCFOLDER The folder where the project is being saved

Unique names
The Always create unique names checkbox, when enabled, will append a specially composed pseudo-
random string of 4 chars to the name in order to make it unique. This is extremely important if you are 
going to render the same samples multiple times, as you will get multiple copies of samples, and Logic 
can't reliably distinguish one sample from the other if they have the same exact name. Enabling this 
checkbox, and so appending the random string, will eliminate this problem.  
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Names for split surround samples
When rendering multi-out or surround samples, Keymap might need to render multiple stereo files with 
the same name: in order to avoid overwritings and potential confusion, a short suffix is appended to the 
name, indicating the output bus. "A" is bus 1+2, "B" is bus 3+4, "C" is bus "5+6" and so on. For the sake of 
convenience, since BUS 1+2 is the most used, the A character is not appended to the sample name. 

Limitation on length of sample names
Currently Logic has a limit of 32 chars in the sample name. Even though Keymap manages the use of 
longer sample names in EXS instruments, the recommendation is to use short names.

If the sample path is not an absolute path...
If the folder structure you set does not start with a " / " or one of the folder tokens (Logic folder, or 
document folder), then Keymap will create the folders next to the instrument file. Some characters are 
considered illegal and are removed when processing. These include " : " both for the folders and for the 
names. The default location saves next to the instrument.

Logic caches instruments!
As of Logic 7.2, once Logic loads an EXS instrument, it caches it in its memory, with the net result that 
regardless of the fact that you load it again from the EXS menu, Logic will keep using the version in 
memory, and ignores any updated file on disk.

In the same way, Logic sometimes will silently overwrite the EXS files with the version it keeps in memory, 
and in this way it can potentially overwrite an edit you just made with Keymap.

Keep these things in mind if you see strange results, such as instruments apparently not being updated, 
or files reverting back to old versions, while running Logic and Keymap at the same time.
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Chapter 26: The Surround+Space Mixer
When creating sample instruments, it can be very helpful to already pre-mix the individual Zones or 
layers, so that the instrument can be used immediately in a musical context. While adjusting volume and 
pan already makes for interesting results, sometimes you need more realistic spatial control over 
placement of sounds in the sound field. These days it’s also increasingly important to be able to spatialize 
sounds not just in the 2.0/stereo domain, but also in more complex speakers configurations as 4.0 or 5.0. 
Moreover, Keymap should be able to print these spatial qualities to the samples so that the EXS24 or any 
other sampler can play the samples as we mixed and heard them in Keymap. The realtime Surround
+Space mixer in Keymap is the answer to these needs.

Surround busses
 table

Speakers (output)
configuration

Soundfield 
editor

Bus
Volume

Bus
Elevation

Bus max 
attenuation

Bus 
stereo 
width

This mixer has 16 stereo input busses coming from Zones, and the output can be configured for  two, four 
or five speakers. The output configuration and the EXS24 busses to use for speakers are selected though 
the Speakers Configuration and the related Front, Read and Front Center pop-up menus.

Four speakers output configuration

Five speakers output configuration

Two speakers output configuration

2 Speakers 4 Speakers 5 Speakers
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Each  stereo bus input has an individual input Volume control,  a Stereo Width control and can be 
processed using the spatialization engine. Here, the Azimuth , Elevation and Distance parameters drive 
one of the five available spatialization algorithms.

Two, four or five speakers signal pathStereo surround bus

Algorithms:
• EqualPower
• HRTF
• Spherical head
• Soundfield 
• Vector

Volume Stereo Width

Spatialization

Azimuth
Elevation
Distance

Distance 
filtering

Distance 
attenuation

Distance 
ambience

Azimuth

Elevation

Distance

Azimuth, Elevation and Distance define the position of the audio 
from the busses, in the soundfield
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Spatialization Algorithms 
These are the available algorithms:

 EqualPower: this algorithm is intended for 2.0 output and implements an simple equal power panner 
driven by the azimuth parameter. The elevation parameter is ignored by this algorithm.

• HRTF (Head-related transfer function): this algorithm uses convolution to model the human head, and 
filters the audio  to simulate the diffraction and reflection properties of the head, pinna, and torso, before 
the sound reaches the eardrum and the inner ear. Biologically, the source-location-specific pre-filtering 
effects of these external structures aid in the determination of source location, particularly the 
determination of source elevation. Thus, the HRTF is used to create the impression of surround sound 
without multiple speakers.  

• Spherical Head: this algorithm is similar to HRTF, but uses a mathematical model instead of convolution.

• Soundfield: this algorithm takes the audio from the bus and distributes it amongst all the output 
channels with a weighting toward the location in which the sound derives. It is very effective for ambient 
sounds, which may derive from a specific location in space, yet should be heard through the listener's 
entire space.

• Vector: this algorithm is similar to Soundfield, but the sound is more focused to the output channels 
near the location in space of the sound source.

Distance-related additional effects
Some algorithms let you also enable distance-related spatialization effects:

• Distance Filtering progressively dampens the sound as the distance increases to emulate the 
attenuation of high frequencies as happens in real, open spaces. You enable and disable it through the Fi 
checkbox in the surround bus table.

• Distance Attenuation progressively dampens the sound as the distance increases to emulate the 
attenuation of high frequencies happening in real, open spaces. Each bus has an independent Distance 
Attenuation parameter, which sets the volume attenuation at the maximum distance, and can be 
enabled and disabled through the A checkbox in the surround bus table

• Distance Ambience progressively adds ambience to the sound as the distance increases to emulate 
sound field ambience reflections. This is enabled and disabled through the R checkbox in the surround 
bus table
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How to route Zones to a Surround bus
For routing the audio out from some Zones into one of the surround busses, select the Zones, set 
“Surround Mix”  in the Out pop-up menu inside the Zone inspector, and then set the desired surround bus 
destination. 

How to place and position the busses in the sound field
The 16 stereo busses are always visualized as numbered circles in the Soundfield editor. Disabled busses 
are displayed in grey, while enabled busses are displayed in red. You set azimuth and distance simply by 
dragging around enabled busses in the soundfield, with the center of the soundfield being the listener 
point. The elevation parameter is set through the elevation slider at the left of the soundfield editor.

2 Speakers

4 Speakers

5 Speakers

Stereo Bus 1

Stereo Bus 2

Stereo Bus 3

Stereo Bus 4

Stereo Bus 5

Stereo Bus 6

Stereo Bus 7

Stereo Bus 8

Stereo Bus 9

Stereo Bus 10

Stereo Bus 11

Stereo Bus 12

Stereo Bus 13

Stereo Bus 14

Stereo Bus 15

Stereo Bus 16

Soundfield editor

While dragging the busses around, the highlight of busses serves as a visual cue that  the busses are at 
the same distance. This let you set up busses at the same distance in a very simple and intuitive way.

Page 286 



Saving projects using the Surround+Space mixer to the EXS24 format
The EXS24 has no built-in support for the surround+space mixer. When a project using these features is 
saved to the EXS24 format, Keymap will recognize the samples which use spatialization and will process 
them and save the result as new sample files. 
If the mixer is configured for 4.0 or 5.0 output format, then Keymap will render the busses to 4 or 5 
channel samples. As EXS24 has no support for multichannel samples, Keymap saves this complex 
rendered multichannel sample as a series of stereo and mono sample files, with new Zones created and 
properly assigned, in order to recreate the same sonic result of Keymap inside the EXS24. 

As you can imagine this is a very complex process, which is not reversible. For this reason we strongly 
suggest to save the project in Keymap format before saving it in EXS24 format.
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Chapter 27: Resources window
The resources window has been designed to give you an overview in tabular form of your current project  
elements, including the referenced real sample files. 

Zone table

Zone table 
menu

Aux sample 
editor

Sample file 
inspector

Search field

Sample table for 
selected zones

Sample table 
menu

Aux sample 
overview

From this window you can also perform advanced renaming of Zones and sample files, view and save 
mapping and loop data to sample files, edit the Zones virtual samples through the auxiliary sample editor, 
open the instrument or sample editor for selected resources and search for specific names in your 
elements.
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The Zone table
This table lists all Zones in your project, and their relationship with layers, instruments and Groups. We 
also see the basic Zone properties:  note and velocity ranges, root note, start and end playback position, 
loop points.

Only some parameters are editable from the table: the Zone, layer, instrument,Group names ,the root 
note and the loop enabled/disabled checkbox. If you double click with the mouse over one of the non 
editable parameters you will actually open the full sample editor for that Zone virtual sample. You can 
also sort the table by clicking on the columns titles. This is very useful if you want to look at the  the Zone 
list organized in various ways, by Group , by instrument, or by layer.

Using the Zone table as a browser
The Zone table editor can also be used to browse the Zones/samples you dropped into the Instrument 
editor, as you can move from one Zone to the other using the cursor keys, and play the sample using the 
space bar. You can also select Zones and later keep or remove them from the Instrument editor.

Selecting Zones in the Instrument editor from the Zone table
Since all editors in Keymap are integrated, you can use the Resources Window next to your Instrument 
editor and select Zones in the Instrument editor from the Resources Window using one of two menu 
functions you find in the Zone table menu.

The Add to selection in Instrument editor function adds the currently selected Zones in the Zone table 
to the Instrument editor selection without deselecting any Zone that might have been already selected 
there.
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The Select in Instrument editor menu function will instead first clear any selection in the Instrument 
editor and then select the Zones as from the Zone table.

Opening the Instrument editor(s) for selected Zones 
Once you select some Zones in the Zone table, you can open the Instrument editors for those Zones using 
the Open Instrument editor(s) for selected Zones menu function.

Advanced rename
Once you select Zone Zones in the Zone table, Keymap lets you rename them with a sophisticated, yet 
simple, token based system which we call advanced rename. You open the advanced rename panel using 
the Advanced rename menu function.

The panel consists of four sections: the Find text field, the Replace text field, the Combine text field and 
the Parameter palette.
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The renaming is done in two phases for each Zone: Find and Replace and then  Combine. 
In the first phase the name is searched for using the Find text, and any instance is replaced with the 
Replace text. After that you can Combine the result with names taken from some of the Zone properties. 
The concatenation is defined by simply placing a series of token in sequence in the Combine field. 
Keymap will replace these tokens with the actual values taken from the currently processed Zones. You 
are not limited to using tokens: you can type text directly in the Combine field, and that text will be used 
to rename your Zones. Of course it doesn’t really make sense to name all Zones with the same text , so 
you might want to at least add a sequential number using the $SEQ token.

Parameters palette
The parameter shows the available tokens for renaming. Here’s an explanation of each of them:

Token Converts to

$OLD The Zone name after find+replace processing

Space A single space. Normally all redundant spaces are removed

$HN The High Note Zone parameter expressed as MIDI Note number

$LN The Low Note Zone parameter, expressed as MIDI Note number

$NHN The High Note Zone parameter expressed as note name

$NLN The Low Note Zone parameter, expressed as note name

$RN The Root Note Zone parameter expressed as MIDI Note number

$NRN The Root Note Zone parameter expressed as note name

Hyphen A single hyphen (“-”)

$HV The High Vel Zone parameter 

$LV The Low Vel Zone parameter 

$DON The project name (which is also the setup name)

$ZON The Zone name before find+replace processing

$GRP The Group name (if the Zone is not assigned to a Group, this translates to nothing)

$INS The instrument name for the Zone
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Token Converts to

$LAY The layer name for the Zone

$SEQ A sequential number, always starting from 1 for each rename session, and 
progressively incremented for each Zone being renamed

$TIM The current date and time

$SMN The name of the real sample file referenced by the Zone

You really have no more excuses for creating instruments with cryptic Zone names!

A step-by-step example
We first select these Zones in the Zone table. Notice how the Zone name is a bit anonymous: we want to 
spice up the Zone names by adding the instrument name, changing the LightSynth text to something 
else, and adding the name of the root note too.

We open the Advanced rename panel using the Zone table menu.
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And  then we set the panel to find and replace the “LightSynth” string with “MyZone” by filling the 
appropriate Find and Replace fields.

 We can combine the resulting name with other parameters by dragging and dropping the tokens from 
the palette into the Combine field. The $OLD token represent the Zone name after the find and replace 
process. If we just leave the $OLD token in the Combine field, then we are simply going to find and 
replace and no further combination (concatenation) of names or values will happen. Let’s start from 
scratch by selecting the combine field and using the backspace key to clear it: as you will see the Combine 
field it works in many ways as a normal text field.

In our case we want the Zones to start with the instrument name, so we drag and drop the $INST token 
from the palette into the combine field , then we drag and drop an hyphen  token that we’ll use as 
separator. We then drag and drop the $OLD token, representing our Zone name after find+replace , then 
we add another hyphen and also the root note as text (i.e. expressed as C4 and not 60).
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This is what you should see

We can now click OK, and Keymap will rename all selected Zonesm , and this is the result:

As you can see each Zone name now starts with the instrument name, then the found+replaced text and 
then the root note (as you can check by comparing with the root note column on the right).
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Another example
Let’s say that we are not satisfied with the results above, and we want to go back to a simple name with a 
sequential number. We open again the Advanced rename panel, and this time we don’t do any find and 
replace, but we type directly the new name we want in the Combine field, followed by a space token and 
a $SEQ token, so that each Zone name is followed by a unique number.
 

We click ok, and this is what we get:
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Adding loop and mapping data to sample files
While the EXS instrument format is supported by all the most popular software samplers, sometimes you 
might want to use the samples in a different context, or with an application which can’t read EXS format. 
Luckily, both the WAV and AIFF file format specifications allow applications to write and read for each 
sample file the expected position in a note+velocity matrix,the root note, the volume and the loop points. 
In many situations this is really all what you need. 

When rendering new sample files, Keymap always embeds this information in the created files. The 
problem however remains for samples not rendered by Keymap, or when you modify the mapping and 
looping parameters and need to update the sample files.

The Add mapping and loop data to sample file menu function in the Zone table menu let you add, or 
update, the mapping information contained in AIFF and WAV samples referenced by the selected Zones. 

This function will not add or update data if a sample is used by more than one single Zone in your 
instrument. This happens because in that case the Zones would have conflicting values, and would not be 
possible to establish the right set to use.

Applications that support the mapping and loop data in sample files will be able to import the samples 
and place them directly in the proper map area.

Keymap supports the mapping data in sample files, and uses this data as the basis for a few automap 
functions available in the Instrument editor.
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The search field
If you type some text in the search field and press Return or Enter, the Zone table will only show you 
Zones  for which the search text matches any part of the names of either the Zone, instrument, layer and 
Group.  Needless to say, the search field is an efficient way to quickly focus on a limited set of Zones.

The aux sample editor
Each time you select a single Zone in the Zone table, you will be able to view and edit its virtual sample in 
the resources window aux sample editor. This editor has all the functionalities of the aux sample editor 
seen in the Instrument editor. 

It’s important to understand that the sample editor will show you the virtual sample for the Zone, and not 
the content of the real sample file. In simple projects the two samples might coincide, but that’s not the 
rule.

The sample table
The sample table shows the sample files referenced by the Zones selected in the Zone table, and their 
most important properties, as number of frames, sample rate, format, modification date, creation date 
and path.

If you select a single sample file, you can see more information in the sample file inspector, including the 
mapping and loop data eventually available in the sample file.

It’s important to note that while the loop points data is automatically used by Keymap when adding 
samples to the project, the mapping data (note, velocity ranges and root note) is never used 
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automatically by Keymap, not even if you drag and drop samples in the Instrument editor, and you have 
to make explicit use of it through the automap functions in the Instrument editor.

Reveal samples in finder
If you select one or more samples in the sample table, you can go to their disk folders using the Reveal in 
finder sample table menu function. 

 

Select Zones in Instrument editor
If you select one or more samples in the sample table, you can select all Zones referencing these samples, 
in their instruments editors, by using the Select Zones in Instrument editor menu function.

Renaming sample files
You can rename sample files. The method and the rename panel are exactly the same as used for the 
Zones, so we won’t repeat the explanation here. Note however that when we talk about sample names, 
we always mean sample names without the format extension (.aiff, .wav). Keymap will always add the 
format extension itself.  

In the specific case of renaming sample files, you have to be careful as there might be other projects or 
instruments using those samples, and if you rename samples, those other projects won’t be able to find 
those renamed samples anymore.
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Another thing to keep in mind is that the Keymap undo system will also undo a rename of sample files, 
but only if you do not change or modify them in any way through the finder or other applications in the 
meantime. If you do so, and then undo a rename session, you might break the project, and Keymap might 
have trouble finding the samples again next time you’ll load the project.

In the case your Combine parameters leads to already existing sample names, Keymap automatically 
appends a sequential number to names so that the files do not overwrite or collide with each other.

Remember: be prudent when you rename sample files, as this is one of the very few destructive 
operations you can do in Keymap.

Moving sample files
You can move sample files by selecting them in the sample table and using the Move samples function. 

You will be asked for a destination folder: if you are moving samples across drives, be sure that there is 
enough space available. If a potential overwrite of files is detected, Keymap will solve the situation by 
appending sequential numbers to your sample names, in order to make the name unique.

Rebuilding sample overviews
Keymap creates and saves sample overview data as a resource of the sample files. You normally should 
never have  to rebuild overviews manually, as Keymap will automatically recognize when the overview 
needs to be updated. However, certain archival utilities and audio applications may corrupt this data. By 
selecting the samples in the sample table, and using the Rebuild overviews menu command, you can 
force Keymap to rebuild the overview data.
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Stripping sample overviews from sample files
If you want to remove the Keymap sample overview data from your sample files, just select the samples in 
the sample table and use the Strip overviews from files menu command. If you open this sample again in 
Keymap, the overview will be regenerated automatically. 

Page 301





Chapter 28: Key manager
Keymap lets you use key commands as alternative to menu commands. Once you take the time to learn 
all the various functions, this is the quickest and most efficient way to use the application. The Key 
manager window lets you see which keys are assigned to functions, which functions are assigned to 
specific keys, and of course you can customize the key assignments to better suit your workflow.

The Key manager is opened using the Windows > Show Key manager command.

Key manager

Search field for 
commands

Commands table

Assign 
key

The commands table shows all key commands available, and the search field lets you narrow the visible 
commands to the ones you are looking for. Each assignment also takes key modifiers in account. The 
supported key modifiers for commands are the Shift, the Option and the Control keys. The Command 
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key is not supported by Keymap for user-definable commands. Note also how key commands are for the 
most part specific to the currently selected view or table, and will operate only there. 

Assigning a new key combination to a command
Keys are assigned in the Key assign panel, which you can open by double-clicking on the selected 
function in the commands table, or by selecting the function in the table and then clicking the Assign key 
button. In the Key assign panel you can both browse and assign keys.

Key assign panel

Key and modifiers

Commands already 
assigned to that 

specific key

Once the Key assign panel is open, you can assign a new key combination (a combination of a key and its 
modifiers) by pressing the same key combination twice in a row. Pressing a key combination just once   
will simply browse keys and see the commands already assigned on that key, regardless of the modifiers.

Some functions are available more than once in the table, as this allows multiple key combinations for 
those functions. Pressing the ESC key will cancel the Key assign panel and no key assignment will occur.

Loading and saving key commands set
The customized key commands set can be saved and loaded using the Load set and Save set functions 

available from the context menu.   The Restore default set menu command restores 
the key assignments to the defaults. The Copy to clipboard command copies the key 
assignments as a text list to the clipboard, from where  you can copy it in a text 
editor. You will need to use a fixed width font, as Courier or Monaco, for it to be 
displayed correctly.
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Chapter 29: Statistics window
While building instruments, it’s often useful to keep track of how many samples are used, and how much 
disk space the project is going to take. Keymap statistics subsystem keeps track of these and many more 
things for you, and displays the current statistics in a dedicated window. 

The most important information is also displayed in a small status Zone in  the OSX system menu so that it 
always remains visible.
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KM [56 Zones]

Size: 9.95 MB

Clicking on the KM status will open a small menu allowing you to select which sample size you want to 
actually see in the system menu bar (current size, saved at 16 bit, saved at 24 bit). 

The statistics are usually updated automatically after each editing action, but you can change this 
behavior by disabling the Updates automatically checkbox at the bottom of the window.

 Once disabled, you can update statistics whenever you want by clicking the Update now button on the 
right.

Most of the values seen in the statistics window are logically subdivided and quite self-explanatory, but 
three of them deserve a comment. 

The Current size value for samples is the total size of the samples referenced by the current project.

The Truncated 16bit size is the predicted sample size if you are going to render all samples for the project 
at 16 bit.

 The Truncated 24bit size is the predicted sample size if you are going to render all samples for the 
project at 24 bit.
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Apart from the size difference due to the different bit depths, it’s important to remember that when you 
render new samples, Keymap by design will always create an independent sample for each Zone, 
regardless of the fact that they might have been originally pointing to the same file. This is the reason for 
why you might see a difference between the Current sizes and the Truncated sizes.

While this design rule can lead instruments generated by Keymap to use potentially more disk space, in 
this way each Zone can be independently processed with third-party audio applications later.
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Chapter 30: Preferences
The preferences window,  accessible using the Keymap>Preferences menu command, lets you 
personalize the software to your preferences and to your computer hardware.

Audio preferences
In the audio preferences page you set the audio device you want to use for Keymap, and the routing of 
Keymap outs to your audio device individual outputs. Note that Keymap does not use the Mac OS X 
system preferences for sound output. 

The Audio Device and Sample Rate pop-up menus let you select the audio device for Keymap, and the 
desired sample rate. Most of the multi-channel devices have a “main” set of stereo outs. The Main stereo 
out menu lets you view and change this “main” stereo couple, but is not directly changing the routing of 
the audio from Keymap to the audio outs, and you will have to change the routings directly in the audio 
routing table. At the end of Keymap audio engine we have 16 virtual audio outputs, exactly as in EXS24, 
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that you can see at the left of the audio routing table. For each one of them you can select an audio 
device output to be used, on the right column. 

If all you want is to send each individual channel to individual outs, you can click the “Set all to individual 
outs” button.

If instead you want to send all outs to a certain stereo set, you should first choose the main stereo out set 
you want to use in the “Main stereo out” menu, and then click the “Set all to main stereo out” button.

Virtual memory
Keymap is based on a streaming audio engine, which avoids loading sample data into the computer RAM 
memory, if not strictly necessary.

Without going into needless technical details, you can change the audio engine behaviour using the 
Virtual memory Strategy menu.  This menu is provided mostly as a way to troubleshoot systems, rather 
than something you should worry/think about, and we reccomend leaving it at the default setting. 

 

Pure streaming will force the audio engine to keep as less audio data as possible in RAM.
Lazy loading on the contrary will not stream but will load samples in RAM only when strictly necessary.
Hybrid streaming settings switch the audio engine to a mode which is “in between” of streaming and 
loading, and gives most of the advantages of both approaches.

You might need to restart Keymap before changes to this setting become effective.

Page 310 



General preferences
These preferences affect the general behavior of Keymap.

The Startup action menu is used to force Keymap to reload the last saved project, or to create a new 
project (or nothing), at startup.

With the Global unit 1, 2 and 3 menus, you define unit of measures that can be used in the sample editor 
for the various parameters inspectors.

Default sample editor ruler units is for the sample editor ruler.

Time grid in ms lets you define the sample editor grid size (when enabled) expressed in milliseconds.

The Zone inspectors show up to menu lets you set the maximum number of zones for which the zone 
inspectors in the instrument editor will work. This setting has an important performance impact, because 
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each time you select multiple zones, Keymap has to check which parameters from all zones are at the 
same value and which not, so that it can display correctly the values in the zone inspectors.
Considering that each zone has hundreds of parameters, and that instruments can easily contain 
hundreds of zones, this can take quite a hit on your CPU. With this parameter you can set the “maximum 
number of zones” which will be handled by the inspectors.

Statistics update automatically, when enabled, will automatically update the statistics window at each 
edit action.

Open instruments when added, when enabled, will automatically open the instrument editor when you 
add instruments to a setup.

Autoselect new tessellated elements, when enabled, will automatically maintain the selection even if a 
zone gets tessellated because of some editing action.

Open setup editor when creating new projects, lets you automatically open the setup editor when 
creating a new project.

The Editors layout menu lets you choose one of three possible layouts available for the main editors 
windows. Each layout is targeted toward a certain screen size, and we have a Compact layout (1024x768), 
a Normal layout (1440x900), and a Wide layout (1920x1200).

Invert virtual keyboard velocity, when enabled, makes the virtual keyboard send low velocity notes 
when clicked at the top, and high velocity notes when clicked at the bottom.

MIDI note 60 is displayed as , lets you define the note name to use for MIDI note 60. Possible choices are 
C3, C4 and C5).

Default dynamic range for new projects lets you set the desired dynamic range when creating a new 
project.

The Autobackup when saving checkbox activates an autobackup function that preserves previously 
saved versions of a project. You can also set the maximum number of older versions you want to preserve 
with the Max number of backups preference.

The next time you save the project, a folder with the project name and the .back suffix will be created 
next to it. At each save, the old version is moved in that folder, and all versions renamed by appending a 
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sequential number, so that at any time version “1” always identifies the newest backup and the others are 
progressively older as the number increases.

The “When saving in EXS format the loop tune is” menu lets you choose how the loop tune should be 
rebalanced when saving to EXS24 format. Please check the Single cycle loops section for more 
information about this.

The Zone automapping mode determine how you want to remap Zones.  The possible choices are:

Root on low note means that the remapped Zones will have the low note set to the root note.

Root on high note means that the remapped Zones will have the high note set to the root note.

Root centered over note range means that the Zones will be remapped so that the root note is centered 
respect the low and high notes (with an exception for the leftmost and rightmost Zones). In Zones two 
notes wide, the low note is set to the root note.

Root centered over note range favoring low is like “Root centered over note range” but with a different 
rounding so that in Zones two notes wide, the high note is set to the root note.

Original map

Optimized map with
 "Root on low note"

Optimized map with
 "Root centered over note range"

Optimized map with
 "Root on high note"
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The When splitting samples trim attack to and When splitting samples trim release to  preferences, let 
you set at which level samples should be trimmed after having been split from a longer audio file. These 
values do not change how the split algorithm works, and are used on each sample segment only after the 
splitting is done.

The MIDI playback mode determines how MIDI playback works when an instrument editor is selected as 
main window. When the “Always use setup definition” setting is selected,  the instrument will play 
transposed and velocity offset as set from setup. When instead the “Only use Setup definition when 
setup is selected” setting is used, instrument transposition and velocity offset will be ignored when 
playing from the instrument editors.

Disable magic pad sound lets you disable the sound emitted by magic pads when dragging some files  
over them.

Search engine preferences
These preferences deal with how and where Keymap searches for samples when loading instruments.
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Keymap uses many different search methods, and you can set the order in which these methods are used. 
from this preferences page, even if normally all you need to do is add the paths to the folders and drives 
where you keep sample files.

Page 315





APPENDIX A
Structure of a Keymap Project file (.kmp)
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APPENDIX B
Structure of an EXS24 instrument file (.exs)
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APPENDIX C
Table of MIDI notes, frequencies  and single cycle periods at 44.1Khz 

MIDI 
Note

Note 
Name

Frequency 
(Hz)

Period in 
samples at 
44.1Khz

0 C-2 8.18 5393.97

1 C#-2 8.66 5091.23

2 D-2 9.18 4805.48

3 D#-2 9.72 4535.77

4 E-2 10.30 4281.19

5 F-2 10.91 4040.91

6 F#-2 11.56 3814.11

7 G-2 12.25 3600.04

8 G#-2 12.98 3397.99

9 A-2 13.75 3207.27

10 A#-2 14.57 3027.26

11 B-2 15.43 2857.35

12 C-1 16.35 2696.98

13 C#-1 17.32 2545.61

14 D-1 18.35 2402.74

15 D#-1 19.45 2267.88

16 E-1 20.60 2140.60

17 F-1 21.83 2020.45
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MIDI 
Note

Note 
Name

Frequency 
(Hz)

Period in 
samples at 
44.1Khz

18 F#-1 23.12 1907.06

19 G-1 24.50 1800.02

20 G#-1 25.96 1698.99

21 A-1 27.50 1603.64

22 A#-1 29.14 1513.63

23 B-1 30.87 1428.68

24 C0 32.70 1348.49

25 C#0 34.65 1272.81

26 D0 36.71 1201.37

27 D#0 38.89 1133.94

28 E0 41.20 1070.30

29 F0 43.65 1010.23

30 F#0 46.25 953.53

31 G0 49.00 900.01

32 G#0 51.91 849.50

33 A0 55.00 801.82

34 A#0 58.27 756.82

35 B0 61.74 714.34

36 C1 65.41 674.25

37 C#1 69.30 636.40
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MIDI 
Note

Note 
Name

Frequency 
(Hz)

Period in 
samples at 
44.1Khz

38 D1 73.42 600.68

39 D#1 77.78 566.97

40 E1 82.41 535.15

41 F1 87.31 505.11

42 F#1 92.50 476.76

43 G1 98.00 450.01

44 G#1 103.83 424.75

45 A1 110.00 400.91

46 A#1 116.54 378.41

47 B1 123.47 357.17

48 C2 130.81 337.12

49 C#2 138.59 318.20

50 D2 146.83 300.34

51 D#2 155.56 283.49

52 E2 164.81 267.57

53 F2 174.61 252.56

54 F#2 185.00 238.38

55 G2 196.00 225.00

56 G#2 207.65 212.37

57 A2 220.00 200.45
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MIDI 
Note

Note 
Name

Frequency 
(Hz)

Period in 
samples at 
44.1Khz

58 A#2 233.08 189.20

59 B2 246.94 178.58

60 C3 261.63 168.56

61 C#3 277.18 159.10

62 D3 293.66 150.17

63 D#3 311.13 141.74

64 E3 329.63 133.79

65 F3 349.23 126.28

66 F#3 369.99 119.19

67 G3 392.00 112.50

68 G#3 415.30 106.19

69 A3 440.00 100.23

70 A#3 466.16 94.60

71 B3 493.88 89.29

72 C4 523.25 84.28

73 C#4 554.37 79.55

74 D4 587.33 75.09

75 D#4 622.25 70.87

76 E4 659.26 66.89

77 F4 698.46 63.14

Page 322 



MIDI 
Note

Note 
Name

Frequency 
(Hz)

Period in 
samples at 
44.1Khz

78 F#4 739.99 59.60

79 G4 783.99 56.25

80 G#4 830.61 53.09

81 A4 880.00 50.11

82 A#4 932.33 47.30

83 B4 987.77 44.65

84 C5 1046.50 42.14

85 C#5 1108.73 39.78

86 D5 1174.66 37.54

87 D#5 1244.51 35.44

88 E5 1318.51 33.45

89 F5 1396.91 31.57

90 F#5 1479.98 29.80

91 G5 1567.98 28.13

92 G#5 1661.22 26.55

93 A5 1760.00 25.06

94 A#5 1864.66 23.65

95 B5 1975.53 22.32

96 C6 2093.00 21.07

97 C#6 2217.46 19.89
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MIDI 
Note

Note 
Name

Frequency 
(Hz)

Period in 
samples at 
44.1Khz

98 D6 2349.32 18.77

99 D#6 2489.02 17.72

100 E6 2637.02 16.72

101 F6 2793.83 15.78

102 F#6 2959.96 14.90

103 G6 3135.96 14.06

104 G#6 3322.44 13.27

105 A6 3520.00 12.53

106 A#6 3729.31 11.83

107 B6 3951.07 11.16

108 C7 4186.01 10.54

109 C#7 4434.92 9.94

110 D7 4698.64 9.39

111 D#7 4978.03 8.86

112 E7 5274.04 8.36

113 F7 5587.65 7.89

114 F#7 5919.91 7.45

115 G7 6271.93 7.03

116 G#7 6644.88 6.64

117 A7 7040.00 6.26
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MIDI 
Note

Note 
Name

Frequency 
(Hz)

Period in 
samples at 
44.1Khz

118 A#7 7458.62 5.91

119 B7 7902.13 5.58

120 C8 8372.02 5.27

121 C#8 8869.85 4.97

122 D8 9397.27 4.69

123 D#8 9956.06 4.43

124 E8 10548.08 4.18

125 F8 11175.30 3.95

126 F#8 11839.82 3.72

127 G8 12543.86 3.52
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APPENDIX D
Definitions for terminology used in this guide

Sample segment: a section of a sample, delimited by a start and an end position. Often used for referring 
to an individual sound within a longer sample.

Harmonic samples: samples containing a single sound, with a clearly defined and reasonably steady 
fundamental, and little inharmonic or noise content. Rhythmic loops, audio effects, song snippets, drums 
are not harmonic samples. 
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APPENDIX E
Default key commands

View Command Key

Matrix View Swap last two played notes *    

Matrix View Swap sample to the left <    

Matrix View Swap sample to the right  >    

Matrix View Select Zones at left CursorLeft    

Matrix View Extend selection to Zones at left CursorLeft ⇧   

Matrix View Move Zones left one octave CursorLeft  ⌥  

Matrix View Move Zones of 1 semitone to left CursorLeft ⇧ ⌥  

Matrix View Move layer left one octave CursorLeft  ⌥ ^

Matrix View Move left of 1 semitone (no root) CursorLeft ⇧ ⌥ ^

Matrix View Select Zones at right CursorRight    

Matrix View Extend selection to Zones at right CursorRight ⇧   

Matrix View Move Zones right one octave CursorRight  ⌥  

Matrix View Move Zones of 1 semitone to right CursorRight ⇧ ⌥  

Matrix View Move layer right one octave CursorRight  ⌥ ^

Matrix View Move right of 1 semitone (no root) CursorRight ⇧ ⌥ ^

Matrix View Select Zones with higher velocity CursorUp    

Matrix View Extend selection to Zones with higher velocity CursorUp ⇧   

Matrix View Switch to upper layer CursorUp  ⌥  

Matrix View Move Zones to upper layer CursorUp ⇧ ⌥  

Matrix View Move whole instrument up of one octave CursorUp  ⌥ ^

Matrix View Select Zones with lower velocity CursorDown    
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View Command Key

Matrix View Extend selection to Zones with lower velocity CursorDown ⇧   

Matrix View Switch to lower layer CursorDown  ⌥  

Matrix View Move Zones to lower layer CursorDown ⇧ ⌥  

Matrix View Move whole instrument down of one octave CursorDown  ⌥ ^

Matrix View Delete selected Zones Backspace    

Matrix View Delete selected Zones Delete    

Matrix View Convert Zones to templates A    

Matrix View Simplify mapping Y    

Matrix View Simplify mapping without expanding Y ⇧   

Matrix View Expand Zones U    

Matrix View Set loop start and end from sample file data I    

Matrix View Remap optimized to minimize maximum transposition O    

Matrix View Parametric loop search P    

Matrix View Mark playing Zones for remove J    

Matrix View Mark selected Zones for remove J ⇧   

Matrix View Remove J  ⌥  

Matrix View Clear all Zones marked for remove J ⇧ ⌥  

Matrix View Mark playing Zones for keep K    

Matrix View Mark selected Zones for keep K ⇧   

Matrix View Keep K  ⌥  

Matrix View Keep K ⇧ ⌥  

Matrix View Create new layer L    

Matrix View Duplicate layer D    

Matrix View Delete layer D  ⌥  
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View Command Key

Matrix View Automap using sample file mappings F  ⌥  

Matrix View Remap to single root notes G    

Matrix View Remap to white keys Q    

Matrix View Remap to black keys W    

Matrix View Remap to all keys E    

Matrix View Remap with range R    

Matrix View Remap velocities T    

Matrix View Clear Zone fades Z    

Matrix View Creade note fades X    

Matrix View Creade velocity fades C    

Matrix View Creade note and velocity fades V    

Matrix View Open in sample editor S    

Matrix View Autophase start B    

Matrix View Autophase loop start B  ⌥  

Matrix View Set start to loop start B ⇧ ⌥  

Matrix View Merge with lower layer M    

Matrix View Autophase end N    

Matrix View Autophase loop end N  ⌥  

Matrix View Set end to loop end N ⇧ ⌥  

Matrix View Play Zone SpaceBar    

Matrix View Play Zone from start SpaceBar ⇧   

Matrix View Play Zone from last played position SpaceBar  ⌥  

Matrix View Toggle mute for selected layer F3    

Matrix View Toggle mute for all layers F3  ⌥  
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View Command Key

Matrix View Toggle single solo for current layer F4    

Matrix View Toggle solo for selected layer F4 ⇧   

Matrix View Toggle solo for all layers F4  ⌥  

Matrix View Toggle background view for selected layer F5    

Matrix View Toggle background view for all layers F5  ⌥  

Matrix View Show Resources window 3   ^

Sample View Play SpaceBar    

Sample View Play from start SpaceBar ⇧   

Sample View Play from last position SpaceBar  ⌥  

Sample View Toggle audition mode A    

Sample View Learn audition time A ⇧   

Sample View Scramble remix selected slices U    

Sample View Set loop start and end from sample file I    

Sample View Rephase loop start R    

Sample View Rephase loop start and cut tail R ⇧   

Sample View Trim selection T    

Sample View Trim loop T  ⌥  

Sample View Trim from start to end T ⇧   

Sample View Scroll left CursorLeft    

Sample View Zoom out CursorLeft  ⌥  

Sample View Shift loop by 1/16th to the left CursorLeft ⇧ ⌥  

Sample View Select slice at left CursorLeft ⇧  ^

Sample View Scroll right CursorRight    

Sample View Zoom in CursorRight  ⌥  
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View Command Key

Sample View Shift loop by 1/16th to the right CursorRight ⇧ ⌥  

Sample View Select slice at right CursorRight ⇧  ^

Sample View Zoom start to end CursorUp    

Sample View Zoom all CursorUp  ⌥  

Sample View Double loop length CursorUp ⇧ ⌥  

Sample View Shift slice content at left CursorUp ⇧  ^

Sample View Zoom loop CursorDown    

Sample View Zoom selection CursorDown  ⌥  

Sample View Halve loop length CursorDown ⇧ ⌥  

Sample View Shift slice content at right CursorDown ⇧  ^

Sample View Zoom selection S    

Sample View Autoloop selection low resolution D    

Sample View Autoloop selection low resolution keeping start D ⇧   

Sample View Autoloop selection high resolution F    

Sample View Autoloop selection high resolution keeping start F ⇧   

Sample View Loop crossfade optimization G    

Sample View Trim selection to sample H    

Sample View Trim start and end to sample J    

Sample View Autoloop single cycle K    

Sample View Move cursor to start Z    

Sample View Move cursor to frame zero Z  ⌥  

Sample View Move cursor to loop start Z ⇧   

Sample View Move cursor to end X    

Sample View Move cursor to last frame X  ⌥  
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View Command Key

Sample View Move cursor to loop end X ⇧   

Sample View Fine tune loop start C    

Sample View Coarse tune loop start C ⇧   

Sample View Fine tune loop end V    

Sample View Coarse tune loop end V ⇧   

Sample View Autophase start B    

Sample View Autophase loop start B  ⌥  

Sample View Set start to loop start B ⇧ ⌥  

Sample View Autophase end N    

Sample View Autophase loop end N  ⌥  

Sample View Set end to loop end N ⇧ ⌥  

Sample View Fine tune whole loop M    

Sample View Coarse tune whole loop M ⇧   

Sample View Toggle loop L    

Sample View Set loop from selection L  ⌥  

Sample View Optimize slices phases O    

Sample View Parametric Autoloop P    

Sample View Split loop in 4 1  ⌥  

Sample View Split loop in 8 2  ⌥  

Sample View Split loop in 16 3  ⌥  

Sample View Split loop in 32 4  ⌥  

Sample View Split loop by transients 5  ⌥  

Sample View Automap loop on current layer sequentially Q    

Sample View Automap loop on current layer using pitch detection Q  ⌥  
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View Command Key

Sample View Automap loop on current layer using midi learn Q ⇧   

Sample View Automap sample on current layer sequentially W    

Sample View Automap sample on current layer using pitch detection W  ⌥  

Sample View Automap sample on current layer using midi learn W ⇧   

Sample View Automap selection on current layer sequentially E    

Sample View Automap selection on current layer using pitch detection E  ⌥  

Sample View Automap selection on current layer using midi learn E ⇧   

Sample View Split slice at cursor Y    

Sample View Remove selected slice Y ⇧   

Sample View Delete selected slice audio data Y  ⌥  

Sample View Slice loop at regular intervals     

Sample View Slice selection at regular intervals     

Sample View Slice loop at transients     

Sample View Slice selection at transients     

Sample View Map slices under selection into layer     

Sample View Map loop slices into layer     

Sample View Create Region from selection =    

Sample View Create autosplit Regions from selection /    

Sample View Snap cursor to rising zero crossing .    

Sample View Snap cursor to grid *    

Layer Table Select all Zones in layer A    

Layer Table Delete layer D    

Layer Table Delete layer Backspace    

Layer Table Delete layer Delete    
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View Command Key

Layer Table Create new layer L    

Layer Table Select higher layer CursorUp  ⌥  

Layer Table Select lower layer CursorDown  ⌥  

Layer Table Merge with lower layer CursorDown ⇧ ⌥  

Layer Table Merge with lower layer M    

Layer Table Select all Zones in layer CursorLeft    

Layer Table Deselect all Zones in layer CursorRight    

Setup View Show Instrument window 2   ^

Project Lower global Keymap volume F1    

Project Raise global Keymap volume F2    

Project Switch to next window F6    

Project Switch to previous window F7    

Project Show Setup window 1   ^

Project Show Resources window 4   ^

Project Show Statistics window 5   ^

Project Show Surround+Space window 6   ^

Project Show Key Commands window 7   ^
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Special thanks go to….  you know who you are, there in the L.A. area.
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things.
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unremitting, nonstop (got the idea?) feedback. Chapeau!
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INDEX

A
aac  :020, 025, 035
absolute  :192, 206, 266, 272, 281
acoustic  :019, 023, 082, 115, 117, 165, 238, 240
activate  :083, 084, 109, 130, 161, 226, 252, 273, 312
active  :026, 030, 037, 060, 062, 082, 101, 105, 106, 111, 112, 157, 158, 161, 162, 164, 165, 172, 

188, 208, 216, 231, 248, 258
add  :020, 021, 022, 023, 024, 030, 033, 034, 035, 036, 048, 049, 065, 068, 076, 077, 090, 095, 

116, 123, 139, 140, 144, 152, 158, 159, 160, 165, 166, 168, 172, 183, 186, 193, 194, 199, 
202, 205, 208, 214, 216, 222, 226, 233, 239, 255, 256, 266, 269, 270, 272, 277, 279, 285, 
290, 292, 293, 294, 297, 298, 299, 312, 315

added  :021, 022, 048, 049, 144, 168, 216, 255, 272, 312
adding  :159, 166, 168, 202, 205, 216, 255, 256, 266, 269, 270, 272, 279, 293, 297, 298
adsr  :173
advance  :026, 029, 036, 080, 165, 184, 276, 289, 291, 293, 296
ahdsr  :173
aiff  :020, 025, 035, 137, 139, 206, 277, 279, 297, 299
algorithm  :022, 023, 042, 111, 112, 117, 138, 205, 206, 234, 240, 284, 285, 314
ambience  :284, 285
ambient  :285
amount  :023, 024, 089, 115, 121, 126, 140, 142, 143, 147, 159, 160, 180, 189, 191, 197, 203, 214, 

238, 244, 246, 264, 335
amplitude  :022, 023, 028, 033, 034, 111, 112, 120, 121, 123, 231, 234, 243, 244, 246, 261
analysis  :053, 054, 112, 113, 118, 137, 138, 142, 144, 231, 235, 236, 241
append  :086, 273, 280, 281, 300, 312, 317, 318, 319, 326, 327
assign  :020, 023, 027, 033, 034, 035, 037, 044, 045, 046, 047, 057, 062, 074, 075, 092, 104, 130, 

137, 155, 156, 158, 161, 165, 172, 173, 175, 179, 194, 260, 263, 278, 280, 287, 292, 303, 
304

attack  :022, 025, 026, 118, 119, 142, 153, 173, 178, 185, 195, 241, 242, 262, 314
attenuation  :277, 283, 284, 285
attshape  :178, 262
audio device  :020, 045, 047, 051, 309
audio preferences  :309
audiofx  :093, 101

Page 337



audition  :026, 086, 195, 196, 197, 330
autobackup  :035, 273, 312
autoloop  :026, 027, 055, 056, 109, 138, 152, 183, 185, 203, 204, 205, 206, 211, 214, 227, 252, 331, 

332
automap  :027, 053, 054, 074, 078, 079, 080, 110, 136, 137, 138, 227, 228, 253, 297, 299, 313, 329, 

332, 333
autophase  :026, 140, 229, 230, 329, 332
autophasing  :229, 230
autosplit  :026, 027, 078, 079, 105, 107, 227, 228, 247, 250, 333
autotrim  :027
autotune  :153, 214
autotuning  :152, 214, 275
autozoom  :028, 029, 188, 191, 192, 193
aux  :037, 038, 041, 057, 061, 062, 104, 105, 106, 111, 113, 118, 163, 164, 176, 187, 194, 236, 

241, 289, 298
axis  :079, 085, 090, 091, 092, 110, 133, 134, 135, 138, 139, 140, 146, 158, 228, 232, 253
azimuth  :284, 285, 286

B
background  :028, 070, 204, 330
backspace  :069, 108, 251, 294, 328, 333
backup  :035, 273, 312, 313
bar  :029, 043, 104, 168, 195, 203, 204, 210, 218, 226, 290, 306, 329, 330
beat  :204, 221, 226
bend  :034, 062, 156, 164, 165, 233, 264, 271
bending  :264
bitdepth  :277
blend  :088, 092, 159, 160, 202
border  :024, 027, 074, 082, 089, 100, 166, 217, 218, 221, 226, 258
boundaries  :205, 218, 221
boundary  :195
box  :037, 059, 070, 098, 100, 103, 112, 113, 115, 116, 117, 119, 142, 143, 146, 152, 166, 167, 

170, 171, 192, 214, 234, 236, 238, 239, 240, 242, 256, 272, 273, 275, 277, 280, 285, 290, 
306, 312

bpm  :203
build  :022, 023, 027, 028, 033, 034, 051, 077, 115, 151, 183, 213, 238, 277, 300, 305
built  :027, 031, 035, 036, 056, 057, 090, 146, 147, 179, 180, 217, 263, 268, 277, 279, 287
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bus  :034, 042, 047, 094, 095, 096, 097, 175, 267, 281, 283, 284, 285, 286, 287

C
cable  :166, 167, 168
caches  :281
cancel  :270, 304
center  :089, 095, 113, 116, 118, 128, 136, 191, 199, 215, 233, 236, 239, 241, 258, 283, 286, 313
cents  :037, 113, 116, 180, 236, 239, 275
chain  :027, 034, 057, 063, 081, 101, 112, 156, 165, 166, 167, 168, 169, 170, 183, 185, 218, 235, 

260
channel  :019, 020, 021, 028, 034, 093, 094, 095, 096, 097, 156, 171, 175, 232, 276, 285, 287, 309, 

310
chapter  :031, 033, 034, 047, 051, 057, 069, 073, 086, 089, 096, 098, 105, 111, 125, 141, 145, 151, 

155, 177, 183, 187, 201, 217, 223, 227, 229, 231, 247, 255, 267, 283, 289, 303, 305, 309
checkbox  :070, 098, 100, 103, 112, 113, 115, 116, 117, 119, 142, 143, 146, 152, 170, 171, 192, 214, 

234, 236, 238, 239, 240, 242, 256, 272, 273, 275, 277, 280, 285, 290, 306, 312
chunk  :036, 275
clear  :023, 033, 037, 083, 086, 091, 108, 137, 139, 169, 203, 251, 291, 294, 326, 328, 329
clipboard  :304
clipped  :137
clipping  :275
clone  :271
close  :037, 051, 077, 080, 081, 156, 165, 167, 184, 185, 255
coarse  :211, 212, 332
color  :024, 063, 074, 086, 105, 106, 143, 160, 167, 174, 188, 189, 190, 194, 201, 218, 219, 233, 

247, 248, 257, 260
column  :169, 290, 295, 310
combination  :223, 294, 304
combine  :019, 023, 029, 040, 089, 101, 137, 176, 207, 226, 231, 255, 258, 272, 279, 291, 292, 294, 

296, 300
compressed  :020, 035
computer  :019, 020, 022, 065, 083, 192, 309, 310
concatenation  :292, 294
condition  :031, 034, 155, 156, 157, 162, 163, 164, 165, 272
configurable  :023, 088, 101
configuration  :020, 042, 283
connect  :027, 036, 046, 065, 146, 166, 167, 168
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controller  :025, 026, 027, 028, 031, 034, 047, 062, 092, 156, 159, 160, 162, 163, 164, 177, 180, 181, 
198, 261, 264

copy  :021, 031, 034, 045, 067, 109, 112, 149, 217, 218, 221, 222, 235, 252, 258, 304
corner  :024, 082, 141, 142, 258
correction  :023, 024, 025, 114, 115, 116, 142, 143, 144, 233, 237, 238, 275
correlation  :151
cpu  :020, 120, 193, 243, 312
crossing  :026, 073, 140, 152, 204, 214, 229, 230, 333
crossfade  :024, 028, 029, 034, 035, 059, 071, 088, 089, 090, 092, 100, 103, 112, 120, 122, 131, 139, 

141, 152, 158, 159, 160, 177, 187, 189, 193, 201, 202, 212, 214, 216, 218, 226, 235, 243, 
245, 261, 266, 271, 275, 276, 277, 331

c-shaped  :147
ctrl  :037, 057, 062, 156, 159, 162, 163, 176
cue  :286
cursor  :022, 026, 028, 029, 063, 065, 083, 089, 104, 105, 106, 118, 152, 160, 163, 164, 165, 167, 

168, 176, 183, 187, 188, 189, 190, 193, 194, 195, 196, 197, 198, 199, 201, 203, 206, 207, 
214, 219, 226, 233, 241, 247, 248, 257, 265, 290, 327, 328, 330, 331, 332, 333, 334

curve  :024, 100, 145, 147, 148, 160, 202
cut  :021, 024, 034, 066, 067, 068, 087, 183, 187, 203, 207, 218, 276, 330
cycle  :025, 026, 061, 151, 152, 153, 204, 206, 213, 214, 257, 275, 313, 319, 331

D
database  :030, 048, 049, 269
date  :029, 030, 049, 056, 115, 143, 163, 165, 167, 190, 192, 194, 238, 258, 269, 278, 280, 281, 

293, 297, 298, 300, 306, 312
dblinear  :177, 261
dcy  :172
decay  :022, 029, 122, 172, 173, 178, 191, 231, 245, 262
decibel  :097, 122, 177, 179, 245, 261, 263
delete  :024, 068, 069, 096, 108, 147, 157, 166, 170, 222, 251, 255, 259, 260, 266, 272, 328, 333
demo  :051, 167
depth  :098, 277, 307
deselect  :084, 140, 174, 290, 334
desktop  :270
destination  :027, 034, 087, 094, 183, 286, 300
destructive  :021, 022, 025, 031, 032, 034, 055, 101, 103, 121, 142, 187, 217, 218, 244, 300
detach  :169, 170
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detail  :019, 033, 034, 065, 068, 104, 146, 183, 207, 208, 310, 335
detect  :027, 077, 078, 081, 108, 110, 113, 137, 185, 220, 224, 225, 227, 236, 251, 253, 300, 332, 

333
detection  :027, 077, 078, 081, 110, 185, 224, 225, 227, 253, 332, 333
de-tuning  :115, 238
deviation  :113, 115, 232, 236, 238
device  :020, 045, 047, 051, 198, 309, 310
difference  :024, 034, 092, 114, 122, 132, 141, 143, 146, 180, 190, 202, 222, 237, 245, 264, 307
disable  :045, 051, 098, 100, 115, 116, 117, 118, 119, 120, 142, 146, 177, 193, 197, 203, 238, 239, 

240, 241, 242, 243, 256, 260, 261, 267, 285, 286, 290, 306, 314
disk  :020, 021, 030, 034, 035, 187, 221, 259, 268, 269, 281, 299, 305, 307
display  :024, 028, 029, 030, 037, 043, 059, 061, 063, 064, 065, 068, 070, 073, 086, 089, 092, 106, 

113, 118, 119, 120, 142, 143, 146, 158, 160, 166, 167, 174, 188, 189, 190, 191, 192, 193, 
194, 199, 201, 215, 216, 218, 221, 232, 236, 241, 242, 243, 248, 257, 265, 266, 269, 271, 
276, 286, 304, 305, 312

distance  :097, 233, 284, 285, 286
divide  :061, 093, 155, 217, 221, 222, 226, 279, 306
docfolder  :280
document  :281
drag  :024, 025, 027, 028, 052, 057, 059, 064, 066, 067, 068, 074, 078, 080, 082, 083, 089, 147, 

148, 153, 160, 163, 165, 166, 167, 170, 175, 183, 193, 194, 195, 197, 198, 201, 216, 221, 
223, 233, 255, 256, 258, 266, 272, 274, 277, 286, 294, 299, 314

draw  :022, 023, 065, 074, 075, 083, 111, 113, 118, 119, 145, 160, 174, 190, 215, 229, 233, 241, 
242

drive  :030, 035, 048, 049, 270, 279, 284, 285, 300, 315
drum  :022, 023, 077, 078, 081, 082, 101, 103, 123, 138, 185, 203, 246, 285, 326
dsp  :026
duplicate  :069, 075, 083, 175, 222, 258, 260, 277, 328
duration  :025
dynamic  :022, 024, 029, 034, 036, 057, 059, 060, 069, 092, 123, 145, 146, 148, 149, 158, 159, 160, 

177, 179, 180, 192, 246, 261, 264, 266, 271, 272, 312

E
editing  :019, 020, 022, 023, 025, 026, 028, 032, 034, 035, 037, 082, 104, 105, 112, 120, 146, 160, 

165, 166, 174, 176, 183, 193, 194, 206, 207, 218, 221, 233, 235, 243, 257, 258, 260, 306, 
312
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effect  :019, 022, 023, 024, 029, 078, 089, 101, 122, 126, 127, 130, 138, 146, 151, 193, 213, 216, 
222, 245, 258, 273, 285, 310, 326

element  :031, 032, 033, 034, 036, 057, 058, 068, 093, 104, 105, 155, 187, 188, 247, 255, 257, 258, 
266, 267, 289, 312

elevation  :283, 284, 285, 286
embedded  :027, 037, 074, 137, 139
enable  :026, 029, 064, 068, 081, 084, 092, 098, 100, 103, 105, 111, 112, 113, 115, 116, 117, 118, 

119, 120, 138, 139, 142, 146, 152, 161, 162, 164, 171, 177, 185, 187, 191, 192, 193, 195, 
197, 198, 202, 203, 214, 217, 218, 219, 224, 231, 234, 235, 236, 238, 239, 240, 241, 242, 
243, 247, 255, 256, 260, 261, 266, 270, 277, 280, 285, 286, 290, 311, 312

energy  :122, 245
engine  :019, 020, 021, 022, 024, 028, 030, 045, 048, 067, 082, 083, 111, 112, 117, 118, 122, 231, 

234, 235, 240, 241, 245, 268, 269, 284, 309, 310, 314
enhancer  :101
enhancing  :233
envelope  :022, 023, 024, 028, 033, 034, 038, 039, 040, 057, 059, 062, 111, 112, 113, 114, 115, 118, 

119, 120, 121, 123, 145, 146, 147, 148, 149, 155, 172, 173, 174, 175, 178, 180, 188, 231, 
232, 233, 236, 237, 238, 241, 242, 243, 246, 255, 261, 262, 266, 271, 272

environment  :019, 256
eqlpower  :177, 261
eqpower  :100, 218
equalpower  :284, 285
erase  :065, 083, 170
esc  :020, 037, 046, 051, 078, 096, 104, 111, 160, 203, 268, 304
event  :162, 256, 258, 298
example  :022, 023, 026, 029, 031, 061, 068, 074, 077, 079, 080, 082, 090, 101, 123, 130, 137, 141, 

151, 155, 159, 161, 165, 174, 184, 203, 204, 213, 217, 221, 226, 227, 272, 277, 279, 293, 
296

expand  :022, 023, 027, 077, 128, 132, 133, 134, 135, 221, 223, 233, 328
export  :019, 020, 021, 035, 070, 071, 123
exs  :019, 020, 021, 030, 031, 032, 033, 034, 035, 047, 055, 070, 071, 090, 094, 095, 096, 097, 

100, 101, 103, 112, 123, 144, 155, 165, 171, 173, 175, 177, 180, 201, 235, 246, 255, 256, 
259, 261, 266, 267, 271, 272, 274, 275, 276, 277, 281, 283, 287, 297, 309, 313, 318, 335

exsmanager  :030
extend  :026, 028, 032, 083, 085, 088, 089, 156, 159, 177, 261, 327, 328
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F
factor  :028, 071, 113, 178, 190, 192, 202, 205, 212, 218, 236, 262
fade  :021, 024, 028, 029, 034, 035, 059, 062, 071, 088, 089, 090, 091, 092, 093, 100, 102, 103, 

104, 105, 112, 120, 122, 131, 139, 141, 152, 158, 159, 160, 177, 180, 187, 188, 189, 193, 
196, 201, 202, 212, 214, 216, 218, 226, 235, 243, 245, 247, 261, 266, 271, 275, 276, 277, 
329, 331

field  :022, 042, 096, 101, 269, 274, 277, 279, 283, 284, 285, 286, 289, 291, 292, 294, 296, 298, 
303

file  :019, 020, 021, 022, 027, 028, 030, 032, 034, 035, 036, 048, 052, 055, 068, 069, 070, 074, 
075, 076, 078, 080, 101, 112, 121, 137, 138, 139, 141, 144, 185, 187, 194, 201, 206, 217, 
221, 235, 244, 255, 256, 259, 267, 268, 269, 270, 271, 273, 274, 276, 277, 278, 280, 281, 
287, 289, 293, 297, 298, 299, 300, 301, 307, 314, 315, 317, 318, 328, 329, 330

filenames  :027
fill  :027, 029, 034, 045, 073, 074, 077, 100, 126, 128, 131, 132, 133, 134, 135, 222, 223, 294
filter  :019, 023, 101, 123, 246, 266, 271, 272, 284, 285
finder  :074, 183, 255, 299, 300
finetune  :098
flat  :118, 191, 241
folder  :025, 029, 030, 048, 049, 051, 074, 268, 269, 270, 273, 274, 277, 279, 280, 281, 299, 300, 

312, 315
formant  :022, 023, 025, 111, 117, 231, 232, 234, 240
format  :019, 020, 021, 029, 035, 037, 043, 055, 056, 063, 064, 070, 071, 090, 092, 095, 100, 101, 

112, 123, 137, 138, 139, 144, 180, 206, 231, 235, 256, 267, 269, 271, 272, 273, 274, 275, 
276, 277, 287, 297, 298, 299, 305, 313

forward  :063, 083, 198, 209, 216, 269
fractional  :151, 213
frame  :298, 331
freeze  :022, 122, 231, 245

G
gain  :029, 046, 055, 077, 123, 141, 142, 159, 163, 164, 165, 176, 193, 196, 197, 198, 221, 246, 

256, 270, 281, 296, 300, 301
garageband  :020
grid  :311, 333
group  :023, 025, 027, 028, 031, 032, 033, 034, 038, 045, 057, 060, 062, 063, 064, 074, 081, 094, 

096, 098, 099, 125, 137, 155, 156, 157, 158, 159, 160, 161, 162, 163, 164, 165, 166, 167, 
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168, 169, 170, 171, 172, 173, 174, 175, 176, 177, 185, 256, 258, 259, 261, 267, 278, 279, 
280, 290, 292, 298

guide  :020, 024, 044, 045, 046, 065, 068, 073, 102, 111, 206, 265, 266, 326

H
half  :119, 216, 221, 242
hand  :019, 035, 051, 060, 066, 068, 082, 104, 111, 119, 133, 165, 170, 205, 233, 242, 256, 266, 

270, 272, 275, 312
hand-drawn  :119, 233, 242
handle  :019, 060, 066, 068, 111, 165, 205, 256, 266, 272, 275, 312
hardware  :033, 309
harmonic resynthesis  :019, 022, 023, 039, 111, 112, 113, 114, 116, 117, 118, 119, 120, 121, 122, 

123, 187, 231, 234, 235, 236, 237, 239, 240, 241, 242, 243, 244, 245, 276
harmonies  :023
hertz  :037, 151, 213, 272
hierarchy  :033
high  :023, 027, 028, 029, 053, 063, 078, 080, 081, 082, 085, 087, 098, 101, 109, 111, 113, 114, 

117, 129, 131, 132, 136, 137, 138, 143, 157, 159, 160, 163, 164, 166, 179, 180, 185, 188, 
190, 192, 198, 201, 205, 219, 228, 232, 233, 234, 236, 237, 240, 252, 260, 263, 264, 265, 
269, 278, 279, 280, 285, 286, 292, 312, 313, 327, 331, 334

higher  :023, 085, 087, 113, 114, 129, 179, 232, 236, 237, 263, 265, 327, 334
highest  :131, 132, 143, 192
highlight  :053, 063, 188, 198, 201, 219, 233, 286
highnote  :157, 260
highpass  :101
highres  :205
highvel  :157, 260
hires  :138
hit  :027, 079, 080, 081, 098, 126, 127, 148, 156, 184, 185, 228, 312, 329
hold  :026, 029, 033, 034, 064, 066, 073, 074, 075, 083, 084, 103, 113, 148, 159, 160, 173, 174, 

175, 193, 194, 195, 197, 198, 203, 219, 221, 226, 233, 236, 257, 258, 271
hole  :022, 023, 024, 025, 027, 056, 059, 071, 079, 082, 087, 092, 119, 122, 125, 137, 145, 146, 

148, 155, 157, 158, 160, 161, 163, 164, 165, 178, 179, 189, 193, 199, 201, 203, 211, 212, 
218, 227, 228, 242, 255, 262, 263, 264, 277, 327, 328, 332

horizontal  :028, 065, 067, 068, 083, 113, 118, 134, 190, 193, 216, 232, 236, 241, 257, 266
hr-a  :023, 111, 117, 234, 240
hr-b  :023, 111, 234
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hr-c  :023, 111
hrtf  :284, 285
hyphen  :278, 280, 292, 294
hz  :151, 213, 319, 320, 321, 322, 323, 324, 325

I
icon  :192
imbedded  :076
import  :019, 020, 030, 033, 034, 036, 038, 057, 060, 061, 066, 069, 083, 090, 092, 111, 123, 141, 

146, 156, 158, 161, 187, 190, 195, 204, 215, 231, 255, 256, 258, 259, 260, 266, 272, 280, 
283, 297, 298, 305, 307, 311

inharmonic  :023, 326
input  :283, 284
insert  :019, 128, 222
inside  :031, 032, 034, 035, 036, 065, 083, 138, 139, 162, 164, 175, 190, 194, 198, 204, 205, 207, 

215, 218, 286, 287
inspector  :023, 037, 057, 059, 060, 061, 065, 068, 083, 089, 092, 093, 096, 097, 104, 111, 119, 121, 

122, 142, 146, 152, 153, 159, 166, 170, 171, 172, 177, 187, 195, 216, 218, 234, 242, 244, 
255, 257, 258, 259, 261, 265, 286, 289, 298, 311, 312

installation  :051
instance  :292
instrument  :019, 020, 021, 022, 023, 024, 025, 027, 028, 031, 032, 033, 034, 035, 036, 037, 038, 040, 

041, 046, 051, 052, 054, 055, 056, 057, 058, 059, 060, 061, 063, 069, 070, 073, 076, 078, 
079, 080, 081, 082, 088, 090, 092, 095, 100, 101, 112, 113, 115, 117, 118, 122, 125, 131, 
137, 141, 145, 151, 155, 157, 158, 165, 166, 171, 172, 173, 176, 177, 180, 183, 184, 185, 
187, 194, 204, 213, 222, 223, 234, 238, 240, 241, 245, 255, 256, 257, 258, 259, 260, 261, 
265, 266, 267, 268, 269, 270, 271, 272, 273, 274, 275, 276, 278, 280, 281, 283, 289, 290, 
291, 292, 293, 294, 295, 297, 298, 299, 305, 307, 311, 312, 314, 318, 327, 328, 334

interface  :026, 166, 205
intersect  :098, 137, 157, 257
interval  :025, 027, 219, 333
inverse  :022, 024
invert  :084, 265, 312

J
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jack  :167
jacks  :167
jump  :024, 088, 103, 122, 158, 188, 195, 196, 201, 245

K
keep  :024, 027, 029, 035, 075, 086, 087, 095, 098, 100, 101, 105, 112, 118, 148, 161, 165, 166, 

174, 205, 235, 241, 247, 256, 266, 272, 275, 281, 290, 300, 305, 310, 315, 328, 331
key  :019, 020, 021, 023, 024, 025, 026, 027, 028, 029, 030, 031, 032, 033, 034, 035, 036, 037, 

038, 042, 044, 045, 046, 047, 048, 051, 053, 055, 056, 057, 058, 063, 064, 065, 066, 067, 
068, 069, 073, 074, 075, 076, 077, 078, 079, 080, 081, 082, 083, 084, 085, 086, 088, 089, 
090, 092, 093, 095, 100, 101, 103, 104, 105, 107, 108, 109, 111, 112, 113, 114, 118, 121, 
122, 123, 124, 126, 127, 130, 131, 137, 138, 139, 140, 141, 142, 144, 145, 146, 148, 151, 
152, 155, 156, 157, 158, 159, 160, 161, 162, 163, 164, 165, 166, 167, 169, 170, 171, 172, 
173, 174, 176, 177, 179, 180, 183, 184, 185, 187, 188, 190, 191, 192, 193, 194, 195, 197, 
198, 199, 201, 202, 203, 204, 205, 206, 211, 213, 214, 217, 218, 219, 220, 221, 222, 223, 
224, 225, 226, 227, 231, 233, 234, 235, 236, 237, 241, 244, 245, 246, 247, 250, 251, 252, 
255, 256, 257, 258, 261, 263, 265, 266, 267, 268, 269, 270, 271, 272, 273, 274, 275, 276, 
277, 279, 281, 283, 287, 290, 291, 292, 294, 295, 297, 298, 299, 300, 301, 303, 304, 305, 
307, 309, 310, 311, 312, 314, 315, 317, 327, 328, 329, 330, 331, 332, 333, 334

keyboard  :023, 025, 027, 028, 029, 033, 053, 057, 058, 063, 064, 065, 073, 077, 083, 084, 086, 108, 
123, 130, 145, 146, 158, 159, 160, 161, 172, 179, 183, 188, 203, 223, 224, 225, 226, 251, 
255, 256, 263, 265, 312

key command  :036, 037, 044, 045, 046, 077, 086, 104, 151, 190, 195, 197, 199, 211, 213, 219, 226, 255, 
257, 303, 304, 327, 334

keys   :025, 027, 029, 046, 063, 069, 082, 083, 084, 085, 179, 198, 226, 263, 265, 303, 304, 329
keyswitch  :028, 031, 034, 064, 080, 081, 156, 161, 162, 184, 185
khz  :151, 213, 319, 320, 321, 322, 323, 324, 325
kmp  :032, 035, 256, 267, 273, 317
knob  :153, 162

L
layer  :023, 024, 025, 028, 032, 033, 034, 035, 038, 041, 052, 057, 058, 059, 063, 064, 065, 066, 

068, 069, 070, 071, 073, 074, 075, 077, 078, 079, 082, 083, 084, 086, 087, 088, 089, 099, 
101, 110, 111, 112, 122, 125, 126, 127, 128, 131, 136, 137, 141, 142, 144, 145, 146, 148, 
149, 156, 157, 158, 159, 161, 165, 166, 171, 176, 183, 185, 203, 222, 223, 224, 225, 226, 
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227, 228, 253, 255, 257, 258, 259, 267, 277, 278, 280, 283, 290, 293, 298, 327, 328, 329, 
330, 332, 333, 334

layout  :037, 048, 052, 065, 255, 265, 312
lead  :179, 212, 263, 266, 300, 307
learn  :025, 037, 056, 077, 197, 223, 224, 225, 303, 330, 333
left   :034, 063, 082, 083, 085, 088, 090, 095, 100, 105, 113, 124, 129, 147, 166, 167, 197, 198, 

199, 210, 215, 216, 221, 226, 236, 248, 286, 310, 327, 330, 331, 334
leftmost  :078, 083, 126, 127, 136, 313
level  :026, 032, 033, 034, 065, 068, 078, 080, 081, 103, 110, 122, 141, 142, 160, 173, 179, 185, 

190, 192, 193, 197, 198, 216, 227, 228, 229, 245, 253, 259, 263, 265, 266, 269, 275, 314
levels  :026, 065, 078, 080, 081, 103, 141, 185, 192, 197, 216, 265, 269
lfo  :180, 266, 271, 272
lighter  :086, 131
limit   :033, 156, 157, 281
limitation  :020, 028, 033, 035, 095, 105, 173, 247, 258, 266, 281
limited  :022, 105, 247, 292, 298, 326
limiting  :026, 162, 277
limits  :275
line  :052, 068, 083, 100, 103, 113, 118, 120, 146, 147, 148, 177, 189, 191, 202, 217, 218, 219, 

229, 236, 241, 243, 261
linear  :100, 103, 148, 177, 202, 218, 261
linked  :062, 094, 100, 176
list   :086, 290, 304
listener  :285, 286
livedb  :030, 048, 049, 269
load  :019, 020, 023, 027, 030, 032, 033, 037, 049, 051, 074, 090, 183, 194, 267, 268, 269, 272, 

281, 300, 304, 310, 311, 314
loaded  :020, 030, 037, 268, 269, 272, 304
loading  :183, 267, 272, 304, 310, 314
locate  :270
location  :048, 268, 269, 270, 274, 277, 281, 285
locations  :048, 268, 269, 270, 277
lock  :192, 277
logfolder  :280
loop  :019, 020, 021, 022, 023, 025, 026, 027, 029, 031, 034, 035, 036, 039, 054, 055, 056, 061, 

102, 103, 104, 105, 109, 112, 118, 119, 120, 122, 123, 138, 139, 140, 151, 152, 153, 183, 
185, 186, 187, 188, 189, 190, 195, 196, 199, 201, 202, 203, 204, 205, 206, 207, 208, 209, 
210, 211, 212, 213, 214, 215, 216, 218, 219, 220, 221, 222, 223, 224, 225, 226, 227, 229, 
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230, 235, 241, 242, 243, 245, 246, 247, 252, 275, 277, 289, 290, 297, 298, 313, 326, 328, 
329, 330, 331, 332, 333

loopenable  :103, 105, 247
loopend  :103, 105, 247
loopstart  :103, 105, 247
looptune  :152
loopxfade   :247
loopxfadeshape  :103, 105, 247
low   :019, 022, 023, 027, 029, 034, 037, 057, 061, 063, 064, 068, 082, 086, 093, 098, 101, 109, 

117, 118, 129, 136, 137, 138, 159, 160, 161, 163, 164, 178, 179, 180, 196, 197, 205, 222, 
232, 240, 241, 252, 260, 262, 264, 265, 266, 275, 278, 279, 280, 292, 297, 312, 313, 331

lower  :085, 087, 113, 120, 129, 151, 205, 213, 232, 236, 243, 265, 327, 328, 329, 334
lowest  :131, 132, 143, 180, 192, 264
lownote  :157, 260

M
map   :019, 020, 021, 023, 024, 025, 026, 027, 028, 029, 030, 031, 032, 033, 034, 035, 036, 037, 

044, 045, 046, 047, 048, 051, 053, 055, 056, 057, 063, 064, 066, 067, 068, 073, 074, 075, 
076, 077, 078, 079, 080, 081, 082, 083, 084, 088, 089, 090, 092, 094, 095, 096, 100, 101, 
103, 105, 107, 108, 109, 110, 111, 112, 113, 114, 118, 121, 123, 124, 125, 126, 127, 128, 
129, 130, 131, 132, 133, 134, 135, 136, 137, 138, 139, 140, 141, 142, 144, 145, 146, 151, 
152, 155, 156, 157, 159, 160, 165, 166, 167, 169, 171, 173, 174, 177, 179, 180, 183, 185, 
187, 190, 192, 193, 194, 195, 197, 198, 201, 202, 203, 204, 205, 206, 211, 213, 214, 217, 
218, 219, 220, 222, 223, 224, 225, 226, 227, 228, 231, 233, 234, 235, 236, 237, 241, 246, 
247, 250, 251, 252, 253, 255, 256, 257, 261, 263, 266, 267, 268, 269, 270, 271, 272, 273, 
274, 275, 276, 277, 279, 281, 283, 287, 290, 291, 292, 295, 297, 298, 299, 300, 301, 303, 
304, 305, 307, 309, 310, 311, 312, 313, 314, 315, 317, 328, 329, 332, 333, 334

mapped  :033, 054, 078, 079, 092, 095, 100, 123, 126, 127, 128, 136, 138, 145, 159, 177, 180, 183, 
185, 194, 222, 223, 224, 225, 227, 228, 231, 261, 265, 275, 313

mapping  :019, 020, 024, 027, 029, 031, 034, 036, 054, 059, 069, 074, 076, 078, 080, 093, 098, 100, 
110, 125, 131, 132, 136, 137, 145, 156, 157, 183, 223, 224, 227, 253, 258, 271, 289, 297, 
298, 313, 328, 329

mark   :027, 086, 328
marker  :027, 029
matrix  :019, 033, 052, 054, 057, 058, 059, 063, 064, 065, 068, 069, 070, 073, 074, 075, 082, 083, 

086, 088, 089, 092, 099, 111, 112, 128, 129, 132, 133, 134, 135, 136, 137, 141, 142, 156, 
157, 159, 166, 183, 223, 224, 255, 257, 258, 259, 266, 271, 272, 297, 327, 328, 329, 330
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maximize  :024
maximum  :020, 022, 088, 111, 126, 131, 172, 191, 192, 206, 234, 273, 285, 311, 312, 328
merge  :028, 329, 334
meters  :022, 025, 028, 029, 031, 034, 036, 037, 045, 056, 057, 059, 060, 061, 064, 069, 071, 074, 

075, 081, 082, 083, 087, 088, 090, 091, 093, 098, 100, 101, 102, 104, 105, 106, 108, 109, 
110, 111, 112, 113, 114, 118, 119, 120, 121, 122, 124, 141, 142, 145, 155, 156, 159, 170, 
173, 174, 175, 176, 177, 178, 179, 180, 188, 195, 197, 206, 218, 220, 226, 229, 231, 235, 
237, 241, 242, 243, 244, 247, 248, 251, 252, 253, 255, 256, 258, 259, 260, 261, 262, 263, 
264, 266, 271, 272, 274, 275, 277, 279, 284, 290, 292, 294, 297, 300, 311, 312

microfadein  :103
microfadeout  :103
microfades  :103
midi  :025, 026, 027, 028, 033, 034, 037, 047, 058, 064, 065, 069, 073, 077, 083, 084, 086, 092, 

097, 103, 130, 145, 146, 156, 159, 160, 161, 162, 163, 164, 171, 177, 178, 180, 181, 183, 
188, 203, 223, 224, 225, 256, 257, 258, 261, 262, 265, 278, 279, 280, 292, 312, 314, 319, 
320, 321, 322, 323, 324, 325, 333

milliseconds  :173, 192, 311
minutes  :056
mix   :023, 029, 042, 103, 220, 221, 226, 283, 330
mixer  :042, 094, 096, 097, 101, 276, 283, 287
modeling  :180
modes  :024, 067, 092, 096, 187
modifier  :025, 028, 037, 046, 064, 065, 074, 075, 167, 170, 197, 221, 258, 303, 304
modulation  :019, 092, 158, 159, 162, 181, 266, 271, 272
monitor  :020, 065, 179, 197, 263
mono  :094, 095, 111, 113, 172, 236, 287
mouse  :022, 026, 028, 029, 037, 046, 057, 058, 063, 064, 065, 066, 067, 082, 083, 086, 089, 113, 

160, 163, 165, 167, 168, 170, 175, 183, 189, 193, 194, 195, 196, 198, 216, 219, 221, 233, 
236, 257, 258, 265, 290

move  :025, 026, 027, 028, 034, 048, 068, 082, 086, 087, 096, 123, 126, 127, 128, 129, 132, 140, 
148, 153, 158, 160, 166, 168, 169, 183, 188, 190, 193, 194, 201, 208, 209, 212, 221, 222, 
246, 258, 266, 267, 269, 270, 273, 277, 278, 279, 281, 290, 292, 300, 301, 312, 327, 328, 
331, 332, 333

ms  :022, 023, 027, 030, 037, 042, 060, 077, 078, 081, 082, 095, 101, 103, 111, 122, 131, 138, 
141, 142, 151, 155, 169, 173, 183, 185, 192, 195, 197, 202, 205, 206, 211, 212, 213, 215, 
216, 232, 234, 245, 267, 269, 275, 284, 285, 310, 311, 326

multichannel  :020, 094, 287
multi-note  :078
multi-out  :281
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multi-sample  :088
multi-timbral  :171
multi-velocity  :078, 080, 082, 088, 184, 227
mute  :033, 034, 035, 070, 073, 074, 161, 197, 329

N
name  :025, 027, 029, 034, 036, 037, 046, 051, 053, 056, 061, 068, 074, 137, 138, 141, 183, 258, 

270, 273, 274, 277, 278, 279, 280, 281, 289, 290, 291, 292, 293, 294, 295, 296, 298, 299, 
300, 312, 319, 320, 321, 322, 323, 324, 325

naming  :029, 036, 258, 289, 292, 299
navigate  :028, 029, 061, 083, 226
navigation  :028, 037
near-cycle  :152, 214
negative  :147, 179, 229, 263
node  :146, 147, 148, 174, 175
noise  :326
normalization  :023, 031, 121, 141, 244
normalize  :034, 121, 244
note   :025, 027, 031, 033, 034, 037, 051, 052, 053, 054, 058, 062, 063, 064, 065, 068, 070, 071, 

073, 074, 077, 078, 079, 082, 084, 085, 086, 087, 090, 091, 092, 095, 097, 098, 099, 103, 
110, 112, 113, 119, 126, 127, 128, 129, 130, 131, 133, 134, 136, 137, 138, 139, 141, 151, 
156, 157, 159, 161, 165, 167, 172, 177, 178, 179, 183, 199, 204, 207, 213, 223, 224, 225, 
228, 232, 234, 236, 242, 253, 256, 257, 258, 260, 261, 262, 263, 265, 266, 272, 278, 279, 
280, 290, 292, 293, 294, 295, 298, 299, 304, 309, 312, 313, 319, 320, 321, 322, 323, 324, 
325, 329

noteoff  :172
noteon  :172

O
octave  :023, 025, 074, 097, 125, 179, 263, 327, 328
offset  :028, 033, 034, 062, 116, 155, 173, 174, 175, 239, 258, 260, 271, 314
open  :020, 028, 035, 037, 048, 051, 074, 076, 077, 080, 081, 096, 103, 105, 108, 167, 184, 185, 

194, 220, 222, 223, 247, 251, 255, 256, 257, 267, 268, 271, 285, 289, 290, 291, 293, 296, 
301, 303, 304, 306, 312, 329

optimal  :026, 078, 193, 203
optimization  :212, 331
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optimize  :024, 136, 139, 186, 212, 313, 328, 332
option  :028, 046, 064, 074, 075, 082, 083, 089, 102, 103, 113, 160, 163, 165, 170, 176, 195, 197, 

198, 199, 201, 219, 221, 226, 236, 258, 269, 303
orange  :106, 113, 166, 167, 236, 248
oscillator  :025
output  :020, 042, 047, 093, 094, 096, 155, 175, 229, 267, 281, 283, 285, 287, 309, 310
outs  :037, 047, 052, 065, 077, 120, 179, 190, 215, 243, 263, 265, 276, 309, 310, 312
overlap  :024, 033, 034, 066, 067, 068, 082, 088, 105, 161, 164, 215, 216, 247, 257, 258, 260, 267
overview  :019, 028, 057, 187, 189, 190, 197, 198, 201, 289, 300, 301
overwrite  :124, 281, 300

P
pad  :027, 059, 069, 078, 080, 081, 162, 183, 184, 185, 186, 198, 314
palette  :274, 277, 291, 292, 294
pan   :028, 071, 097, 155, 170, 176, 197, 198, 199, 260, 283
panel  :036, 047, 055, 068, 078, 080, 081, 108, 123, 126, 168, 180, 185, 220, 251, 255, 256, 264, 

266, 268, 270, 273, 274, 275, 276, 291, 293, 294, 296, 299, 304
panner  :285
panning  :074, 097, 108, 251
paradigm  :033
parameter  :022, 025, 026, 028, 029, 031, 034, 036, 037, 045, 056, 057, 059, 060, 061, 064, 069, 071, 

074, 075, 081, 082, 083, 087, 088, 090, 091, 092, 093, 098, 100, 101, 102, 103, 104, 105, 
106, 108, 109, 110, 111, 112, 113, 114, 115, 116, 117, 118, 119, 120, 121, 122, 123, 124, 
136, 141, 142, 145, 151, 152, 155, 156, 159, 170, 172, 173, 174, 175, 176, 177, 178, 179, 
180, 188, 195, 206, 213, 214, 218, 220, 226, 229, 231, 235, 237, 238, 239, 240, 241, 242, 
243, 244, 245, 246, 247, 248, 251, 252, 253, 255, 256, 258, 259, 260, 261, 262, 263, 264, 
266, 267, 269, 271, 272, 274, 275, 277, 278, 279, 280, 284, 285, 286, 290, 291, 292, 294, 
297, 300, 311, 312

parametric  :026, 080, 138, 206, 277, 328, 332
paste  :021, 034, 068, 149, 187, 217, 218, 276
path  :030, 048, 068, 196, 269, 274, 277, 279, 281, 284, 298, 315
pattern  :074
peak  :029, 191, 197, 198, 277, 283, 284, 285, 286
pedal  :162
pen   :020, 035, 037, 051, 065, 075, 076, 077, 083, 096, 156, 167, 168, 185, 194, 196, 247, 255, 

256, 257, 267, 271, 285, 289, 290, 291, 293, 296, 301, 304, 306, 312, 329
pencil  :174
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percentage  :119, 139, 173, 192, 206, 238, 242
percussion  :103, 126, 127, 130
percussive  :142, 203
phase  :026, 084, 085, 119, 140, 152, 153, 173, 178, 202, 207, 208, 214, 229, 230, 242, 262, 292, 

329, 330, 332
phasing  :028, 207, 229, 230
phrases  :077, 078
pitch   :022, 023, 025, 027, 028, 034, 053, 054, 077, 078, 081, 098, 110, 111, 112, 113, 114, 115, 

116, 123, 124, 137, 138, 151, 152, 156, 164, 176, 185, 213, 214, 224, 225, 227, 231, 232, 
233, 236, 237, 238, 239, 241, 253, 264, 266, 267, 271, 275, 332, 333

pitchbend  :062, 156, 164, 165
pitched  :111, 234
pitches  :098, 114, 128, 237
pitchshift  :111, 231
placeholder  :026, 034, 073, 074, 084, 271
play   :023, 024, 026, 029, 030, 033, 034, 037, 054, 055, 058, 061, 062, 065, 068, 070, 073, 081, 

089, 092, 098, 099, 103, 104, 105, 112, 115, 120, 123, 130, 137, 141, 143, 144, 145, 146, 
151, 155, 156, 157, 158, 159, 161, 172, 173, 174, 175, 185, 188, 191, 192, 193, 195, 196, 
199, 209, 213, 216, 218, 226, 238, 243, 248, 257, 258, 265, 266, 270, 272, 283, 290, 312, 
314, 329, 330

playback  :019, 020, 022, 026, 029, 031, 034, 093, 098, 102, 103, 114, 118, 153, 155, 156, 157, 162, 
165, 187, 188, 189, 195, 196, 201, 207, 208, 209, 210, 217, 237, 241, 275, 290, 314

player  :203, 277
plugin  :022, 271
point  :020, 022, 023, 025, 026, 028, 029, 033, 034, 035, 059, 074, 103, 108, 112, 113, 118, 122, 

138, 139, 148, 151, 152, 188, 195, 196, 201, 202, 204, 207, 208, 211, 212, 213, 214, 215, 
216, 220, 229, 231, 235, 236, 241, 245, 251, 270, 286, 290, 297, 298, 307

polyphonate  :023, 114, 123, 237
polyphonation  :111, 123, 234
polyphony  :172
popup  :055
positive  :147, 152, 179, 214, 229, 230, 263
preference  :036, 037, 045, 047, 048, 051, 063, 078, 080, 081, 136, 180, 185, 227, 228, 255, 256, 264, 

265, 268, 273, 275, 309, 311, 312, 314, 315
process   :056, 073, 078, 123, 142, 166, 204, 208, 220, 227, 266, 287
processed  :096, 120, 243, 277, 284, 292, 307
processing  :120, 141, 146, 193, 207, 208, 243, 276, 278, 281, 292
project  :021, 029, 030, 031, 032, 033, 034, 035, 036, 037, 041, 043, 055, 059, 062, 069, 074, 076, 

077, 090, 092, 095, 112, 144, 160, 177, 180, 194, 235, 255, 256, 261, 264, 266, 267, 268, 
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269, 271, 272, 273, 274, 275, 276, 278, 279, 280, 287, 289, 290, 292, 298, 299, 300, 305, 
306, 311, 312, 317, 334

properties  :022, 040, 111, 120, 146, 153, 155, 231, 234, 243, 285, 290, 292, 298
pseudo-random  :080, 184
pseudo-randomization  :080, 184

Q
quadrasmooth  :024, 141, 142, 143, 144, 275
quarter  :203

R
realtime  :019, 020, 021, 022, 023, 026, 030, 092, 121, 142, 146, 168, 189, 190, 201, 218, 226, 244, 

273, 283
record   :080, 184
recording  :026, 027, 035, 076, 077, 078, 079, 080, 081, 183, 184, 185, 227
rectangle  :052, 067, 073, 257, 258
reduce  :022, 023, 027, 137, 221, 233
reference  :020, 021, 031, 034, 035, 036, 037, 045, 046, 047, 048, 051, 063, 068, 073, 074, 075, 078, 

080, 081, 087, 102, 136, 159, 174, 180, 183, 185, 192, 227, 228, 255, 256, 264, 265, 266, 
268, 271, 273, 275, 276, 278, 280, 289, 293, 297, 298, 306, 309, 311, 312, 314, 315

region  :026, 029, 038, 039, 061, 093, 105, 106, 107, 108, 109, 110, 187, 217, 218, 247, 248, 249, 
250, 251, 252, 253, 333

release  :026, 029, 066, 067, 082, 084, 085, 115, 167, 172, 173, 178, 185, 193, 238, 262, 314
relscale  :178, 262
remap  :020, 024, 027, 034, 059, 069, 077, 094, 125, 126, 127, 128, 129, 130, 131, 132, 133, 134, 

135, 136, 137, 138, 145, 146, 157, 223, 313, 328, 329
remix  :029, 220, 221, 226, 330
remove  :027, 048, 086, 087, 096, 123, 132, 168, 169, 221, 222, 246, 269, 270, 277, 278, 279, 281, 

290, 292, 301, 328, 333
rename  :036, 258, 273, 291, 292, 293, 295, 296, 299, 300, 312
renaming  :029, 258, 289, 292, 299
render  :021, 029, 035, 036, 095, 101, 103, 112, 137, 139, 144, 235, 273, 274, 276, 277, 278, 279, 

280, 281, 287, 297, 306, 307
reorder  :169
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reorganize  :169
repeat  :024, 026, 027, 067, 151, 195, 213, 234, 257, 299
repetition  :151, 213, 222
repetitive  :183
rephase  :207, 208, 330
rephasing  :207
replace  :019, 074, 075, 271, 272, 277, 278, 291, 292, 294, 295, 296
repositories  :093
resampled  :098
resampling  :022, 098, 114, 237
reset  :022, 059, 075, 146, 175, 197, 221, 233
reshape  :019, 111, 120, 145, 231, 243
reshaping  :146
resize  :077, 082
resizing  :065, 082, 258
resolution  :029, 109, 138, 252, 331
resonance  :023, 101
resonant  :117, 240
resource  :025, 036, 041, 068, 090, 140, 187, 193, 194, 289, 290, 298, 300, 330, 334
retune  :025, 152, 266
retuning  :151
reverse  :063
revert  :035, 106, 248, 281
rhythmic  :029, 183, 203, 204, 226, 326
right  :025, 057, 059, 060, 065, 066, 068, 075, 081, 082, 083, 085, 088, 089, 090, 095, 097, 100, 

124, 129, 130, 136, 142, 143, 151, 152, 153, 167, 170, 185, 193, 198, 199, 204, 210, 212, 
213, 214, 215, 216, 218, 221, 222, 226, 236, 259, 272, 295, 297, 306, 310, 313, 327, 330, 
331, 334

rising  :140, 151, 213, 333
rms  :027, 078, 095, 103, 131, 141, 142, 183, 192, 197, 202, 211, 215, 216, 232
round robin  :027, 081, 156, 184, 185
route   :047, 094, 286
routed  :095, 096, 097, 175
routing  :093, 094, 095, 096, 155, 175, 180, 271, 286, 309, 310
ruler  :105, 113, 188, 192, 195, 201, 236, 247, 311

S
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sample   :019, 020, 021, 022, 023, 024, 025, 026, 027, 028, 029, 030, 031, 034, 035, 036, 037, 039, 
041, 043, 046, 048, 052, 053, 057, 061, 062, 068, 073, 074, 075, 076, 077, 078, 079, 083, 
086, 087, 088, 090, 093, 094, 095, 098, 102, 103, 104, 105, 106, 107, 108, 109, 110, 111, 
112, 113, 114, 115, 118, 119, 120, 121, 122, 123, 137, 138, 139, 140, 141, 143, 151, 152, 
153, 156, 165, 172, 185, 187, 188, 189, 190, 191, 192, 194, 195, 196, 197, 198, 199, 201, 
203, 204, 205, 206, 207, 211, 213, 214, 215, 216, 217, 218, 219, 220, 221, 222, 223, 224, 
225, 227, 228, 229, 231, 232, 233, 234, 235, 236, 237, 238, 240, 241, 242, 243, 244, 245, 
246, 247, 248, 249, 250, 251, 252, 253, 259, 261, 268, 269, 270, 273, 274, 275, 276, 277, 
278, 279, 280, 281, 283, 287, 289, 290, 293, 297, 298, 299, 300, 301, 306, 307, 309, 310, 
311, 314, 315, 326, 327, 328, 329, 330, 331, 332, 333

sampleend  :102, 103, 105, 106, 120, 247
sampler  :019, 020, 022, 034, 101, 123, 151, 165, 213, 283, 297
samplestart  :102, 103, 105, 106, 120, 247
sampling  :020, 022, 086, 098, 114, 121, 237
saturators  :023, 101
save   :049, 055, 090, 194, 256, 267, 271, 272, 273, 274, 275, 278, 280, 287, 289, 304, 312
saveas  :273, 274
scissors  :065, 075, 083
scramble  :330
screen  :022, 028, 029, 030, 043, 048, 061, 068, 104, 118, 183, 192, 241, 271, 312
scroll   :028, 029, 170, 198, 330
scrolling  :198
scroll wheel  :028, 170
second  :027, 030, 046, 055, 088, 096, 112, 130, 142, 151, 161, 173, 192, 193, 213, 231, 235, 269, 

311
segment  :077, 078, 080, 081, 102, 103, 105, 106, 107, 118, 119, 151, 183, 185, 194, 195, 197, 198, 

199, 201, 202, 203, 204, 205, 206, 207, 208, 212, 213, 215, 217, 218, 220, 221, 223, 224, 
227, 228, 241, 242, 247, 250, 314, 326

select   :023, 026, 027, 028, 029, 037, 047, 052, 055, 056, 061, 062, 064, 065, 066, 067, 068, 069, 
070, 075, 077, 078, 079, 081, 083, 084, 085, 086, 089, 092, 094, 095, 096, 103, 104, 106, 
107, 108, 111, 112, 113, 123, 139, 140, 156, 160, 161, 162, 163, 164, 167, 168, 169, 170, 
171, 174, 176, 177, 185, 194, 198, 205, 206, 207, 218, 219, 220, 222, 226, 227, 228, 233, 
248, 249, 250, 251, 255, 256, 257, 261, 266, 270, 275, 277, 286, 290, 291, 293, 298, 299, 
301, 306, 309, 310, 312, 327, 330, 331, 333, 334

selection  :026, 027, 028, 029, 034, 042, 045, 060, 062, 065, 077, 078, 079, 081, 082, 083, 084, 085, 
086, 106, 107, 108, 131, 140, 155, 156, 163, 164, 165, 166, 170, 185, 187, 188, 190, 191, 
194, 195, 198, 199, 201, 205, 218, 219, 220, 222, 224, 225, 227, 234, 249, 250, 251, 257, 
261, 270, 290, 291, 312, 327, 328, 330, 331, 332, 333

semitone  :114, 180, 237, 272, 327
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sequence  :027, 080, 137, 165, 184, 268, 292
sequential  :074, 077, 078, 081, 110, 126, 127, 128, 130, 183, 185, 222, 223, 224, 226, 227, 253, 273, 

278, 280, 292, 293, 296, 300, 313, 332, 333
shape  :019, 022, 023, 024, 067, 100, 103, 105, 111, 120, 145, 146, 147, 148, 152, 160, 173, 174, 

177, 178, 180, 195, 202, 214, 218, 231, 233, 243, 247, 261, 262, 276
signal  :142, 229, 284
size  :019, 023, 025, 030, 043, 048, 077, 082, 083, 089, 112, 113, 177, 219, 235, 255, 261, 269, 

275, 306, 307, 311, 312
slice  :021, 029, 039, 187, 207, 208, 217, 218, 219, 220, 221, 222, 226, 330, 331, 332, 333
slicing  :029, 219, 220, 222
slide  :023, 024, 025, 026, 061, 065, 066, 067, 071, 089, 115, 142, 153, 191, 192, 216, 236, 238, 

286
slider  :023, 025, 026, 061, 071, 089, 115, 142, 153, 191, 192, 216, 236, 238, 286
smart  :024
smear  :022, 233
smooth  :022, 024, 088, 090, 091, 092, 100, 103, 118, 131, 141, 142, 143, 144, 152, 158, 190, 201, 

202, 214, 218, 226, 233, 275
snap  :024, 045, 068, 266, 333
solo   :070, 115, 238, 330
solo-muted  :070, 073
sort   :032, 290
sound  :019, 020, 021, 022, 023, 024, 028, 029, 033, 034, 035, 042, 054, 055, 073, 074, 076, 078, 

079, 080, 081, 082, 088, 090, 092, 094, 096, 097, 100, 101, 102, 103, 111, 112, 113, 115, 
117, 118, 122, 123, 126, 127, 139, 151, 152, 153, 157, 158, 159, 160, 161, 172, 173, 184, 
185, 203, 204, 208, 213, 214, 223, 227, 228, 231, 234, 235, 236, 238, 240, 241, 245, 246, 
260, 265, 276, 283, 284, 285, 286, 309, 314, 326

soundfield  :042, 096, 101, 283, 284, 285, 286
source  :025, 036, 041, 065, 068, 090, 140, 187, 193, 194, 285, 289, 290, 298, 300, 330, 334
spacebar  :195, 329, 330
spatialization  :096, 284, 285, 287
speakers  :283, 284, 285, 286
spectral  :101, 117, 152, 153, 202, 214, 240
split  :021, 024, 026, 027, 029, 067, 075, 076, 078, 079, 080, 081, 083, 105, 107, 131, 139, 140, 

183, 185, 194, 219, 220, 221, 222, 226, 227, 228, 247, 250, 260, 275, 281, 314, 332, 333
s-shape  :103, 147, 218, 276
stacked  :033
stacking  :088, 148
stacks  :260
standard  :019, 020, 035, 193, 270
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start  :020, 026, 029, 031, 034, 035, 065, 067, 077, 093, 102, 103, 104, 105, 106, 110, 112, 118, 
120, 122, 126, 127, 128, 130, 139, 140, 151, 152, 153, 165, 166, 172, 183, 188, 190, 192, 
193, 194, 195, 196, 199, 201, 202, 203, 204, 205, 206, 207, 208, 210, 211, 212, 213, 214, 
215, 216, 221, 223, 224, 229, 230, 241, 243, 245, 247, 248, 253, 275, 278, 280, 281, 290, 
293, 294, 295, 310, 311, 326, 328, 329, 330, 331, 332

state  :203
static  :071, 088, 092, 177, 261, 275
statistics  :030, 036, 037, 043, 305, 306, 312, 334
step  :037, 047, 067, 114, 140, 158, 237, 268, 270, 293
stereo  :023, 042, 047, 094, 095, 096, 101, 113, 236, 281, 283, 284, 286, 287, 309, 310
stop  :054, 088, 172, 188, 193, 256, 257, 335
strip  :019, 187, 301
stutter  :222
subdivide  :061, 093, 155, 217, 226, 279, 306
subdivision  :082
subfolder  :029, 268, 269, 270, 279
suffix  :270, 273, 281, 312
superimposed  :028
surround  :023, 036, 042, 094, 096, 097, 101, 175, 187, 276, 281, 283, 284, 285, 286, 287, 334
sustain  :162, 173, 178, 262
swap  :027, 094, 130, 221, 226, 327
switch  :025, 028, 031, 034, 037, 038, 061, 064, 080, 081, 092, 096, 105, 156, 161, 162, 170, 174, 

184, 185, 216, 234, 247, 310, 327, 328, 334
sync  :025, 030, 123, 269
synthesis  :019, 022, 023, 039, 061, 093, 111, 112, 113, 114, 116, 117, 118, 119, 120, 121, 122, 123, 

180, 187, 231, 234, 235, 236, 237, 239, 240, 241, 242, 243, 244, 245, 255, 256, 266, 271, 
272, 276

synthetic  :046

T
tab   :061, 063
table  :021, 023, 024, 026, 047, 059, 060, 069, 070, 074, 087, 101, 105, 106, 108, 109, 152, 168, 

170, 174, 176, 183, 192, 194, 214, 231, 233, 247, 248, 249, 251, 252, 255, 256, 257, 258, 
259, 260, 261, 269, 270, 271, 272, 274, 277, 283, 285, 289, 290, 291, 293, 297, 298, 299, 
300, 301, 303, 304, 309, 310, 319, 333, 334

template  :026, 034, 073, 074, 075, 083, 084, 087, 328
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tempo  :033, 035, 197, 210
tessellate  :067, 075, 312
tessellation  :024, 065, 067, 082, 083
timestretch  :111, 231
toggle  :197, 203, 329, 330, 332
token  :277, 278, 279, 280, 281, 291, 292, 293, 294, 296
tool  :019, 022, 025, 026, 039, 065, 075, 082, 083, 158, 166, 168, 170, 187, 204, 231, 233
track   :034, 035, 166, 174, 305
trackball  :028, 037, 113, 170, 198, 216, 236
trackpad  :162, 198
transform  :083, 087, 114, 131, 146, 173, 237
transient  :029, 108, 203, 220, 251, 332, 333
translate  :035, 274, 276, 278, 280, 292
translates  :278, 280, 292
transport  :195
transpose  :033, 082, 114, 124, 237, 258, 260, 314
transposition  :034, 114, 124, 237, 314, 328
triangle  :068, 197, 266
trigger  :031, 034, 103, 156, 172
trim   :026, 027, 061, 077, 185, 227, 228, 314, 330, 331
trimming  :026
truncated  :306, 307
truview  :028, 193, 216, 218, 243
tune  :023, 025, 078, 098, 114, 115, 116, 123, 151, 152, 153, 179, 185, 211, 212, 213, 214, 237, 

238, 239, 263, 266, 271, 272, 275, 313, 332
tuning  :027, 034, 075, 082, 115, 151, 152, 179, 211, 213, 214, 232, 238, 261, 263, 266, 272, 275

U
undo  :021, 025, 035, 121, 244, 300
unit  :037, 188, 192, 311
unroll  :208

V
variation  :024, 062, 077, 080, 081, 117, 161, 165, 184, 185, 205, 226, 240
vector  :284, 285
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velocities  :024, 029, 033, 079, 080, 081, 125, 126, 134, 135, 136, 140, 159, 184, 185, 227, 329
velocity  :023, 024, 025, 027, 028, 031, 033, 034, 058, 059, 061, 062, 063, 065, 068, 071, 073, 078, 

079, 080, 081, 082, 085, 087, 088, 090, 091, 092, 098, 110, 126, 131, 133, 134, 135, 137, 
138, 140, 141, 145, 146, 147, 148, 156, 157, 158, 159, 160, 176, 177, 179, 180, 184, 185, 
227, 228, 253, 257, 258, 260, 261, 264, 265, 266, 271, 277, 279, 290, 297, 298, 312, 314, 
327, 328, 329

vertical  :029, 063, 065, 067, 068, 083, 113, 135, 148, 166, 169, 188, 189, 191, 192, 197, 216, 217, 
232, 233, 236, 257, 266

vibrato  :022, 059, 116, 123, 180, 181, 233, 239, 271, 272
view  :019, 026, 028, 029, 033, 036, 037, 057, 061, 062, 064, 068, 070, 083, 084, 089, 104, 120, 

143, 147, 187, 188, 189, 190, 192, 193, 194, 196, 197, 198, 199, 201, 203, 206, 215, 216, 
217, 218, 219, 221, 226, 233, 236, 242, 243, 247, 249, 259, 266, 270, 289, 298, 300, 301, 
304, 309, 327, 328, 329, 330, 331, 332, 333, 334

virtual  :020, 021, 026, 028, 034, 035, 053, 057, 058, 063, 064, 065, 068, 073, 083, 084, 086, 093, 
130, 166, 187, 188, 194, 201, 217, 218, 219, 221, 231, 255, 256, 258, 259, 265, 289, 290, 
298, 309, 310, 312

voice  :023, 123, 151, 213
volume  :022, 024, 034, 059, 071, 075, 078, 079, 090, 093, 097, 100, 110, 137, 138, 141, 142, 143, 

144, 155, 160, 163, 164, 165, 172, 176, 177, 179, 180, 187, 196, 197, 218, 226, 228, 232, 
253, 260, 261, 263, 264, 266, 271, 272, 275, 277, 279, 283, 284, 285, 297, 334

W
wav   :206, 279, 297
waveform  :029, 103, 118, 120, 141, 151, 152, 180, 188, 189, 190, 191, 192, 193, 195, 198, 202, 213, 

214, 215, 216, 229, 232, 241, 243, 250, 251
whatever  :266
window  :025, 028, 030, 036, 037, 038, 039, 040, 041, 042, 043, 044, 046, 048, 057, 058, 061, 063, 

068, 113, 118, 140, 187, 194, 197, 217, 241, 255, 256, 257, 265, 289, 290, 298, 303, 305, 
306, 309, 312, 314, 330, 334

wire  :166, 168
workspace  :033, 034, 035, 037, 166, 167, 168, 169, 170

X
xfade  :062, 090, 091, 092, 103, 104, 105, 139, 159, 160, 177, 188, 189, 201, 202, 218, 247, 261
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Y
yellow  :064, 068, 148, 197, 198, 266

Z
zero  :026, 029, 068, 092, 140, 152, 157, 175, 177, 180, 204, 214, 229, 230, 261, 266, 331, 333
zone  :020, 021, 022, 023, 024, 025, 026, 027, 028, 029, 030, 031, 032, 033, 034, 035, 038, 041, 

043, 052, 053, 055, 057, 058, 061, 062, 063, 064, 065, 066, 067, 068, 069, 070, 071, 073, 
074, 075, 076, 077, 078, 079, 082, 083, 084, 085, 086, 087, 088, 089, 090, 091, 092, 093, 
094, 095, 096, 097, 098, 099, 100, 101, 102, 103, 104, 105, 106, 109, 110, 111, 112, 113, 
114, 117, 119, 120, 121, 122, 123, 124, 125, 126, 127, 128, 129, 130, 131, 132, 133, 134, 
135, 136, 137, 138, 139, 140, 141, 142, 143, 144, 145, 146, 147, 148, 149, 152, 153, 155, 
156, 157, 158, 159, 161, 162, 165, 172, 173, 175, 176, 177, 183, 194, 199, 201, 222, 223, 
224, 225, 226, 227, 228, 231, 234, 237, 247, 248, 252, 253, 256, 258, 259, 261, 266, 267, 
271, 272, 275, 277, 278, 279, 280, 283, 286, 287, 289, 290, 291, 292, 293, 294, 295, 296, 
297, 298, 299, 305, 306, 307, 311, 312, 313, 327, 328, 329, 333, 334

zoom  :028, 029, 065, 113, 170, 188, 190, 191, 192, 193, 197, 198, 199, 216, 236, 265, 330, 331
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